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Dingo Interaction Report Form Insert Code: C Dingo ID: GBW11m  
 
Date (of Interaction): 3/01/14 
Location (of Interaction): Winnam CZ 

Time (of Interaction 24hrs): 0800 
Reporting Officer/s details: 7026936 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) 2m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults 1             
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Left 
    Details: GBW11m (dingo ranger identified dingo 
from photo took during interaction). 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #:
Age: 53 
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: At 0800 on the 3/01/14, was fishing on the water’s edge in front of 
Winnam CZ. He turned around and noticed a dingo running towards him. He backed into the water to his 
knee depth, as he was not comfortable with how close the dingo was to him (2m). The dingo remained 
at that distance long enough for  to take a photo of it. then yelled at and chased the dingo 
away. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: showed a dingo ranger the photo of the dingo involved in the 
interaction. This photo clearly showed a delaminated orange tag in the left ear, with the colours Green 
Blue and White that remain around the edge of the tag.  
 
 
Action taken: Briefed camper, generated and circulated report. 
 
 
 
 
 
Proposed further action: Continue to brief campers and guests to the Oaks residents in relation to 
dingo safety. 
 
 
 
 
 
Faxed/emailed date:  7/01/14                                 Reporting Officers details:   7026936     
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacysch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: 2 Unidentified dingoes 
 
Date (of Interaction): 4/01/14 
Location (of Interaction): Beach in front of the 
Oaks. 

Time (of Interaction 24hrs): 1730 
Reporting Officer/s details: 7026936 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  Other (specify) father drove his car, 

in between the dingoes and his son, who 
hopped in the car. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     click to select 
b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             2 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #:       
Age: 16 
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   Holliday rental guest      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: walked from his accommodation at the Oaks to the water to get 
some salt water in a bucket. After he had filled the bucket he noticed that Two dingoes were 
approaching him. When they were 1m from him, father drove their car down to prevent the 
dingoes from approaching closer. hopped in the car and the dingoes moved on. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: father commented that when they were both in the car, the 
dingoes were sniffing around the area that had been standing with the bucket. This is an 
indication that the dingoes were soliciting food from
 
 
 
 
 
Action taken: Briefed and his family. Generated and circulated report. 
 
 
 
 
 
 
 
 
Proposed further action: Continue to brief new guests to accommodation at the oaks in relation to 
dingo safety. 
 
 
 
 
 
Faxed/emailed date:  7/01/14                                     Reporting Officers details:  7026936 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: GBW11m, 2 Untagged Juvenile 
Males 
 
Date (of Interaction): 10/1/13 
Location (of Interaction): Northern end of Eli CZ 

Time (of Interaction 24hrs): 17:40 
Reporting Officer/s details: 7028020 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     3 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults 1             
Sub adults                   
Juvenile 2             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GBW11m 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   Independant      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: While on patrol QPWS ranger observed GBW11m and 2 untagged juvenile 
male dingoes loitering around a group of fishermen getting their fishing gear out of their vehicle at Eli 
CZ.  The fishermen actively discouraged the dingoes by yelling at them, clapping their hands and kicking 
sand towards them.  The dingoes were only deterred for a short while before returning. 
As the fishermen left the vehicle and headed towards the ocean the three dingoes moved towards the 
car where they were again discouraged by a female visitor sitting in the vehicle.  GBW11m then headed 
north along the beach while the two untagged juveniles followed the fishermen to the water’s edge.  The 
juveniles were again discouraged by the fishermen and it took several attempts for the dingoes to move 
away. 
GBW11m and the two juveniles then headed into two campsites within the Eli CZ, where they were 
chased off by campers, before heading north along the beach towards Eliz Creek. 
 
 
 
Additional comments and notes: GBW11m and the 2 juveniles showed highly habituated behaviour, 
showing no wariness of people or vehicles and proving difficult to move along when discouraged. 
 
 
 
Action taken: Fishermen spoken to and dingo briefing given.  Report generated and circulated. 
 
 
 
Proposed further action: Increase patrols between Poyungan and Eli Creek while visitation and dingo 
activity are high. 
 
 
 
Faxed/emailed date:  11/1/13                                              Reporting Officers details:  
7028020 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  GBW11m and 2 
untagged 2013 juveniles, Eli CZ, 
10/01/14 - QPWS 
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
 

 
Release
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Dingo Interaction Report Form Insert Code: C Dingo ID: UT 2013 female juvenile 
 
Date (of Interaction): 10/01/14 
Location (of Interaction): Oaks Residence 
Beachfront 

Time (of Interaction 24hrs): 18:00 
Reporting Officer/s details: 7028020 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile       1       
Unknown Age                   

 
c. Were the dingo(s) tagged No 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

Release
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Questionnaire:                  Specify visitor type   resident      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments QPWS rangers have given dingo safe briefings to these residents. 
 
 
 
Detailed report of events: QPWS ranger on patrol observed two female visitors actively discouraging 
an untagged female juvenile dingo in front of the residences at the Oaks.  The ranger stopped to speak 
with the visitors and was told that the dingo had been hanging around for a while while they had been on 
the beach swimming and fishing.  She was showing no signs aggression but they were conscious of 
discouraging her from loitering. 
The dingo loitered in the area while the conversation was happening, being yelled at and chased off 
several times.  The dingo would retreat to the dunes for a short time (around 1min) before returning to 
the beach. 
 
 
 
Additional comments and notes: There is a known habituated pack of dingoes in this area who have 
been frequently seen around the residences at the Oaks.  Residents in the houses have been actively 
discouraging (yelling, clapping hands) any dingoes that come close to the houses. 
QPWS rangers have visited the houses on several occasions to give dingo safe briefings and talk to the 
residents. 
 
 
 
Action taken: Interview conducted and dingo safe messaging reinforced.  Patrols of the area continued. 
 
 
 
Proposed further action: Continue dingo safe briefings of incoming residents and regular contact with 
all residents. 
Increase patrols in this area while visitation and dingo activity are high. 
 
 
 
Faxed/emailed date:  11/01/14                                      Reporting Officers details:  7028020 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified dingoes 
 
Date (of Interaction): 21/01/2014 
Location (of Interaction): Gurruman CA 

Time (of Interaction 24hrs): 17:30 
Reporting Officer/s details: 7028595 & 7027848 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)  Approx. 4m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults 1             
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details: Didn’t notice any tags 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:One of the dingoes had scarring on the 
back of their head 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address: Cashmere, Brisbane 
Phone #:
Age:       
 
Name: 
Address: As above 
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments The couple have a baby so thought it best to stay at the fenced Dundubara camp 
ground the day after the interaction. 
 
 
Detailed report of events: At approx 17:30 on the 21/01/2014, nd 
children were unpacking the car at their camp in the Gurruman camping area. Whilst unpacking they 
moved their youngest child to the annex of their tent and continued unpacking. When checked on 
her child she noticed a male dingo approaching the baby. The dingo approached within 4 meters of the 
child but was scared away when the screamed and ran at the dingo yelling at it. 
 
Later that night two dingoes (described as two males, one large and the other small) were loitering 
around their tent, regularly stopping to look into the window and the door yelled at them, scaring 
them away but they'd return.   
 

and his family moved to Dundubara the following day.   
 
 
 
Additional comments and notes: noticed one of the dingoes had scarring all over the back of its 
head. 
 
No tags were noticed on the dingoes.  
 
 
Action taken: Interaction reported to rangers. Interview taken and report generated and circulated.  
 
 
Proposed further action: Continue ranger patrols through the camp areas. Install trail cameras within 
the area for dingo monitoring purposes.  
 
 
Faxed/emailed date:  27/01/14                                              Reporting Officers details:  
7027848 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacysch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Dingo Interaction Report Form Insert Code: c Dingo ID: Unknown 
 
Date (of Interaction): 23.01.14 
Location (of Interaction): Maheno CZ 

Time (of Interaction 24hrs): 1800 
Reporting Officer/s details: 7028595 & 7027848 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
       attempting to steal food from a plastic box 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     3 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults             1 
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address Morayfield 
Phone #:
Age: 58 
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: and his adult sons had been camping in the Maheno CZ. They 
noticed in the first couple of days that at least two or more dingoes were coming through their camp area 
in the evenings at night looking for food scraps and then moving on when chased away. 
On the evening of the 23rd of January all the campers were sitting on the dunes adjacent to their camp 
when they heard some noise under their annex. They turned to see a dingo attemping to take the lid off 
a plastic food box that had been used for dinner, a male dingo was biting at the box and one of the 
campers chased it away. The light was dim but it was believed that two or more dingoes were present in 
the area.  
 
 
 
Additional comments and notes: It was suggested to the campers that plastic boxes, unless stored 
safely, were not secure enough to stop dingoes 
 
 
 
Action taken: Report taken and patrols continued. 
 
 
 
Proposed further action: Continue patrols of camping areas and briefings to campers. 
 
 
 
Faxed/emailed date:  27.01.14                                      Reporting Officers details:  7027848 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified dingoes 
 
Date (of Interaction): 24/1/2014 
Location (of Interaction): Maheno Campzone 

Time (of Interaction 24hrs): 2200 
Reporting Officer/s details: 7027202 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
       Aldi bag with personal items 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             2 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age: Adult 
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: At approx. 22:00 on 24/1/2014 camper and her three friends were 20 
mtrs away from their tent when they heard noises nearby, inspection found two dingoes had ripped the 
flyscreen on the tent and one had grabbed a bag with personal items, they yelled and chased the 
dingoes, one dingo dropped the bag and both took off into the foredune area. Later on in the evening 
they saw two dingoes again, they reacted the same way by yelling and chasing the dingo away, that was 
their last interaction. 
 
 
Additional comments and notes:       
 
 
Action taken: Report generated and circulated. 
 
 
Proposed further action: Continue ranger presence (patrolling) in the Maheno/Whaba/Eugarie to brief 
visitors.  
 
 
Faxed/emailed date:  14/1/2014                                 Reporting Officers details:  7027202 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified - 5 dingoes 
(likely Eurong pack members) 
 
Date (of Interaction): 25 January 2014 
Location (of Interaction): Northernmost node, 
One Tree Rocks camping zone 

Time (of Interaction 24hrs): Night time (after 
7pm) 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) move off momentarily but 

often return 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     5 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             5 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Not described - too dark, although one 
dingo is seemingly bigger than the others 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Palace tag along leader 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Questionnaire:                  Specify visitor type   Tag along tour      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Had been briefed by tag along leader 
 
 
 
Detailed report of events: Palace tag along tour leader called into the office to report some theft and 
incidentally mentioned that there were regularly 5 dingoes loitering around their camp and proving very 
difficult to discourage. The dingoes were reported to have lay down on the foredunes between the beach 
and the camp, and move into the camp approaching the barbecue when cooking dinner and generally 
when clients are loitering around. Attempts were made to shoo the dingoes away (yelling at and 
advancing towards) but the dingoes usually only retreat momentarily before moving towards the camp 
again.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Reporter stated that he couldn't identify any of the dingoes as it is 
too dark when they are being seen, although he said that one dingo appears larger than the others. 
 
 
 
 
 
Action taken: Reported. Agreed that it might be time for the group to move camping areas when the 
leader suggested this. 
 
 
 
 
 
 
 
 
Proposed further action: Trap and tag dingoes as required, consider temporary closure of camping 
zone to settle dingo activity. 
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Faxed/emailed date:  26 January 2014                                              Reporting Officers 
details:  7026804 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
 

 
Release
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Dingo Interaction Report Form Insert Code: C Dingo ID: Untagged Eur 13m 
 
Date (of Interaction): 25/1/14 
Location (of Interaction): One Tree Rocks CA 
Beachfront 

Time (of Interaction 24hrs): Between 18:19 
Reporting Officer/s details: 7026466 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
Question 3: Dingo numbers and identification 
a. How many dingoes present     6 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults              
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged No 
    Details: UT 13m Eurong.  
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Low front paw markings 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Not taken 
Address: Germany 
Phone #:       
Age: Mature aged 
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments Didn't think throwing bait back into the water was encouraging or feeding dingoes.  
 
 
 
Detailed report of events: Rangers observed 2 mature aged adults fishing in water with their bucket on 
the sand approximately 20 metres behind them. PWW12m and an UT13m_Eur juvenile were laying 
wathcing the pair. PWW12m eventually got up and moved south while the juvenile moved towards the 
bucket, put it's head into the buck and pulled something out.  
 
The older female retreated from the water and moved towards the bucket, shooing the dingo away and 
returning to the water with the bucket. The dingo stayed with them and continued to hang around. The 
older male reeled in this lined and discarded the bait by throwing it towards the water. The dingo 
immediately went to the item and ate it. The couple started to walk towards their camp in the camping 
area. 
 
 Rangers spoke to the couple regarding food availability and encouraging dingoes.  
 
 
 
Additional comments and notes: These 2013 born juveniles are displaying increased signs of 
habituation 
 
 
 
Action taken: Persons advised of secure bait options and implications to the dingo when habituated. 
Report generated.  
 
 
 
Proposed further action:   Patrols are being conducted early morning and late afternoon in this area 
while visitation and dingo activity is high. 
 
 
 
Faxed/emailed date:  28/01/14                                       Reporting Officers details:  7026466 
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Photos  
 

 

Photo 1. 
Description (who took 
photo/when):  QPWS after the 
bucket was removed from the 
dingoes access. 
 

 

Photo 2. 
Description (who took 
photo/when):  QPWS - Juvenile 
dingo involved. 
 

 

Photo 3. 
Description (who took 
photo/when):  QPWS -  Juvenile 
dingo involved. 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified, untagged 
adult female 
 
Date (of Interaction): 27 January 2014 
Location (of Interaction): Central Station 
barracks - eastern then western sides 

Time (of Interaction 24hrs): 1215hrs 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults       1       
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged No 
    Details: Darker mark on right ear - may be 
healed scar from lost tag? 
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Obvious white tail tip, tail curled, lighter 
fur coat colouring 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Witnessed by 5 rangers having lunch 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

15-166 File C 25 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 2 

  lunging (attempting to nip or bite) 
Questionnaire:                  Specify visitor type   QPWS employee      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Whilst sitting on the rear verandah of the Central Station eastern barracks, 
we observed an untagged female adult dingo (estimated age approximately 5 years due to lighter fur 
colour) emerge from below the building and proceed to sniff around the lawn underneath the adjacent 
mango tree (which had dropped some fruit). The dingo was aware of our presence but showed little 
interest in, nor wariness of us. She was walking around with her tail curled over and a darker patch on 
her right ear may indicate a healed scar from a previous tag, although the ear did not appear torn. She 
moved west and then disappeared under the western barracks and wasn't sighted again. Observation 
lasted approximately one minute. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: Reported. 
 
 
 
 
 
 
 
 
Proposed further action: Consider securing underneath building to prevent dingo access/sheltering. 
Trap and tag dingo for identification purposes. 
 
 
 
 

Release
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Faxed/emailed date:  29 January 2014                                              Reporting Officers 
details:  7026804 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
 

 
Release
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Dingo Interaction Report Form Insert Code: C Dingo ID:  B/W/R13m 
 
Date (of Interaction): 7/02/14 
Location (of Interaction): One Tree Rocks CA 

Time (of Interaction 24hrs): Morning for extended 
period 
Reporting Officer/s details: 7026466 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults              
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: BWR13m Eurong.  
 
d. Which ears were tagged Left 
    Details: BWR13m Eurong. 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:young-looking 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Not taken 
Address: Sydney 
Phone #:       
Age: Middle-aged aged 
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events:  Campers reported that a young male dingo with the tag BWR in the left ear 
was hanging around their camp for various parts of the day. 
 
It came in close on numerous occasions and was shooed off. At one stage it came in and started to 
chew the gas pipe from their gas bottle. The dingo made vocalisations towards the people in a non 
aggressive manner and slept in their vicinity for up to an hour approx. 30 metres away. 
 
Later in the afternoon it returned but was not interested in hanging around. 
 
 
 
Additional comments and notes: This report was obtained when general conversation with other 
campers prompted the reporting campers to discuss their interaction. The gas pipe may have had fat or 
something similar that caused the dingo to attempt to chew on it.  
 
 These 2013 born juveniles are displaying increased signs of habituation 
 
 
 
Action taken: Report generated.  
 
 
 
Proposed further action:   Patrols are being conducted early morning and late afternoon in this area 
while visitation and dingo activity is high. 
 
 
 
Faxed/emailed date:  09/02/14                                       Reporting Officers details:  7026466 
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Dingo Interaction Report Form Insert Code: C Dingo ID: unknown 
 
Date (of Interaction): 8/2/14 
Location (of Interaction): Burad CZ 

Time (of Interaction 24hrs): 2100 
Reporting Officer/s details: N Badcock 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) When camper got out of the 

tent next to the one that was ripped. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Plainlands QLD 4341 
Phone #:
Age: 20s 
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments "No" to above question as the campers stored some food inside a tent. This tent was 
not the tent they were sleeping in. 
 
 
 
Detailed report of events: Rangers took the opportunity to speak with these campers as they were 
returning from other duties (servicing Middle Rocks amenities). They were in the process of packing up 
their camp to move to another location on the island. 
 
They were asked if they had any negative dingo interaction to report.  
 
They indicated that their spare tent that was being used for storing gear had been ripped on the night of 
Saturday 8th February 2014. 
 
No one was inside the tent at the time. 
 

eard noises from the vicinity of the tent that was ripped as the dingo was in the process of 
trying to gain entry to the tent. 
 

states that as soon as he alighted from his tent the dingo ran off. He was unable to identify any 
distinguishing features of the animal. 
 

states that they had some items of unopened food and also a loaf of bread inside a lidded crate 
inside the tent. 
 
The dingo did not gain access to the inner tent but ripped through the flysheet of the tent. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Campers were given information regarding the need to store food in 
their vehicle when camping in beach camping zones. They appeared to be well prepared for their stay 
and simply didn’t believe that a dingo would try and rip their tent in order to access a box containing 
food. 
 

and his party (total = 3) were intending to move to the Carree camping zone later today 
(10/2/14) 
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Action taken: Dingo/food safety messages highlighted for the group. 
Encouraged to report any further negative dingo interaction during the reaminder of their stay on FI. 
 
 
 
 
 
 
 
 
Proposed further action: Nil. 
 
 
 
 
 
Faxed/emailed date:  10/2/14                                              Reporting Officers details:  
7027146 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified 
 
Date (of Interaction): 8/02/2014 
Location (of Interaction): Wongai Camp Area  

Time (of Interaction 24hrs): 05:45 
Reporting Officer/s details: 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
       A thong 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile             1 
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details: Too far to see a tag 
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   tour participant      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments The Eurong resort guest was practicing her martial arts alone on the beach. 
 

 
Detailed report of events: was practicing her on the beach at 05:45 on 8/02/2014 
near Wongai  camping area, when she noticed a dingo approaching her possessions she had placed 
approx. 20 meters away on the foredunes. The dingo ran up to her possessions and stole one of her 
thongs. The dingo then ran away with the thong in its mouth. chased and yelled at the dingo that 
subsequently dropped the thong and kept running.  
 
 
Additional comments and notes: The dingo was described as smaller than an adult with large ears 
and feet. This indicates that the dingo is most likely a juvenile and most likely part of the 2013 Eurong 
pack.  
 
No other identification such as an ear tag could be seen as the dingo was too far for to see.  
 
The 2013 Eurong pack juveniles are displaying increased signs of habituation. 
  
 
Action taken: Details of the interaction were taken and a report generated and circulated. RIC notified. 
 
 
Proposed further action: Continue ranger patrols of the eastern beach and camp areas. Liases 
campers. CTO's and visitors to obtain unreported interactions.  
 
 
Faxed/emailed date:  9/02/2014                               Reporting Officers details:  7028018 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified Dingoes 
 
Date (of Interaction): 9/02/2014 
Location (of Interaction): Eli Camping Area 
Beachfront 

Time (of Interaction 24hrs): Approx. 10:00 
Reporting Officer/s details: 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       
  Interference with dingoes  Vehicles swerving 

at the dingoes     
 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     3 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             3 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: RBAC Tag Along Leader 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   unknown      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Unknown 
Comments       
 

Detailed report of events: At 15:45 on the 9/02/2014, Ranger 7028018 was driving north on patrol 
when an oncoming vehicle flashed their lights and stopped the ranger. The driver of the on coming 
vehicle reported that there was a deceased dingo approx. 100 meters south of Eli Creek. 
 
The deceased dingo was located by the ranger and removed off the beach. The dingoes warm body 
temperature and no obvious signs of rigor mortis indicated that it had only recently died.  
 
Whilst removing the dingo a group of RBAC vehicles stopped and the group leader asked the ranger 
what had happened. The ranger responded that it was a deceased dingo possibly caused by a vehicle 
strike (detailed examination of the animals injuries by the ranger confirmed that a severe impact such as 
consistent with vehicle strike had killed the animal).  
 
Subsequently the group leader then reported that earlier that morning approx. 10:00am he had and the 
group had seen 3 vehicles near Happy Valley intentionally swerving and aiming at 3 dingoes. One of the 
vehicles narrowly missed a dingo. 
 
The tag along driver was unable to describe the vehicles, identify any registrations or supply any photos 
of the interaction.  
 
The details of the driver and the ranger were exchanged and the driver said he would notify QPWS if he 
recognised any of the vehicles involved in the swerving incident during his stay on the island.  
 
 
Additional comments and notes: The deceased dingo was a juvenile from a known habituated pack. 
 
The deceased dingo was semi submerged in the incoming tidal waters when it was removed. No 
evidence of a vehicle were seen due to the incoming tidal water. 
 
 
Action taken: Details of the interaction were taken and a report generated and circulated. RIC notified. 
 
 
Proposed further action: Continue ranger beach patrols. Further investigating the report of visitors 
intentionally trying to injure wildlife and enforce compliance where possible.  
 
 
Faxed/emailed date:  10/02/2014                               Reporting Officers details:  7028018 
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Dingo Interaction Report Form Insert Code: C Dingo ID: GGPi13f 
 
Date (of Interaction): 19/02/2014 
Location (of Interaction): Beachfront in front of 
Yidney Rocks 

Time (of Interaction 24hrs): 17:08 
Reporting Officer/s details: 7028020, 7028018, 
7026466, 7027518 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) Within 1m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Discouraged with fishing rod 

but did not move far and returned within 
seconds 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile       1       
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GGPi13f 
 
d. Which ears were tagged Right  
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:
Phone #:
Age:    
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   resident      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments actively discouraged dingo by yelling at it and using her fishing rod.  
 
 
 
Detailed report of events: Rangers on patrol observed a
fishing on the beach approx 100 meters south of Yidney Rocks being repeatedly approached and 
harassed by a juvenile female dingo.  As they got closer they observed that the dingo was tagged and 
was identified as GGPi13f. 

was actively discouraging the dingo by yelling at it, using her fishing rod when the dingo got 
within 1m, and moving away from the dingo. 
 
QPWS rangers spoke with who stated that the dingo had been hanging around for a while, and 
she had moved closer to the accommodation to be 'on the safe side'.  QPWS rangers discouraged the 
dingo by yelling at it and clapping hands, at which point the dingo moved around 20m away. 
 

was observed walking back towards Yidney houses, and GPiPi13f continued to follow her, 
running a short distance to catch up.  QPWS rangers drove towards the dingo and put their vehicle 
between and the dingo.  Rangers continued to move with the using their vehicle and 
yelling/clapping to discourage the dingo, until reached the accommodation. 
 
The dingo was observed a short time later still actively folowing and trying to hang around at 
the threw an item at the dingo, chasing and clapping at it 
eventually causing it to retreat back to the beach. 
 
 
 
Additional comments and notes: GGPi13f is a highly habituated juvenile from a known pack around 
the Oaks area. also advised ranger 7026466 that she suspected a known local from the 

was feeding this pack of dingoes. 
 
 
 
Action taken: Report generated and circulated. This area and the Eurong area is being regularly 
patrolled for high risk interaction behaviour. 
 
 
 
Proposed further action: Continue patrols in this area, including early mornings and late afternoons.  
Continue visitor education and camper briefings. Rangers will revist Yidney Resort managers regarding 
dingo safety messages and support for educating their patrons who are fishing, swimming, walking etc in 
this area. 
 
 
 
Faxed/emailed date:  20/02/2014                               Reporting Officers details:  7028020 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  GGPi13f & 

just after the 
dingo had been discouraged. 
Yidney Rocks Beachfront. 
 

 

Photo 2. 
Description (who took 
photo/when):  GGPi13f, 
19/02/2014, Yidney Rocks 
Beachfront 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified 
 
Date (of Interaction): 19/02/2014 
Location (of Interaction): On the beach 2km Sth 
of Eurong Township. 

Time (of Interaction 24hrs): 18:30 
Reporting Officer/s details: 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify) 2 tents and 

numerous other pieces of camping gear 
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age 1             

 
c. Were the dingo(s) tagged Yes 
    Details: Noticed the reflector shine in the ear 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address: Richmond 
Phone #
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits No 
Did they read the Dingo BrochureNo 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments The car hire company Fraser Magic delivered a comprehensive dingo safety briefing 
to the campers prior to their departure.  
 
 
Detailed report of events and 3 other campers arrived at their chosen camping site 
on the beach 2km south of the Eurong township (Wongai CA) at approx. 17:00pm on the 19/02/2014. 
 
The visitors set up their camp and proceeded to cook dinner around 18:30pm. Whilst cooking their 
dinner they noticed a dingo lying up in the fore dunes watching them. oticed that the 
dingo had a tag, describing it as a 'shiny thing' in its left ear. 
 
Once the campers finished their dinner they packed up their cooking equipment and food and stored it in 
their vehicle, as per the recommendations given to them by Fraser Magic. They then carried their chairs 
down to the beach to watch the sunset. 
 
At approx. 19:00pm and friends returned to their camp to find both their tents ripped 
into, their bags torn apart and clothing and other camping equipment dragged out of their tents and piled 
into a single pile approx. 10 meters away. Dingo prints were all around the camp but no dingoes were 
seen. 
 
The campers packed up their camp and booked into a room at Eurong Resort.  
 
 
Additional comments and notes: No colours on the ear tag were seen. 
 
The Eurong pack is active within the area the interaction occurred and display very habituated 
behaviour. 
 
 
Action taken: Eurong Resort notified QPWS Eurong Base of the interaction. Interview conducted and 
report generated and circulated. RIC notified. 
 
 
Proposed further action: Continue Ranger patrols and camper briefings. Continue monitoring of the 
area for identification of dingoes frequenting the area.  
 
 
Faxed/emailed date:  20/02/2014                               Reporting Officers details:  7028018 
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Dingo Interaction Report Form Insert Code: C Dingo ID: GGPi13f 
 
Date (of Interaction): 20th February 2014 
Location (of Interaction): Yidney Rocks 
beachfront to Yidney Cabins 

Time (of Interaction 24hrs): 0600-0700hrs 
Reporting Officer/s details: 7027904, 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) within 2m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) resident returned to property, 

dingo followed to door then lost interest and 
then allegedly went to a family group on the 
beach 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile       1       
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: Green/pink tag (GGPi13f) 
 
d. Which ears were tagged Right  
    Details: Identity confirmed in previous 
interaction observed by rangers 19/2/2014 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Confirmed ID 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:
Phone #
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
sch4p3( 3) Prejudice the protection of an individuals right to privacy

15-166 File C 44 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 2 

Questionnaire:                  Specify visitor type   resident      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments Reporting resident also observed a family group nearby being 'harassed' by the same 
dingo 
 
 
 
Detailed report of events: Resident rang Eurong office at 655hrs to report an interaction with "the 
same dingo that rangers had observed her being harassed by the previous afternoon" - refer to separate 
interaction report. She also reported that the same dingo was currently harassing a family group on the 
beach with a young child. Ranger 7027904 was dispatched to scene to intervene/investigate. Family 
group fishing on the beach near the northern bypass entrance was interviewed first - no dingo was 
present at this time. Male family member reported no issue with any dingoes that morning. Reporting 
resident was interviewed and stated that she had been fishing and the dingo had been loitering very 
close to her over an extended period, she had a couple of fish in her bait/catch bag that the dingo was 
possibly interested in. Resident eventually decided that it was in her best interests to move away from 
the persistent dingo - as she walked back to her premises the dingo followed her closely (within 2m) all 
the way until she was inside her house (up to back door). The resident stated that the dingo then 
allegedly left and 'harassed' the family group on the beach, although this group denied interaction with 
any dingo during interview.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Resident stated that this dingo commonly frequents around the 
property and close to nearby infrastructure, including accessing verandahs. 
 
 
 
 
 
Action taken: Two parties allegedly involved interviewed. Reported to NRM. 
 
 
 
 
 
 
 
 

Release
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Proposed further action: Monitor behaviour, adjacent camping zones already closed, educate and 
brief nearby visitors. 
 
 
 
 
 
Faxed/emailed date:  20/02/14                               Reporting Officers details:  7027904 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code:  C Dingo ID: Unidentified 
 
Date (of Interaction): 22/02/2014 
Location (of Interaction): One Tree Rocks CA 

Time (of Interaction 24hrs): 24:00 
Reporting Officer/s details: 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify) Torn tent 
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address Ormeau Hills 
Phone #
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits No 
Did they read the Dingo BrochureNo 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments The campers only received their permits from the QPWS visitor center at Rainbow 
Beach. No information packs were supplied. The campers received all their 'dingo safe' 
meassaging from ranger briefings on Fraser Island. 
 
 
 
Detailed report of events: At approx. 24:00 on the 22/02/2014, were woken up at their 
One Tree Rocks camp by a dingo tearing into the front door of their tent. yelled and bashed the 
side of the tent to scare the dingo away. The dingo promptly ran away. 
 
No identifying features of the dingo could be described due to it being dark.  
 

packed up their camp the following morning and booked into a room at the Eurong 
Resort. 
 
 
 
Additional comments and notes: confirmed that a young male dingo with a GY tag 
(GY13m) and a female with a red tag (6Red10f) visited their camp earlier that day. tried to yell 
and chase the two dingoes away but they both lay down in the shade under a tree approx. 15 meters 
away from their camp and went to sleep. 
 
The 2013 Eurong pack juveniles are displaying increased signs of habituation. 
  
 
Action taken: The campers notified the Eurong Resort of the interaction. The resort notified rangers.  
Ranger interviewed the campers and generated and circulated a report. Dingo ranger and SMU 2IC 
notified.   
 
 
Proposed further action: Continue ranger patrols and briefings within all camp areas along the eastern 
beach. Consider camp area closure of Wongai & One Tree Rocks CA's during the busy easter period.   
 
 
Faxed/emailed date:  25/02/2014                               Reporting Officers details:  7028018 
 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified Dingo 
 
Date (of Interaction): 3/03/2014 
Location (of Interaction): Yidney Rocks 

Time (of Interaction 24hrs): 21:30 
Reporting Officer/s details: 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     4 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults 1             
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details: couldn’t see a tag due to the dark 
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Murgon, QLD 
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: The following interaction was reported to QPWS rangers at Rainbow Beach 
by NRM ranger 7028018 conducted an in-person interview. 
 
At approx. 21:30 was watching television at the Yidney Rocks accommodation when
looked up at the closed screen door and noticed a large male dingo sitting on veranda staring at

chased the dingo away. Once outside noticed 3 more dingoes asleep on one of the other 
apartment verandas. The other dingoes were unresponsive to any deterrents.   
 
 
Additional comments and notes: The large dingo was described as an adult dingo and the 3 other 
dingoes asleep on the veranda were described as smaller. All three dingoes are most likely members of 
the known habituated pack frequenting between Poyungan and Eli Creek. 
 
No ear tags were seen as it was dark and 
 
 
Action taken: QPWS notified of the interaction by Yidney Rocks staff. NRM ranger conducted an in 
person interview and generated and circulated a report. RIC notified.  
 
 
Proposed further action: Continue ranger patrols of the eastern beach and camp areas. Increase 
ranger briefings to visitors at Yidney Rocks and The Oaks accomodation during the easter holidays.   
 
 
Faxed/emailed date:  5/03/2014                               Reporting Officers details:  7028018 
 
 
  

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacysch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacysch4p3( 3) Prejudice the protection of an individuals right to privacy
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Dingo Interaction Report Form Insert Code: c Dingo ID: Unidentified Dingoes 
 
Date (of Interaction): 3/03/14 
Location (of Interaction): Wyuna CZ 

Time (of Interaction 24hrs): 1800 
Reporting Officer/s details: 7028595 & 7027848 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
       Stealing a cooked chicken out of an esky 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)          
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) campers heard the dingo at 

the kitchen area but did not investigate and did 
not chase away dingo  
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Adamstown 
Phone #:
Age: 27 
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: and four other friends heard a noise in the kitchen area outside of 
their tent at approximately 11.00pm on the 3.03.14 at Wyuna CZ.They did not investigate the 
disturbance but in the morning iscovered one of their eskies had been dragged along the sand, 
opened and had a whole chicken missing from it's contents. The latch on this particular esky was not a 
common rubber loop but the dingo managed to open it. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: The campers had been noticing a large male dingo loitering in the 
area every day generally in the afternoon. As we (rangers) were taking notes about this dingo 
interaction, a large male dingo with a delaminated red or pink ear tag approached the camping area and 
was chased off by
 
 
 
 
 
Action taken: Reported incident and continued patrols in camp zones.The campers secured their ice 
boxes and storage boxes with rachet straps. 
 
 
 
 
 
 
 
 
Proposed further action:       
 
 
 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Faxed/emailed date:  3/03/14                                              Reporting Officers details:        
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: c Dingo ID: Green tag 
 
Date (of Interaction): 06.03.14 
Location (of Interaction): Yurru Camp Zone 

Time (of Interaction 24hrs): 2:15pm 
Reporting Officer/s details: 7028595 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) 5m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) sounded horn in QG 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     click to select 
b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 2             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged 
No -not all dingo(s) (detail) 
    Details: 1 green tagged dingo, 1 untagged 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: point vernon 
Phone #: 
Age: Adult 
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Regular Fraser Island camper 
 
 
 
Detailed report of events: At 2:30pm I was driving through along the beach past Yurru Camp Zone and 
I saw a camper close to the water with two dingoes watching closely. I stopped the vehicle and one of 
the dingo's came close to the QG ute, I sounded the horn to get him away from the vehicle. I got out of 
the vehicle and talked to the camper. I stayed with camper until dingos moved on.     
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: report generated and forwarded 
 
 
 
 
 
 
 
 
Proposed further action: Continued patrols and monitoring of GREEN tagged dingoes behaviour 
 
 
 
 
 
Faxed/emailed date:  7.3.14                                              Reporting Officers details:  
7028595 
 
 

Release
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  

6.3.14 
 

 

Photo 2. 
Description (who took 
photo/when): 

6.3.14 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified 
 
Date (of Interaction): 9/03/2014 
Location (of Interaction): One Tree Rocks 
Camping Area 

Time (of Interaction 24hrs): 21:00 
Reporting Officer/s details: 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             Unknown 

 
c. Were the dingo(s) tagged Unknown 
    Details: No dingoes were witnessed 
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: (Teacher: Tweed Valley 
Adventist College) 
Address:   
Phone #: 
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments The school teacher responsible for safety briefing the students told the students to 
chase the dingoes away by running towards them whilst waving your arms and yelling. When 
asked if they received any dingo safety information with their permits they said yes. The correct 
dingo safety information was forwarded (verbally) onto them by rangers. 
 
 
 
Detailed report of events: Rangers 7028018 & 7028122 were approached by two teachers from Tweed 
Valley Adventist College, at approx. 22:00 at the QPWS ranger base, Eurong. The teachers reported a 
dingo interaction and showed genuine concern for their students safety.   
 
At approx. 21:00 two students from Tweed Valley Adventist College staying at One Tree Rocks camping 
area, returned to their tents to find the front door of their tent torn. Nothing was missing but the students 
noticed dingo foot prints all around their tent. No dingoes were seen that night but the students and 
teachers commented that a couple of dingoes were loitering around their camp earlier that day. The 
school student interviewed said he had a container of powdered energy drink that had teeth marks in it.   
 
Since this interaction 4 more tents have been torn. The teachers are now following ranger advice to lock 
away all items while the tents are unoccupied. It was also recommended that the school group relocate 
to a fenced camp ground such as Central Station or Dundubara.    
 
 
Additional comments and notes: A known very habituated dingo pack occupy the One Tree Rocks 
camping area. The dingoes that have ripped the tents and were loitering earlier that day around their 
camp were most likely part of this pack. 
 
The teachers reported that none of the dingoes have shown aggressive behaviour directly towards 
people. All the tents have been unoccupied when they were torn.  
 
 
Action taken: Interview conducted and report generated and circulated. RIC notified and a dingo safety 
briefing delivered by a dingo ranger to the school group. Rangers are regularly patrolling the camp area 
and contacting the school group leaders.  
 
 
Proposed further action: Continue ranger patrols and visitor briefings. Increase ranger patrols and 
visitor briefings during the Easter holiday period. Consider closing the Wongai and One Tree Rocks 
camping areas during the busy Easter holiday period and dingo mating season.  
 
 
Faxed/emailed date:  11/03/2014                               Reporting Officers details:  7028018 
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Dingo Interaction Report Form Insert Code: C Dingo ID: GGG13M 
 
Date (of Interaction): 12 Mar 14 
Location (of Interaction): Cathedral Beach Resort 

Time (of Interaction 24hrs): Afternoon 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   resort staff      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Staff chased the dingo away 
 
 
 
Detailed report of events: It was reported by resort staff that a green tagged young male had been 
seen loitering around the resort area. Staff had chased it off but found it difficult to deter only reteating a 
short distance eventually loosing interest and leaving. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Description consistant with GGG13M also seen by Ranger 7027330 
earlier in the day loitering around backpackers at the Pinnacles.The dingo is showing no aggression at 
this stage however is displaying a high level of habituation. 
 
 
 
 
 
Action taken: Briefed campers in resort, Report generated  
 
 
 
 
 
 
 
 
Proposed further action: Monitor GGG13M, ensure camper briefing regime maintained 
 
 
 
 
 
Faxed/emailed date:  15Mar14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: GGG13M 
 
Date (of Interaction): 12Mar14 
Location (of Interaction): Pinnacles Beachfront 

Time (of Interaction 24hrs): 1300 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

Release
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Questionnaire:                  Specify visitor type   QPWS employee      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: During a patrol Ranger 7027330 noticed a juvenile dingo sitting behind a 
group of backpackers (RBAC) who were collecting pippies. The ranger asked the guide if he had seen 
the dingo sitting and watching. The guide said he had seen the dingo in the area but had not seen it 
approach. At this point the ranger positively identified the dingo as GGG13M by its ear tag. The ranger 
then chased the dingo away. The dingo retreated approx. 10m and did not leave the area until the 
backpackers left the scene.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: This animal is showing no signs of aggression however is displaying 
high levels of habituation. 
 
 
 
 
 
Action taken: Report generated 
 
 
 
 
 
 
 
 
Proposed further action: Monitor animal, brief camps in area 
 
 
 
 
 
Faxed/emailed date:                                                     Reporting Officers details:        
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  7027330 12Mar14 
Pinnacles Beachfront 
 

 Photo 2. 
Description (who took 
photo/when):        
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 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified Dingoes 
 
Date (of Interaction): 12 Mar 14 
Location (of Interaction): One Tree Rocks CZ 

Time (of Interaction 24hrs): After 0830 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #: 
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments They believed the boxes they had were secure from dingoes this was not the case. 
 
 
 
Detailed report of events: The campers left their site at approx. 0830. On their return they noticed that 
one fly screen in the annex of the camper trailer had been torn and there were dingo foot prints in the 
annex.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Since the interaction the campers had seen juvenile dingoes in the 
area. On the day the campers were spoken to fresh tracks were seen throughout the CZ and a tagged 
juvenile female was sighted. Area frequented by the Eurong Pack. 
 
 
 
 
 
Action taken: Patrol CZ, report generated, informed 2IC Sth. 
 
 
 
 
 
 
 
 
Proposed further action: Patrol and monitor area  
 
 
 
 
 
Faxed/emailed date:  16Mar 24                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: GGPu13m & PuGR13m 
 
Date (of Interaction): 16/03/2014 
Location (of Interaction): Eurong Resort 

Time (of Interaction 24hrs): 07:00 
Reporting Officer/s details: 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line Eurong 

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) GGGPu13m voluntarily 

through a gate. PuGR13m was trapped. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 2             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GGPu13m & PuGR13m 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Eurong Resort 
Address:       
Phone #: 07 4120 1600 
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   resort staff      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: QPWS rangers were performing scheduled maintenance on the Eurong 
fence and grids on the morning of 16/03/2014 when they noticed fresh dingo tracks inside the fence. 
After locating the dingo, rangers were able to release GGPu13m through a vehicle access gate on 
18/03/2014.  
 
The following morning (19/03/2014) the Eurong Resort staff notified dingo ranger 7028018 of another 
dingo inside the fenced area. PuGR13m was persued for serveral days until he was trapped on the night 
of 24/03/2014.   
 
 
Additional comments and notes: GGPu13m & PuGR13m are members of a highly habituated pack 
frequenting around Eurong. 
 
 
Action taken: Eurong Resort & QPWS senior management notified of the dingo inside the fence. 
Rangers loacted and released the dingoes. 
 
 
Proposed further action: Continue the regular fence inspections and ensure all gates and grids 
function . 
 
 
Faxed/emailed date:  25/03/2014                               Reporting Officers details:  7028018 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Untagged Dingo 
 
Date (of Interaction): 16/03/2014 
Location (of Interaction): Approx. 1km sth Yidney 
Rocks on the beach 

Time (of Interaction 24hrs): 21:00 
Reporting Officer/s details: 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) 2-3 meters        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) When stuck by a fishing rod. 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile             1 
Unknown Age                   

 
c. Were the dingo(s) tagged No 
    Details: Confirmed by a number of witnesses 
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: (made contact with the 
dingo) 
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments The fishermen were together as a group and not spread out along the beach. Rangers 
recommended that if a dingo approaches them in the future that they should pack up and 
relocate. It was also suggested that making contact with a dingo is considered 'interfering with 
wildlife' under legislation. 
 
 
 
Detailed report of events: At approx. 21:00 on the evening of the 16/03/2014, a group of 8 were fishing 
on the beach approx. 1km south of Yidney Rocks when they were approached by an untagged dingo 
(described as 'one of the young ones'). The dingo approached within a couple of meters and showed no 
signs of being wary of the group. One of the fishermen feeling uncomfortable with the close proximity of 
the dingo whacked it on the hind legs to scare it away. When the fishermen struck the dingo the two 
gang hooks attached to his fishing line lodged themselves in the dingoes hind leg. The dingo yelped and 
ran away with the two hooks still lodged in its leg. 
 
The fishermen reported the interaction to who promply 
contacted QPWS rangers. 
 
 
Additional comments and notes: The untagged dingo is most likely a juvenile who's part of the 
habituated pack occupying the area between Poyungan and Eli Creek.  
 
 
Action taken: QPWS rangers were notified by Yidney Rocks management. QPWS senior management 
notified. Interview conducted and a report generated and circulated. Rangers are patrolling the beach 
looking for the dingo.  
 
 
Proposed further action: Continue patrolling the beach to locate the dingo. Once the dingo is located 
QPWS rangers will administer first aid to remove the hooks. 
 
 
Faxed/emailed date:  20/03/2014                               Reporting Officers details:  7028018 
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Dingo Interaction Report Form Insert Code: C Dingo ID: GGG13m 
 
Date (of Interaction): 19/03/2014 
Location (of Interaction): 400m sth of the 
Pinnacles 

Time (of Interaction 24hrs): 12:30 
Reporting Officer/s details: 7027118 & 7027940 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GGG13m 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: (Discovery bus driver) 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   commercial tour operator      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments The bus driver allowed the passengers to exit the bus and approach the dingo at 
close proximity to take photos. 
 
 
 
Detailed report of events: At approx. 12:30 on the 19/03/2013 rangers commuting off the island 
noticed a tour operator and his passengers approaching a dingo (GGG13m) on the beach. On arrival 

(discovery bus driver) had the majority of his passengers out of the bus taking photos of the 
juvenile male dingo GGG13m (see attached photos).  
 

was quick to say that he had talked with a head ranger in the past about stopping and letting 
passengers out of the bus to take photographs, and was under the impression that this was ok. When 
asked who the ranger was he was unsure and couldn’t remember the person’s name. Ranger 7027118 
asked to board the passengers and that they could simply take photo's form within the bus to 
prevent the habituation process of any dingo. 
 
 
 
Additional comments and notes: GGG13m regularly displays very habituated behaviour.  
 
 
Action taken: Rangers stopped and spoke to the tour operator. Photos taken and report generated and 
circulated.  
 
 
Proposed further action: Continue ranger patrols and visitor briefings along the beach and within the 
camp areas. Recommend to all tour operators allowing passengers to leave the tour vehicle to 
photograph dingoes at close proximity to cease this activity as its increasing the chances of dingoes 
becoming habituated and it may increase the chances of an adverse human/dingo interaction.   
 
 
Faxed/emailed date:  20/03/2014                               Reporting Officers details:  7027118 & 
7028018 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description:  
GGG13m taken 
19/03/2014 by 
7027118 
 

 

Photo 2. 
Description:  
GGG13m taken 
19/03/2014 by 
7027118 
 

 

Photo 3. 
Description:  
GGG13m taken 
19/03/2014 by 
7027118 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified dingo 
 
Date (of Interaction): 19/03/2014 
Location (of Interaction): Gabala camping area 

Time (of Interaction 24hrs): 12:55 
Reporting Officer/s details: 7027118 & 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
       Fish frames 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: (professional beach 
wormer) 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   Proffessional fisher/wormer      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments The beach wormer left bait unsecured and available for dingoes to access. 
 
 
 
Detailed report of events: At 12:55 on 19/03/2014 commuting rangers 7027118 & 7027940 noticed an 
unidentified dingo eating a fish frame 50m north of the parked vehicle 
registered to professional beach wormer was questioned where the dingo aquired 
the fish frame and he replied by saying that while he was preparing worm burly in a bucket he left the 
bucket to go to the other side of the vehicle, during this time the dingo had rushed in and took a couple 
of frames from the bucket.  
 
Ranger 7027118 stressed the importance of dingo food security, along with the procedure for disposing 
fish offal. 
 
 
Additional comments and notes: BPuR12m was seen and identified watching the professional beach 
wormers at Gabala at 15:30.  
 
 
Action taken: Rangers interviewed the professional beach wormer. Report generated and circulated. 
 
 
Proposed further action: Continue ranger beach patrols and visitor briefings. Continue ranger vigilance 
on enforcing appropriate food security measures are practiced by all visitors to Fraser Island. 
 
 
Faxed/emailed date:  20/03/2014                               Reporting Officers details:  7028018 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unknown 
 
Date (of Interaction): 21/3/2014 
Location (of Interaction): Chard Rocks 

Time (of Interaction 24hrs): 0735 
Reporting Officer/s details: 7027202 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Dingoes remained in the 

same area for some time. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     3 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults 1       2 
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Toyota Land 
cruiser
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   unknown      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Unknown 
Comments       
 
 
 
Detailed report of events: While travelling up the beach two rangers noticed a Land cruiser 

parked with three dingoes within a couple of metres of it, when the rangers got within 50 
metres the vehicle took off towards the south, on pulling up, the rangers noticed dry dog food scattered 
over the sand and the dingoes eating the dog food, the rangers turned around and attempted to catch up 
with the vehicle but were only able to get it's number plate as it continued to increase it's speed 
beyond a safe limit, the rangers were loaded with a mop up unit and water and chose not to continue. 
The info was passed onto the southern rangers, on returning to the scene two of the dingoes took off 
and one stayed eating something on the ground, the dingoes had eaten all the dog food, there was also 
a lot of opened/crushed Eugarie on the ground. I received a radio call from a NRM/SMU rangers who 
had spoken to/interviewed the driver of the vehicle at the Eurong out grid, a conversation took place and 
the driver said he had stopped to look at the dingoes but had no part in feeding them. He was asked if 
there were any other vehicles in the area, he replied there was another with a trailer, the rangers that 
first noticed the incident believed there we no other vehicles to the north or the south. The NRM/SMU 
rangers that were speaking to the driver advised them on the regulations and sent them on their way.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: Report generated and circulated and vehicle details put on file 
 
 
 
 
 
 
 
 
Proposed further action:       
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Faxed/emailed date:  21.3.14                                              Reporting Officers details:  
7027202 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

Photo 1. 
Descriptio
n (who took 
photo/when):  

21.3.14 
Chard Rocks 
 

 Photo 2. 
Descriptio
n (who took 
photo/when):  
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 Photo 3. 
Descriptio
n (who took 
photo/when):  
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unknown 
 
Date (of Interaction): 24 March 2014
Location (of Interaction): Eastern Beach 

Time (of Interaction 24hrs): Day time 
Reporting Officer/s details: 7026480 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Unknown 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:

Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   commercial tour operator     

Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments The guide got down to dingoes level to take a photograph with an iPhone. This action 
encouraged the dingo to approach him. 
 
 
 
Detailed report of events:  

 
Additional comments and notes: Dingo looks to be a 2013 born juvenile and possibly male according 
to post. No sign of aggressive behaviour noted. is a long term guide on Fraser Island and is 
aware of the QPWS dingo safe messages and appropriate behaviour around dingoes. These actions 
from experienced guides have been known to encourage visitors to act in a similar manner towards 
dingoes. 
 
 
 
 
 
Action taken: incident reported. Guide will be spoken to regarding these actions and the possible 
interpretation by readers of the post who may attempt the same actions in order to obtain a close 
photograph and put themselves and a dingo at unnessessary risk. 
 
 
 
 
Proposed further action: Remind CTO oprerators and guides of their permit obligations and QPWS 
dingo safety messages to mitigate risk between humans and dingoes. 
 
 
 
Faxed/emailed date:  21 April 2014                               Reporting Officers details:  7026466
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Photos  
 
 Photo 1.

Description (who took 
photo/when): 
with iPod non zoom camera. 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified 
 
Date (of Interaction): 24/03/2014 
Location (of Interaction): One Tree Rocks 
Camping Area 

Time (of Interaction 24hrs): Between 7am & 8pm 
Reporting Officer/s details: 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments The campers stored their bbq in their tent. 
 
 
 
Detailed report of events: At 7am on the 24/03/2014 nd three other friends left their 
camp at One Tree Rocks Camping Area. When they arrived back at their camp at approx. 8pm the same 
day they noticed that a dingo had torn a hole in their tent fly mesh and pulled the drip try off their bbq 
and licked it clean. Dingo tracks outside and around their tent confirmed it was a dingo. 
 
 
Additional comments and notes: GGPu13m was seen hanging around their camp that evening. 
GGPu13m is a member of a the highly habituated pack that frequently loiter around campers in the One 
Tree Rocks camping area. 
 
 
Action taken: Campers interviewed and a report generated and circulated.  
 
 
Proposed further action: Continue regular ranger patrols through the camp and visitor day use areas. 
 
 
Faxed/emailed date:  25/03/2014                               Reporting Officers details:  7028018 
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Dingo Interaction Report Form Insert Code: C Dingo ID: 3 Unidentified Male dingoes 
 
Date (of Interaction): 25.3.14 
Location (of Interaction): One Tree Rocks Camp 
Zone 

Time (of Interaction 24hrs): 1300 
Reporting Officer/s details: 7027118 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
       Chew on food boxes - didn’t access food 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Would leave when chased 

away - though returned on several occasions. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     3 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age 3             

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

15-166 File C 91 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 2 

Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits No 
Did they read the Dingo BrochureNo 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: Three dingoes were loitering around camp continuously - when the 
camp was left vacant the dingoes came in and attempted to access a plastic food box by chewing on the 
handles.  
Dingoes were discouraged on several occasions but they continued to loiter in the area. 
 
 
 
Additional comments and notes:       
 
 
Action taken: Report generated 
 
 
Proposed further action:       
 
 
Faxed/emailed date:  10.04.14                                      Reporting Officers details:  7027118 
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Dingo Interaction Report Form Insert Code: C Dingo ID: GGG13M BWY13M 
 
Date (of Interaction): 31 Mar 14 
Location (of Interaction): Yuru CZ 

Time (of Interaction 24hrs): 1530 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 2             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Chappel Hill 
Phone #
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: were fishing at the southern end of Yuru CZ with their 
adult daughter. While fishing GGG13M and BWY13M were loitering around the family threw sand and 
pumice stone at them to deter the animals. This had little to no effect. The dingoes lost interest over time 
and left the area. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: GGG13M and BWY13M are showing high levels of habituation. 
GGG13M is regularly seen in this area. 
 
 
 
 
 
Action taken:    Report generated 
 
 
 
 
 
 
 
 
Proposed further action: Patrol and monitor these animals 
 
 
 
 
 
Faxed/emailed date:  1 Apr14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: c Dingo ID: GGG13m 
 
Date (of Interaction):  02.04.14 
Location (of Interaction): Guruman 

Time (of Interaction 24hrs): 10:30am 
Reporting Officer/s details: 7028595 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
       Took a rope from campsite while campers 
where present. 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: Green tag 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:socks 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #: 
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Campers were setting up their tents when a male dingo (green,green,green 
tag) took a tent rope and ran off with it. The Campers didn't chase after the dingo. Later on they took a 
walk on the beach and retrived their rope that the dingo had taken earlier on. Green comes to theIR 
camp site daily and sits at their campsite. Campers said this green tagged dingo has been seen chasing 
other dingoes through their campsite.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: It is important to note that the family did not chase the dingo away 
from their camp site and ignored it. We informed them that they shouldn't let it loiter in the area near 
their camp site. 
 
While conducting camper briefings a colleague and I saw a dingo in the Maheno CZ (couldn't see the 
tag). It kept its distance from the family.   
 
 
 
 
 
Action taken: Report generated and forwarded 
 
 
 
 
 
 
 
 
Proposed further action: Continued patrols and monitoring GGG13m dingoes behaviour 
 
 
 
 
 
Faxed/emailed date:  08.04.14                                    Reporting Officers details:  7028595 
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Dingo Interaction Report Form Insert Code: C Dingo ID: 3 Unidentified 
 
Date (of Interaction): 04/04/2014 
Location (of Interaction): Eurong Beachfront 

Time (of Interaction 24hrs): Approx 16:00 
Reporting Officer/s details: 7028020 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) sand kicked at it 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     3 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             3 

 
c. Were the dingo(s) tagged Unknown 
    Details: No tags noticed 
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: Rangers on patrol at Eli Creek on 05/04/2014 were advised of an incident 
which occurred out the front of Eurong the previous evening. 
A male visitor was on the beach fishing when he noticed three dingoes within 5m of him.  He banged two 
pieces of poly pipe (rod holders) together and yelled at the dingoes and 2 of them moved away and 
continued along the beach.  The third dingo only moved back a short way and advanced again before 
the visitor kicked sand at it.  The dingo moved about 15m away and lay down. 
The visitor moved his car closer to him and put his sealed bait bucket in the back of the ute. 
The dingo stayed in the area as long as the fishermen were fishing. 
 
 
 
Additional comments and notes: No tags were noticed. 
 
 
 
Action taken: Report generated.  RIC notified. 
 
 
 
Proposed further action: Continue patrols in the area.  Consider closing Wongai and OTR CZ if 
interactions continue in this area. 
 
 
 
Faxed/emailed date:  05/04/2014                               Reporting Officers details:  7028020 
 
 

15-166 File C 99 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 1 

Dingo Interaction Report Form Insert Code: c Dingo ID: Unidentified Dingoes 
 
Date (of Interaction): 04/04/2014 
Location (of Interaction): One Tree Rocks 
Camping Area 

Time (of Interaction 24hrs): 11:30 
Reporting Officer/s details: 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) When let out of the tent 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 2             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: A red tag in the left ear 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #: 
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: A family camping at One Tree Rocks camping area went early morning 
fishing and returned at approx. 11:30 to find a dingo stuck in the annex of their tent. The campers had 
left the tent annex door slightly open and two other members of their group witnessed two dingoes 
entering the tent. One of the dingoes left the tent but the other couldn’t find the exit. The dingo was stuck 
for a number of hours until the owners of the tent returned and let the animal out. 
 
The dingoes didn’t damage any of the campers property.  
 
The dingo in the tent was described as having a red tag in its left ear. The first dingo was described as 
having a green tag in its left ear. 
 
 
Additional comments and notes: The green tagged dingo is most likely GGPu13m and the red tagged 
dingo BWR13m. Both dingoes regularly hang around the OTCA and are part of the Eurong habituated 
pack. BWR13m was seen by rangers only a couple of hours after the interactoin loitering around other 
campers in OTCA. 
 
 
Action taken: Camp briefing delivered by rangers. Interview conducted and a report generated and 
circulated.   
 
 
Proposed further action: Continue camp briefings. Continue early morning and afternoon ranger 
patrols for compliance, community liaising, risk mitigation and monitoring purposes during the busy 
Easter holiday period. 
 
 
Faxed/emailed date:  6/04/2014                               Reporting Officers details:  7028018 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Possible Brown, unsure 
 
Date (of Interaction): 4/4/14 
Location (of Interaction): Waddy Point Beach 
Front Campground 

Time (of Interaction 24hrs): 1400 
Reporting Officer/s details: 7027202 for 7028773 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Dingoes were followed by 

rangers in vehicle and moved on at their own 
accord. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     4 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults 1             
Sub adults                   
Juvenile                   
Unknown Age 2 1       

 
c. Were the dingo(s) tagged Yes 
    Details: One tag seen on male possible brown 
 
d. Which ears were tagged Right  
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Large Male 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Witnessed by two QPWS rangers 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   click to select      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: While repairing the Waddy Point beachfront access road rangers saw four 
dingoes engaging in a fight between the pack, this unfolded in front of the rangers who managed to get a 
photo and possibly saw a brown tag on the large male. Rangers followed the dingoes and two ran 
around the dingo fence towards the sand blow and two ran up the ranger residence driveway towards 
the RIC house, while following the dingoes rangers spoke to a girl aged 9 at the Dorrigo outside the 
ranger base with no adult present, her parents were camping in the fenced area, they advised her to go 
back to the fenced area with her parents.    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Possibly and most likely the pack reported in a code D on 1.4.2014 
 
 
 
 
 
Action taken: Report generated and circulated. 
 
 
 
 
 
 
 
 
Proposed further action: Continued dingo patrolling/raising awareness and camper briefings. 
 
 
 
 
 
Faxed/emailed date:  5.4.14                                              Reporting Officers details:  
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7027202 / 7028773 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):

4.4.14 
 

 

Photo 2. 
Description (who took 
photo/when):  

4.4.14 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: 6Red10f 
 
Date (of Interaction): 05/04/2014 
Location (of Interaction): Eurong Beachfront 

Time (of Interaction 24hrs): 16:40 
Reporting Officer/s details: 7028020 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Moved back to approx. 20m 

when QG approached and stayed there 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults       1       
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Right  
    Details: 6Red10f 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   Proffessional fisher/wormer      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Ranger 708020 on patrol noticed a dingo in close proximity to a vehicle. 
As the QPWS vehicle approached the dingo moved and sat about 10m away from the vehicle, watching 
the two professi9onal wormers at the water’s edge. 
When the ranger stopped to identify the dingo (6Red10f) the dingo moved further back towards the 
dunes and sat down again watching the wormers.  The ranger was in the area for another 15 minutes on 
patrol and the dingo was in the same spot when they left. 
 
 
 
Additional comments and notes: The professional wormers are known to QPWS rangers.  The female 
dingo is part of a known habituated pack in the area. 
 
 
 
Action taken: Report compiled and circulated. 
 
 
 
Proposed further action: Continue patrols, including morning and afternoon.  Continue briefings with 
campers and visitors.  Monitor behaviour of the known pack in the area.  Consider closing Wongai and 
OTR campzones if interactions continue to occur. 
 
 
 
Faxed/emailed date:  06/05/2014                               Reporting Officers details:  7028020 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  6Red10f, Eurong 
Beachfront, 7028020 
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Dingo Interaction Report Form Insert Code: C Dingo ID: GGPi13f 
 
Date (of Interaction): 05/04/2014 
Location (of Interaction): Yidney Rocks 

Time (of Interaction 24hrs): 17:10 
Reporting Officer/s details: 7028020 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) Within 5m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile       1       
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Right  
    Details: GGPi13f 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   Independant      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: While on patrol a QPWS ranger noticed a dingo sitting within 5m of a parked 
vehicle.  As the ranger got closer the dingo was chased away by the occupants. 
The dingo was identified as GGPi13f. 
The dingo continued south along the beach towards a further two parked vehicles.  As the dingo 
approached the occupants of the vehicles got into their cars and watched as the dingo sniffed around.  
The dingo was chased off by a male visitor and retreated up the sand dune where it continued to watch 
as the occupants packed away their belongings. 
The dingo then headed over the sand dune towards the Yidney Rocks accommodation.  The ranger 
parked on the beach and walked up to the accommodation to look for the dingo and brief the visitors 
staying in the accommodation. 
The dingo was observed sitting on top of the dune watching the activity on the grass in front of the 
accommodation.  The dingo slowly approached the group (5-10m at a time) before descending and 
walking around the edge of the grassed area.  The ranger observed the dingo, while briefing the visitors, 
and chased the dingo off as she approached the group by yelling and clapping their hands. 
The dingo retreated down the bank to the beach and headed south along the beach. 
The ranger continued briefing the visitors and residents on dingo safe behaviour and left. 
The dingo was seen approx. 20mins later at the Oaks on the beach. 
 
 
 
Additional comments and notes: This dingo is a part of a known habituated pack in the area and has 
been involved in several recent code C & D interactions. 
 
 
 
Action taken: Visitors and residents briefed.  Report compiled and circulated.  RIC notified. 
 
 
 
Proposed further action: Continue patrols in this area including morning and afternoons.  Continue 
monitoring the behaviour of this dingo and the known pack in the area.  Continue the closure of the 
campgrounds between Poyungan Rocks and Eli Creek. 
 
 
 
Faxed/emailed date:  06/04/2014                               Reporting Officers details:  7028020 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  GGPi13f, Yidney 
Rocks, 7028020 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unknown 
 
Date (of Interaction): 06.04.14 
Location (of Interaction): Maheno Campzone 

Time (of Interaction 24hrs): 2:00am 
Reporting Officer/s details: 7028595 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
       trying to get into esky 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     click to select 
b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Unknown 
Comments       
 
 
 
Detailed report of events: 2:00am Camper woke up to a noise, He went to check and found a dingo 
trying to get into his esky. He quickly yelled at it and chased it with a stick and the dingo ran into 
adjacent bush behind the dunes. 
 
 
 
Additional comments and notes: Reported generated and forwarded 
 
 
Action taken: Reported generated and forwarded 
 
 
 
Proposed further action: Breifing Campers regulary about dingo safety 
 
 
Faxed/emailed date:  9.3.14                                          Reporting Officers details:  7028595 
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Dingo Interaction Report Form Insert Code: C Dingo ID: GGG13m 
 
Date (of Interaction): 7.4.14 
Location (of Interaction): Akuna creek Eastern 
beach Fraser Island 

Time (of Interaction 24hrs): 0915 
Reporting Officer/s details: 7027118 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
      -Stole Hat 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Left when took hat. 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     3 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Left 
    Details: GGG13m 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age:    
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   Independant      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: and her family were stopped at Akuna creek on the 7/4/14 at 0915am. 
Juvenile dingo GGG13m approached the group from the fore dunes was taking photos of the 
dingo when her hat blew off her head. This excited GGG13m as the dingo came in, grabbed the hat and 
took off behind the fore dunes. The dingo did not return after this interaction. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Ranger 7027118 viewed photos of the dingo and positively 
identified the dingo to be GGG13m. 
 
 
 
 
 
Action taken: Report generated 
 
 
 
 
 
 
 
 
Proposed further action:       
 
 
 
 
 
Faxed/emailed date:  11.04.14                                              Reporting Officers details:  
7027118 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: GrGrGr 
 
Date (of Interaction): 7/4/14 
Location (of Interaction): Guruman CZ 

Time (of Interaction 24hrs): 1130 
Reporting Officer/s details: 7027146 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: Green Green Green tag 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #: 
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments       
 
 
 
Detailed report of events: * Rangers were driving through Guruman CZ at approximately 11:30am 
when they approached a campsite. 
* Rangers observed GrGrGr lying on the grassy track approximately 3 metres from the campsite we 
were driving toward. 
* The dingo got up and walked alongside our vehicle and away from the campsite. 
 
* I queried as to how long the dingo had been lying around their camp. He indicated that the 
dingo had been a regular visitor to their camp since they had arrived several days earlier. On this 
occasion he said the dingo had been lying in that spot for approximately 5-10 minutes. 
 
* I outlined to nd his wife that the QPWS requests that campers actively attempt to deter 
dingoes from loitering around their campsites. I suggsted that needed to do this in the future 
so as to try and prevent the reinforcement of habituated behaviours from dingoes such as this one. 
 
* While speaking with the family the dingo returned toward their camp and approached the group of us 
closely. I chased the dingo away with a length of PVC pipe (fishing road holder).  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: * Chased dingo away from the campsite. 
* Requested the assistance of the campers to continue to actively deter this and any other dingoes form 
their campsite. 
 
 
 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Proposed further action: Refer to NRM Ranger for assessment and action. 
 
 
 
 
 
Faxed/emailed date:  7/4/14                                              Reporting Officers details:  
7027146 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unknown dingo / es 
 
Date (of Interaction): 7 / 4 / 14 
Location (of Interaction): One Tree Rocks CZ 

Time (of Interaction 24hrs): 1500 (approx) 
Reporting Officer/s details:  7027904 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
        

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments No food or rubbish had been stored in the tent. 
 
 
 
Detailed report of events:  
 
On returning to camp, it was noticed that something, probably a dingo, had torn 2 holes in a tent at the 
camp site. Nothing had been taken and there were no food items or anything else apparent in the tent 
that would have caused a dingo to rip in to the tent. 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:  
 
No dingoes were present at the time but there were a total of 5 dingoes seen in the area by the group 
and green was seen on a tag of one. 
 
 
 
 
 
Action taken: Report taken 
 
 
 
 
 
 
Proposed further action:       
 
 
 
 
 
Faxed/emailed date:                                      Reporting Officers details:  7027904 
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Photos  
  

 

Photo 1. 
Description (who took 
photo/when):  The damage to the 
tent (7027904) 
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Dingo Interaction Report Form Insert Code: C Dingo ID: 2 unknown 
 
Date (of Interaction): 8/04/14 
Location (of Interaction): Beach front, Cathedral 
Store 

Time (of Interaction 24hrs): 1800 
Reporting Officer/s details: 7028595 & 7027848 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)          
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) The two dingoes did not 

leave the area  
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults             2 
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged 
No -not all dingo(s) (detail) 
    Details: One was tagged 
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address Middle Park. 
Phone #:
Age: 40 
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: and his family were driving to Cathedral Beach store at around 7pm on 
the 8.04.14 when they saw what appeared to be a man in his early 20's sitting on the ground in front of a 

He was looking suspcious as there were two dingoes 
near by eating something off the ground. As it was dark it was difficult to see clearly but the man looked 
like he had some sought of food,bait etc in a circle infront of him. approached the man on his way 
up the ramp to the Cathedrals Store and asked him if he was ok. The man replied in an unfriendly 
manner telling him to go away. This made more suspcious and he tried to obtain the car 
registration number with the aid of his torch but was not successful.  
 
 
 
Additional comments and notes: and his friend noticed the man was still there after they came 
back down the ramp about 20 minutes later as well as the two dingoes. 
 
 
Action taken: Reported incident and continued patrols in camp zones. 
 
 
 
Proposed further action:       
 
 
 
Faxed/emailed date:  16/04/14                                              Reporting Officers details:  
7028595 & 7027848 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unknown dingo / es 
 
Date (of Interaction): 8 / 4 / 14 
Location (of Interaction): One Tree Rocks CZ 

Time (of Interaction 24hrs): 0500 (approx) 
Reporting Officer/s details:  7027904 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
       see list on report 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify) Esky 
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments The campers tried to secure food by putting a large tent peg through the 'eyes' on the 
esky lid but dingoes were still easily able to access the contents 
 
 
 
Detailed report of events:  
 
On waking in the morning, it was observed that a dingo or some dingoes had taken a block of butter, 
one kg of sausages, 66 eggs, ½ kg bacon and 150 plastic wrapped cheese slices of from an 
inadequately secured esky. 
 

also mentioned that he woke at 0600 to find a dingo between his tent and his tent fly. It was 
startled and ran away when he woke and no ID was seen. 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:  
 
No dingoes were seen taking the food but there were a total of 5 dingoes seen in the area and green 
was seen on a tag of one. 
 
 
 
 
 
Action taken: Report taken and advice on securing food given 
 
 
 
 
 
 
Proposed further action:       
 
 
 
 
 
Faxed/emailed date:                                      Reporting Officers details:  7027904 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
  

 

Photo 1. 
Description (who took 
photo/when):  Padlock eyes 
similar to the esky at the camp 
where a tent peg was placed 
(internet image and peg drawn in) 
 

 

Photo 2. 
Description (who took 
photo/when):  Chew marks on 
esky (7027904) 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified juv 
 
Date (of Interaction): 9 April 2014 
Location (of Interaction): Yidney Rock beach 

Time (of Interaction 24hrs): 13:35 
Reporting Officer/s details: 7026466 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       
  Interference with dingoes  Vehicles swerving 

towards the dingoes     
 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Unsure - observers left the 

scene. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile             1 
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Young looking. Dark back and tail. 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: 
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments People were not spoken to. 
 
 
 
Detailed report of events: reported the following interaction to QPWS ranger 7029704.  
 
Both were driving along the eastern beach when they observed a White Toyota Land cruiser troupe 
carrier (older style) stopped with a dingo behind it. They looked to be stopped to take photos of the dingo 
but they revved the motor,  "chucked a U-turn and straightened up, accelerating towards the dingo". The 
dingo dodged the vehicle by moving to the rocks and tucked itself in closer to the rocks.  
 

pulled his vehicle in behind the troupe carrier and followed them off. The troupe carrier continued to 
the south side of Yidney and onto the bypass and doubled back to the original area where the dingo 
was. noticed that the tyre rack at the back had not been closed or latched before the Toyota took off. 
 
Due to having young family in the vehicle did not want to continue following the troupe and possibly 
cause aggrivation. A photograph was taken of the vehicle QLD registration number
 
Dingo looked young (2013 born juvenile). 
 
 
 
Additional comments and notes: 

 
From ParksQ – vehicle owner details –

 
 
 
Action taken: Report generated.  RIC notified. 
 
 
 
Proposed further action: Education 
 
 
 
Faxed/emailed date:  07/04/2014                               Reporting Officers details:  7026466 
 
 
 
 
 
 
 
 
 
 
 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
 

 

Photo 1. 
Description (who took 
photo/when):  Taken By

Note tail gate not 
secured or closed. 
 

 Photo 2. 
Description (who took 
photo/when):        
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified Dingo 
 
Date (of Interaction): 9/4/14 
Location (of Interaction): Maheno CZ 

Time (of Interaction 24hrs): During night 
Reporting Officer/s details: 7028576 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: Couple slept in their vehicle, during the night a dingo ripped their tent. The 
dingo was not seen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Previous day male tagged dingo (red in tag) and an untagged dingo 
passed through the camp.  
 
 
 
 
 
Action taken: Report generated 
 
 
 
 
 
 
 
 
Proposed further action: Continue briefings 
 
 
 
 
 
Faxed/emailed date:  27Apr14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: GGPi13F 
 
Date (of Interaction): 10Apr14 
Location (of Interaction): Happy Valley 
Beachfront 

Time (of Interaction 24hrs): 0930 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) after blocked by vehicle and 

family inside fence 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile       1       
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Right  
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   Independant      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments When recommended to leave the beach they did so 
 
 
 
Detailed report of events: At approx. 0930 Ranger 7027330 was patrolling Nth from Eurong, on arrival 
at Happy Valley beachfront an a lady with two young children was seen walking Nth in the vicinity of the 
ramp. On continuing Nth a juvenile dingo was seen heading Sth at this point the ranger turned around 
and advised the lady with the children to return to the fenced area of Happy Valley which she did. The 
ranger then went back to the dingo who was continuing travelling Sth. The dingo was positively identified 
as GGPi13F and photographed. The dingo noticed the family moving toward the ramp and changed 
direction toward them. The ranger placed the vehicle between the dingo and the family untill the family 
was inside the fenceline. 
 
 
 
 
 
 
 
 
 
Additional comments and notes: The dingo displayed no aggression and got no closer than 75M to 
the family 
 
 
 
 
 
Action taken: Ric Nth informed, report generated 
 
 
 
 
 
 
 
 
Proposed further action: Continue patrols, monitor animal. 
 
 
 
 
 
Faxed/emailed date:  11Apr14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  7027330 10 Apr 
2014      
 

 Photo 2. 
Description (who took 
photo/when):        
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 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: BWR13m 
 
Date (of Interaction): 11/04/2014 
Location (of Interaction): OTR CZ Beachfront 

Time (of Interaction 24hrs): 11:30 
Reporting Officer/s details: 7028020 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Was chased away and 

returned after a short period 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: BWR13m 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   unknown      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Whilst walking along the beach with a friend an off duty QPWS ranger 
observed a dingo lying on the sand close to two fishermen.  As the ranger got closer they were able to 
identify the dingo as BWR13m from his ear tag.  The dingo was observed being chased away from the 
fishermen but returning after a short time and lying down nearby again. 
The dingo was not wary of people walking past and photos were taken to confirm identification.  When 
the ranger was approx. 50m past the dingo they looked back and observed the dingo walking towards 
the fishermen and standing within 5m of them. 
 
 
 
Additional comments and notes: A QPWS ranger vehicle had just stopped to talk to the fishermen 
prior to this incident. 
 
 
 
Action taken: Report compiled and circulated. 
 
 
 
Proposed further action: Continue patrols in this area, including mornings and afternoons.  Monitor 
behaviour of this habituated individual.  Consider closing Wongai & One Tree Rocks camping areas if 
behaviour continues. 
 
 
 
Faxed/emailed date:  19/04/2014                               Reporting Officers details:  7028020 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  BWR13m, 11.04.14 
 

 

Photo 2. 
Description (who took 
photo/when):  BWR13m & 
fishermen, 11.04.14 
 

 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Dingo Interaction Report Form Insert Code: C Dingo ID: GGG13M 
 
Date (of Interaction): 11Apr14 
Location (of Interaction): Cathedral Beach 
Beachfront 

Time (of Interaction 24hrs): 1145 
Reporting Officer/s details: 7028576 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GGG13m 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   QPWS employee      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Single juvenile male sighted loitering at Cathedrals beachfront. The animal 
approached the QG and attemted to solicite food. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: This animal is habituated however showing no aggression at this 
stage. 
 
 
 
 
 
Action taken: Report generated 
 
 
 
 
 
 
 
 
Proposed further action: Monitor animal, continue briefing program. 
 
 
 
 
 
Faxed/emailed date:  23Apr14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: GGPi13F 
 
Date (of Interaction): 11 Apr 14 
Location (of Interaction): Eli Ck 

Time (of Interaction 24hrs): 0930 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) followed off site by ranger 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile       1       
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Right  
    Details: GGPi13F 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

15-166 File C 147 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 2 

Questionnaire:                  Specify visitor type   QPWS employee      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: At approx. 0930 ranger 7027330 was patrolling Eli Ck when a dingo 
approached from the Sth and proceeded along the southern bank. The dingo was photographed and 
watched from the Nth bank of the creek. The dingo was identified as GGPi13F. The dingo was followed 
up the board walk toward the toilet block and down to the beach. The dingo then headed back Nth 
toward the creek were it was intercepted by ranger 7027330 it then turned Sth and left the area. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Showed no aggression at this time displays high level of habituation. 
Wary when approached by rangers but will walk straight toward campers. 
 
 
 
 
 
Action taken: RIC Nth informed, report generated. 
 
 
 
 
 
 
 
 
Proposed further action: Monitor animal patrol area. 
 
 
 
 
 
Faxed/emailed date:  11Apr14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  7027330 11 Apr 14 
Eli Ck 
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified Dingo 
 
Date (of Interaction): 12/4/14 
Location (of Interaction): Dundubara 
Campground 

Time (of Interaction 24hrs): 0530 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) got back out over the grid 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   QPWS employee      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Ranger 7027330 was leaving Dundubara to commence early patrol when 
dingo tracks were sighted inside the fence line. The ranger patrolled the fence line for any signs of 
breeches none were found, signs of the dingo attempting to dig out were found. With the assistance of 
four other rangers a sweep of the vegetated area in the campground was made no sign of the dingo was 
found. All camps were informed that there may be a dingo inside the fenced area, no campers reported 
sightings. Patrols were conducted late that evening and early the next morning no fresh signs were 
found. 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: On first finding the tracks inside the fence line there were tracks of 3-
4 dingoes being very active outside the grid on the in road. Initially this was thought to have been the 
activity that caused the dingo to cross the grid; however this may have been the activity post exiting the 
fence. 
 
 
 
 
 
Action taken: Patrol fence line, inform RIC, sweep vegetated area, brief campers, patrol camp and 
fence line, generate report. 
 
 
 
 
 
 
 
 
Proposed further action: Investigate design and engineering measures to facilitate the swift removal of 
dingoes from fenced areas.  
 
 
 
 
 
Faxed/emailed date:  28 Apr14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
 

 

15-166 File C 152 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 1 

Dingo Interaction Report Form Insert Code: C Dingo ID: GGG13m 
 
Date (of Interaction): 13/4/14 
Location (of Interaction): Gurruman CZ 

Time (of Interaction 24hrs): 1100 
Reporting Officer/s details: 7027816 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GGG13m 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: eenage daughter witnessed a Nissan Patrol drive up to GGG13m and 
proceed to throw unidentified food items to the dingo. The incident occurred on the beach in front of their 
camp. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Latter the same day GGG13m loitered around their camp while they 
were having dinner. 
 
 
 
 
 
Action taken: Report generated, campers in area briefed. 
 
 
 
 
 
 
 
 
Proposed further action: Increase patrols 
 
 
 
 
 
Faxed/emailed date:  27Apr14                                              Reporting Officers details:  
7027330 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
 

 

Release
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Dingo Interaction Report Form Insert Code: Code C Dingo ID: Unidentified 
dingoes 
 
Date (of Interaction): 13/04/14 
Location (of Interaction): Gabala CZ 

Time (of Interaction 24hrs): 2300 
Reporting Officer/s details: 7026936 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify) Waeco esky 
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     click to select 
b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1+ 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #: 
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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  lunging (attempting to nip or bite) 
Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Waeco esky's are quite secure however must still be strapped down as dingoes are 
able to gain access 
 
 
 
Detailed report of events: awoke on the morning of the 14/04/14 to find that his Waeco esky had 
been broken into and saw dingo tracks all around his campsite. His two daughters said that they heard 
"the dingoes" outside their tent in the night. The dingoes stole 1kg of sausages, milk and butter.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: was asked to secure the waeco esky with a strap and to be extra vigilant with food 
security. He was also warned to actively deter the dingoes, as they are likely to return. 
 
 
 
 
 
 
 
 
Proposed further action: Continue to patrol area and make campers aware that this type of behaviour 
is occurring in this area. 
 
 
 
 
 
Faxed/emailed date:  15/4/14                               Reporting Officers details:  7026936 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
 

 

15-166 File C 159 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 1 

Dingo Interaction Report Form Insert Code: C Dingo ID: GGG13m 
 
Date (of Interaction): 15/4/14 
Location (of Interaction): Pinnacles 

Time (of Interaction 24hrs): 13:04 
Reporting Officer/s details: 7027816 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Both cars present drove 

away. dingo wandered along the beach. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 2             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: Green tag and BWY13m 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Not taken - witnessed by ranger. 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   Independant      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Stayed in vehicle and didn't feed dingo. 
 

 
Detailed report of events:  Patrolling rangers observed GGG13m approach a white landcruiser at the 
front passenger door. His face was up turned towards the window in a manner consistent with soliciting 
food then it lay down on the beach next to the stationary vehicle in close proximity as pictured. 
 
The second male dingo (BWY13m) went to the fore dunes and found a dead bird to play with. 
 
 
 
 
Additional comments and notes: This behaviour is regularly observed from GGG13m. There are 
concerns this dingo will eventually be hit by a vehicle. Dingo did not display aggressive behaviour. 
 
 
Action taken: Took photos and video. Interaction reported to RIC NRM. Rangers stayed in the vicinity 
until the two vehicles left. 
 
 
Proposed further action: Refer to NRM Ranger for assessment and action. 
 
 
Faxed/emailed date:  16/4/14                                           Reporting Officers details:  7026466 
 
 
 
 
 Photos  
 

 

Photo 1. 
Description (who took 
photo/when):  7026466 15Apr14 
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Photo 2. 
Description (who took 
photo/when):  7026466 15Apr14. 
Second dingo in background. 
 

 

Photo 3. 
Description (who took 
photo/when):  7026466 15Apr14  
 

 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Dingo Interaction Report Form Insert Code: C Dingo ID: PuOW13m 
 
Date (of Interaction): 15/04/2014 
Location (of Interaction): Eurong Township and 
Resort 

Time (of Interaction 24hrs): Unknown 
Reporting Officer/s details: 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) When trapped 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: PuOW13m 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Ranger 7028018 
Address:       
Phone #: 07 4127 9128 
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   QPWS employee      

Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: On the 15th April, ranger 7027118 was contacted by a Second Valley 
resident, notifying QPWS that a dingo was seen inside the fence. After investigation it was confirmed 
that a dingo was inside the fenced area. 
 
Rangers 7028018 & 7028020 trapped on the nights of the 16th & 17th April, inside the fenced area and 
captured the animal at 2025 on the night of the 17th. The dingo was an untagged juvenile male dingo 
later tagged PuOW13m. The dingo was released later that night.  
 
 
Additional comments and notes: Due to four reported dingoes in the past month inside the Eurong 
fenced area (1 unconfirmed) and all scheduled fence inspections and maintenance completed, NRM 
rangers are investigating the possibility that the dingoes were encouraged inside the fence intentionally.  
 
 
Action taken: Interviews taken and a report generated and circulated. Dingo ranger notified. 
 
 
Proposed further action: Continue investigations into how the dingoes are entering the fenced area. 
 
 
Faxed/emailed date:  22/04/2014                               Reporting Officers details:  7028018 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Purple Red 
 
Date (of Interaction): 16 April 2014 
Location (of Interaction): Beachfront, Eurong 
near Ranger Station water point 

Time (of Interaction 24hrs): 1430 
Reporting Officer/s details: 7027904 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) 4        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) The dingo hung around for a 

while. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile             1 
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: Purple Red 
 
d. Which ears were tagged Unknown 
    Details: Confirmed identity 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Purple and Red Tag 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address: Narangba 
Phone #
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments: The family involved had been briefed about dingo safety earlier that morning by 
myself and 7026804 
    
 
 
 
Detailed report of events:  
 
On exiting the workshop driveway, myself and 7027772 observed a dingo close by a red 4WD 

I saw the dingo pick something up and eat it near the passenger side of the car. I 
drove up to the red 4WD and saw the dingo pick up a bread crust. I observed an adult female in 
the front passenger seat, a very young child behind her and a slightly older child seated behind 
the driver’s seat. I got out of my vehicle and asked the female what she was doing feeding a 
dingo. The female stated that her 18 month old child had thrown bread crusts out the window. I 
explained the importance of dingoes not associating food with humans. She was very very 
appologetic.   
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: Spoken to, recorded vehicle registration details, reported. 
 
 
 
 
 
 
 
 
Proposed further action:  
 
 
 
 
 
Faxed/emailed date:   April 2014                               Reporting Officers details:  7027904 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unknown dingo / es 
 
Date (of Interaction): 16 & 17 / 4 / 14 
Location (of Interaction): One Tree Rocks CZ 

Time (of Interaction 24hrs): 1200 - 1530 
Reporting Officer/s details:  7027904 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
        

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify) Board game 
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             Unknown 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Gold Coast 
Phone 
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments No food or rubbish had been stored in the tent. 
 
 
 
Detailed report of events:  
 
On returning to camp on 2 occasions 16th @ 1500 and 17th @ 1530, it was noticed that something, 
probably a dingo, had torn holes in a tent at the camp site. The only thing taken was a board game, both 
times (photo). 
 
There were no food items or anything else apparent in the tent that would have caused a dingo to rip in 
to the tent. 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: On 16/4/14 at 2240, some cleaned plates were removed from a 
picnic backpack. They were dropped near by. 
 
3 Dingoes were seen in the area. Tags were White & Red, Yellow & Beige (?) and one was seen to be 
green. 
 
 
 
 
 
Action taken: Report taken 
 
 
 
 
 
 
Proposed further action:       
 
 
 
 
 
Faxed/emailed date:                                      Reporting Officers details:  7027904 
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Photos  
  

 

Photo 1. 
Description (who took 
photo/when):  The damage 
to the tent the 1st time 
(7027904) 
 

 

Photo 2. 
Description (who took 
photo/when):  The damage 
to the tent the 2nd time 
(7027904) 
 

 

Photo 3 
The board game 
(7027904) 
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Dingo Interaction Report Form Insert Code: C Dingo ID: GY13m 
 
Date (of Interaction): 17 April 2014 
Location (of Interaction): Beachfront, Eurong 
Ranger Station 

Time (of Interaction 24hrs): 1200hrs 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: Green Yellow (bicolour) 
 
d. Which ears were tagged Left 
    Details: Confirmed identity 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Small white tail tip 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: White Toyota Hilux Dual Cab utility 
Address: NSW rego
Phone #: Camping at Dilli Village 
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      

Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments       
 
 
 
Detailed report of events: Whilst on patrol, myself and Ranger 7028641 observed a stationary Hilux by 
which a dingo (confirmed through ear tag to be GY13m) was scrounging around within 2m of the car. 
The adult female passenger at one stage as we were approaching the car had her hand draped outside 
the car window and the dingo was sniffing at the ground, although there was insufficient evidence to 
suggest that she had dropped the dingo any food. The woman began photographing the dingo as we 
pulled up alongside the vehicle and I exited our vehicle to talk to them, stopping them as they attempted 
to drive off. I asked them how long the dingo had been around for, and the woman replied "half an hour" 
and then I provided them with a quick dingo briefing (established that they were camping at Dilli Village 
and aware of illegality of feeding dingoes) and suggested that we are concerned about dingoes being 
nonchalant around vehicles due to the risk of vehicle strike and possibility of being thrown food, to which 
the male driver responded "that's why we were leaving" before they departed. 
 
 
 
 
 
 
 
 
 
Additional comments and notes: GY13m very habituated and regularly sighted on Eurong beachfront 
 
 
 
 
 
Action taken: Spoken to, recorded vehicle registration details, reported. 
 
 
 
 
 
 
 
 
Proposed further action: Monitor dingo activity on Eurong beachfront, consider temporarily closure of 
One Tree Rocks and Wongai camping zones to mitigate dingo activity. 
 
 
 
 
 
Faxed/emailed date:  20 April 2014                               Reporting Officers details:  7026804
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified male dingo 
 
Date (of Interaction): 18/04/2014 
Location (of Interaction): One Tree Rocks 
Camping Area 

Time (of Interaction 24hrs): 14:00 
Reporting Officer/s details: 7027772 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #: 07 4127 9128 
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   QPWS employee      

Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: At 14:00 on the 18th April, rangers whilst patrolling the One Tree Camping 
area noticed a dingo going in and out of campsites. When the rangers approached the dingo is promptly 
ran up the sand dunes and sat down and watched. It was later discovered by the owners of the camps 
that the dingo had ripped into their tents and eaten all their chocolate Easter eggs. 
 
 
Additional comments and notes: The dingo is most likely a member of the habituated Eurong pack. 
 
 
Action taken: Interviews taken and a report generated and circulated. Dingo ranger notified. 
 
 
Proposed further action: Continue camp briefings. Continue early morning and afternoon ranger 
patrols for compliance, community liaising, risk mitigation and monitoring purposes during the busy 
Easter holiday period. 
 
 
Faxed/emailed date:  20/04/2014                               Reporting Officers details:  7028018 
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Dingo Interaction Report Form Insert Code: C Dingo ID: BGB01f + one 
unidentified 
 
Date (of Interaction): 18.04.2014 
Location (of Interaction): Third northernmost 
noded, Gabala Camping Zone 

Time (of Interaction 24hrs): 1310hrs 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) interrupted by rangers 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults       1       
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details: BGB01f confirmed identity, other dingo 
fled swiftly so was unidentified 
 
d. Which ears were tagged Right  
    Details: BGB01f (refer attached photos) 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Private camp (all food secure) 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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  lunging (attempting to nip or bite) 
Questionnaire:                  Specify visitor type   camper      

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Campers not present at camp, no breach of dingo safe message detected at camp (all 
food secured - had been briefed) 
 
 
 
Detailed report of events: Whilst on patrol, ranger 7028026 and myself observed two dingoes loitering 
around a vacated campsite (van and gear present but no persons; all food and rubbish secured). The 
initial observation was from the beach 40m away, and on driving up the driveway of the camp one of the 
dingoes fled into the bush and thus remained unidentified (not sure of gender or if tagged) whilst the 
other dingo was curious of our vehicle and not wary of us. I was thus able to photograph and positively 
identify the dingo as BGB01f (confirmed through ear tag, scarring on face and pale fur coloration). The 
dingo fled into the bush within approximately 30 seconds of our vehicle being present. 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Photos of interaction attached 
 
 
 
 
 
Action taken: Photographed and reported. 
 
 
 
 
 
 
 
 
Proposed further action: Monitor activity, continue to brief camps in territory
 
 
 
 
 
Faxed/emailed date:  20 April 2014                               Reporting Officers details:  7026804
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1.
Description (who took 
photo/when): 7026804 during 
interaction 
Two dingoes (obscured by 
vegetation, refer arrows) 

 

Photo 2.
Description (who took 
photo/when):  7026804 
Camp driveway 

 

Photo 3.
Description (who took 
photo/when):        
 

Release

15-166 File C 176 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 4

 

Leaving camp – into bush 

 

Leaving camp – into bush 
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Dingo Interaction Report Form Insert Code: C Dingo ID: GGG13m 
 
Date (of Interaction): 19,20,21,22 April 2014 
Location (of Interaction): Eugarie - Dundubara 

Time (of Interaction 24hrs): AM/PM
Reporting Officer/s details: 7027202 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) when moved on by rangers 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GGG 
 
d. Which ears were tagged Unknown 
    Details: LEFT 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:  
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   unknown      

Did they receive an information pack with their permits No 
Did they read the Dingo BrochureNo 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments       
 
 
 
Detailed report of events: GGG loitering around camps, walking through camps, walking close to 
people, laying on the beach, laying under parked vehicles, sitting next to vehicles having photos taken, 
chasing vehicles moving between camps from K'gari to Dundubara. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Campers were all advised of this dingo and it's behavior and no 
incidents were reported. 
 
 
 
 
 
Action taken: Report completed 
 
 
 
 
 
 
 
 
Proposed further action: NRM dingo ranger to advise
 
 
 
 
 
Faxed/emailed date:  22.4.14                                              Reporting Officers details:  
7027202 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):        
 

 Photo 2.
Description (who took 
photo/when):        
 

 Photo 3.
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: GGPi13f 
 
Date (of Interaction): 19 April 2014 
Location (of Interaction): Happy Valley 
beachfront, 100m north of 80km sign 

Time (of Interaction 24hrs): 1720hrs 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) within 1m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) didn't leave - persisted  

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile       1       
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GGPi13f (confirmed) 
 
d. Which ears were tagged Right  
    Details: Confirmed identity by ranger 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Happy Valley resident 
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

15-166 File C 181 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 2 

Questionnaire:                  Specify visitor type   resident      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Attempted unsuccessfully to discourage dingo by throwing sand at it 
 
 
 
Detailed report of events: Whilst on patrol, I observed GGPi13f within 1m of local resident and two 
other men who were worming with a bag filled with fish offal. The men were throwing small handfuls of 
sand towards the dingo in an attempt to discourage her. She would move off slightly but still maintain her 
interest in the group. On talking to it was determined that GGPi13f had been around them for a 
few minutes and he mentioned an interaction that had occurred 10 mins prior involving GGPi13f 
chasing/herding two girls (has been submitted as a Code D). On us leaving the scene, GGPi13f was still 
within a few metres of the men. 
 
 
 
 
 
 
 
 
Additional comments and notes: Very habituated. Behaviour indicates possibly consistently fed. 
Unwary of QG vehicles or uniformed rangers. 
 
 
 
 
 
Action taken: Interviews taken and a report generated and circulated. Dingo ranger notified. 
 
 
 
 
 
 
 
 
Proposed further action: Monitor, continue morning and afternoon briefings in known territory. 
 
 
 
 
 
Faxed/emailed date:  22 April 2014                               Reporting Officers details:  7026804 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Dingo Interaction Report Form Insert Code: C Dingo ID: GY13m 
 
Date (of Interaction): 19 April 2014 
Location (of Interaction): Beachfront, Eurong 

Time (of Interaction 24hrs): 1635hrs 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) within 5m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) didn't leave - persisted 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile       1       
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GY13m 
 
d. Which ears were tagged Left 
    Details: Confirmed by ranger 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Observer - ranger 7026804 
Address: Details of persons not recorded 
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   unknown      

Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments Were not attempting to discourage dingo presence 
 
 
 
Detailed report of events: Whilst on patrol, we observed GY13m loitering around a group of men 
fishing and worming, often approaching to within 5m, demonstrating particular interest in their worming 
bag containing fish frames. The dingo would occasionally retreat and lie down on the wet sand feigning 
disinterest about 10m from the men. I spoke briefly to a member of the group who suggested that the 
dingo had been present for "a couple of hours". 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Dingoes around Eurong beachfront seem to be particularly 
interested recently in worming activity. 
 
 
 
 
 
Action taken: Interviews taken and a report generated and circulated. Dingo ranger notified. 
 
 
 
 
 
 
 
 
Proposed further action: Monitor, continue briefings on beach and patrols, consider temporary closure 
of Wongai and One Tree Rocks CZ. 
 
 
 
 
 
Faxed/emailed date:  22 April 2014                               Reporting Officers details:  7026804

Release
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):        
 

 Photo 2.
Description (who took 
photo/when):        
 

 Photo 3.
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unknown 
 
Date (of Interaction): 19/04/2014 
Location (of Interaction): One Tree Rocks CZ 

Time (of Interaction 24hrs): Afternoon 
Reporting Officer/s details: 7028641 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                  
Sub adults                  
Juvenile                  
Unknown Age            Unknown 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   Independant      

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: During the afternoon of 19/04/2014 four tents were ripped into in a vacant 
campsite.  Three tents did not have any food in them, the fourth had some vitamins stolen out by 
dingoes. 
 
 
 
Additional comments and notes:       
 
 
 
Action taken: Report completed and circulated. 
 
 
 
Proposed further action: Continue patrols, including mornings and afternoons, in this area.  Monitor 
behaviour of habituated dingoes frequenting this area. 
 
 
 
Faxed/emailed date:  20/04/2014                               Reporting Officers details:  7028641 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unknown 
 
Date (of Interaction): 19/4/14 
Location (of Interaction): Orchid Beach 

Time (of Interaction 24hrs): 1400
Reporting Officer/s details: 7027202 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) When approached by ranger 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults 1             
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged No 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Large Solid Male  
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Did not want to supply 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   Independant      

Did they receive an information pack with their permits No 
Did they read the Dingo BrochureNo 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments Group of fisherman staying at Orchid Beach 
 
 
 
Detailed report of events: While patrolling between Orchid Beach and Ngkala Rocks a large male 
dingo was seen with head in fishermans bucket, upon inspection the bucket was empty, spoke to 
fisherman and they were not interested in conversation.I advised them of their responsibility. Other 
campers reported seeing this dingo in the past few days with no incident. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: Report completed 
 
 
 
 
 
 
 
 
Proposed further action:       
 
 
 
 
 
Faxed/emailed date:  22.4.14                                              Reporting Officers details:  
7027202 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):        
 

 Photo 2.
Description (who took 
photo/when):        
 

 Photo 3.
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unknown dingo / es 
 
Date (of Interaction): 20 / 4 / 14 
Location (of Interaction): Wongai CZ 

Time (of Interaction 24hrs): 1800 - 1600 
Reporting Officer/s details:  7027904 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify) paper towels - 

new in plastic 
  tent ripping (vacant campsite or tent) 

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             Unknown 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments No food or rubbish had been stored in the tent. 
 
 
 
Detailed report of events:  
 
On returning to camp, it was noticed that a/some dingo/es, had torn holes in a tent at the camp site. 
Some paper towells, new in plastic were destroyed. 
 
There were no food items or anything else apparent in the tent that would have caused a dingo to rip in 
to the tent. 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:        
 
 
 
 
 
Action taken: Report taken 
 
 
 
 
 
 
Proposed further action:       
 
 
 
 
 
Faxed/emailed date:                                      Reporting Officers details:  7027904 
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Photos  
  
Photos to be emailed Photo 1. 

Description (who took 
photo/when):   
 

Photos to be emailed Photo 2. 
Description (who took 
photo/when):   
 

Photos to be emailed Photo 3 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unknown 
 
Date (of Interaction): 20/04/2014 
Location (of Interaction): Eurong Township - 
beach access near pub gate 

Time (of Interaction 24hrs): Between 02:00-07:00
Reporting Officer/s details: 7028641 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                  
Sub adults                  
Juvenile                  
Unknown Age            Unknown 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Camp Hill 
Phone #
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   Independant      

Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Sometime between 02:00am and 07:00am dingoes gained access into an 
unsecured esky left out.  Removed all food from the esky including several packets of ham, butter, 
bread, etc 
 
 
 
Additional comments and notes: A no penalty (warning) PIN was issued. 
 
 
 
Action taken: Report completed and circulated. 
 
 
 
Proposed further action: Continue patrols, including mornings and afternoons, in this area.  Monitor 
behaviour of habituated dingoes frequenting this area. 
 
 
 
Faxed/emailed date:  20/04/2014                               Reporting Officers details:  7028641 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unknown dingo(es) 
 
Date (of Interaction): 21-22 April 2014 
Location (of Interaction): Eurong ranger base 
residence 

Time (of Interaction 24hrs): overnight 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
       bag of recyclables 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) when it had taken bag 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             unknown 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: QPWS ranger 7027522 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   QPWS employee      

Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Ranger 7027522 reported that his back screen door had inadvertently not 
been secured overnight and on the morning of 22 April 2014 he realised that the bag of recyclable 
materials (primarily beer cans) had been stolen from his laundry floor and its contents strewn on the 
lawn. The dingo(es) responsible was neither heard nor sighted. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: I had observed an unidentified dingo passing between my house and 
ranger 7027522’s house at 1820hrs on 21/4/14. 
 
 
 
 
 
Action taken: Interviews taken and a report generated and circulated. Dingo ranger notified, all staff 
reminded of their responsibility to ensure that their residences are not accessible by dingoes, screen 
door checked to ensure functionality. 
 
 
 
 
 
 
 
 
Proposed further action: Monitor dingo activity in local area 
 
 
 
 
 
Faxed/emailed date:  23 April 2014                               Reporting Officers details:  7026804
 
 

Release
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unknown 
 
Date (of Interaction): 21/4/14 
Location (of Interaction): Eugarie CZ 

Time (of Interaction 24hrs): 0200
Reporting Officer/s details: 7027202 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
       Easter Eggs 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     8 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             8 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:  
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   Independant      

Did they receive an information pack with their permits No 
Did they read the Dingo BrochureNo 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments Rangers briefed him at barge and at camp. 
 
 
 
Detailed report of events: Camper advised ranger of a sighting of eight dingoes in the early morning, 
camper was woken by dingoes making noise aroung his camp at 0200, cmaper checked and said he 
counted eight dingoes "playing" around his camp, he watched until they left, when he got up he noticed 
that a easter egg had been intefered with. He commented on how vigilent he had been with food storage 
and had not issues in the past. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Camper was reminded of his obligations and issued further 
information on dingo safety. 
 
 
 
 
 
Action taken: Report completed 
 
 
 
 
 
 
 
 
Proposed further action:       
 
 
 
 
 
Faxed/emailed date:  22.4.14                                              Reporting Officers details:  
7027202 

Release
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):        
 

 Photo 2.
Description (who took 
photo/when):        
 

 Photo 3.
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unknown 
 
Date (of Interaction): 21/04/2014 
Location (of Interaction): Wongai CZ 

Time (of Interaction 24hrs): During the day 
Reporting Officer/s details: 7028020 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify) Swag 
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

15-166 File C 203 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 2 

Questionnaire:                  Specify visitor type   Independant      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: On patrol QPWS ranger 7028020 was informed that when two campers had 
returned to their camp on 21/4/14 from a day out they had found one of their swags was open and the 
contents of a bag were pulled out. 
The visitors indicated that the fly wire had been zipped up and the canvas flap had been pulled up but no 
zipped.  There were paw prints and scratch marks on the flywire, however no damage.  It looked like the 
weight of the dingo had pulled enough that the zip had started to come open and the dingo has then 
pushed with enough force to unzip the fly wire.  A bag was pulled out of the swag and the contents 
strewn around the vicinity.  The bag contained one piece of chewing gum. 
 
 
 
Additional comments and notes: Fly wire was intact but clear evidence of scratching was visible. 
 
 
 
Action taken: Report taken, completed and circulated. 
 
 
 
Proposed further action: Continue patrols in the area, including morning and afternoon.  Monitor 
behaviour of known habituated dingoes in this area.  Consider the closure of Wongai CZ if behaviour 
continues. 
 
 
 
Faxed/emailed date:  05/05/2014                               Reporting Officers details:  7028020 
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Dingo Interaction Report Form Insert Code: C Dingo ID: BWPi13f 
 
Date (of Interaction): 22/04/14 
Location (of Interaction): Eurong Beachfront 

Time (of Interaction 24hrs): 16:30 
Reporting Officer/s details: 7028020 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
       Tried to get in the back of a vehicle 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile       1       
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Left 
    Details: BWPi13f 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   click to select      

Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: While on patrol ranger 7028020 noticed 3 dingoes running around chasing 
each other on Eurong beachfront.  When they got closer it was observed that BWPi13f was approaching 
the rear of a vehicle that had the boot open.  The dingo was observed sniffing the open car and 
preparing to jump up/into the vehicle.  The QPWS ranger got out of the vehicle and yelled at the dingo, 
clapped their hands and walked towards the dingo to deter it from the vehicle. 
The dingo moved away from the open boot, walked around the front of the car and came back towards 
the boot from the other side of the vehicle.  The dingo was chased off again  and it then started moving 
south along the beach.  The owner of the vehicle approached from the water edge where he had been 
fishing and was asked to make sure that the rear of his vehicle was secured. 
 
 
 
Additional comments and notes: Several other vehicles in the area were also spoken to in relation to 
leaving the rear of the vehicle open when they were on the water’s edge fishing. 
 
 
 
Action taken: Interviews taken and a report generated and circulated. Dingo ranger notified. 
 
 
 
Proposed further action: Continue patrols and briefings in this area, including mornings and 
afternoons.  Monitor behaviour of this individual and other habituated dingoes in this area. 
 
 
 
Faxed/emailed date:  03/04/14                               Reporting Officers details:  7028020 
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Dingo Interaction Report Form Insert Code: C Dingo ID: BWR13m 
 
Date (of Interaction): 22/04/14 
Location (of Interaction): Wongai CZ Beachfront 

Time (of Interaction 24hrs): 17:00 
Reporting Officer/s details: 7028020 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
       Head torch in sealed plastic bag 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 2             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Left 
    Details: BWR13m and GY13m 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   click to select      

Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: While on patrol QPWS ranger 7028020 was observing three dingoes on the 
beach in front of Wongai Camp Zone.  These dingoes were running around, chasing each other and play 
fighting in and around fishermen and visitors. 
BWR13m and GY13m approached a milk crate being used by a fisherman to hold some gear.  BWR13m 
stuck his head into the crate, the ranger drove towards the dingo honking the horn of the vehicle to try 
and deter the dingo from the crate.  The dingo ran away from the crate with a sealed bag in his mouth.  
He moved away about 10m and dropped the bag at which time the fisherman informed the ranger that 
the bag held his head torch but the bag had been in contact with a bag of bait which he had in his hand.  
The dingo picked up the torch again and moved away about 20m, the QPWS ranger drove towards the 
dingo at which time the dingo dropped the bag and retreated enough that the fisherman could retrieve 
his torch. 
As the fisherman returned to his crate he noticed that a dingo had his head in the crate again (identified 
as GY13m).  He was chased away and the ranger told him he should put the crate in a vehicle away 
from the dingoes on the beach 
 
 
 
Additional comments and notes: These dingoes had been observed for a while and a couple of other 
Code C interactions have been recorded. 
 
 
 
Action taken: Report generated and circulated.  Dingo Ranger notified. 
 
 
 
Proposed further action: Continue patrols and briefings, including mornings and afternoons, in the 
area.  Monitor the behaviour of the commonly seen habituated dingoes in this area. 
 
 
 
Faxed/emailed date:  23/04/2014                               Reporting Officers details:  7028020 
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Dingo Interaction Report Form Insert Code: Code C Dingo ID: Green Yellow13m, 
BWR13m & BWPi13f 
 
Date (of Interaction): 22/4/13 
Location (of Interaction): Wongai CZ beachront 

Time (of Interaction 24hrs): 1730 
Reporting Officer/s details: 7026936 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) when the man was directed to 

leave 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     3 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 2 1       
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: All three dingoes, Mentioned above. 
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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  lunging (attempting to nip or bite) 
Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureNo 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments       
 
 
 
Detailed report of events: Ranger 7026936 observed some cars stopped next to Three dingoes 
interacting with eachother on the beach. The ranger witnessed someone crouching down and 
approaching the dingoes within 1m, poking (what looked like) a stick in amounst the dingoes as they 
were play fighting.  
 
The ranger intervened with vehicle and saw that the man was poking a "GoPro" on a 1m long pole 
underneath the dingoes. The man was asked to stop what he was doing and was warned that it is an 
offence to interfere with an animal such as a dingo that is capable of causing harm to people, on Fraser 
Island. He appeared to be surprised about this and evidently was not aware of any dingo safe 
messaging on Fraser Island.  
 
The man was asked to move along in his vehicle after he had been briefed.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
Action taken: Briefed in relation to dingo safety. Early and late patrols were being carried 
throughout through this period until 27/4/14. 
 
Proposed further action: Continue dingo briefing and patrols  
 
 
Faxed/emailed date:  29/4/14                               Reporting Officers details:  7026936 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: GGPi13f 
 
Date (of Interaction): 23/4/14 
Location (of Interaction): 200m Sth of Yidney Rks 

Time (of Interaction 24hrs): 0855 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile       1       
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GGpi13f 
 
d. Which ears were tagged Right  
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   QPWS employee      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: While on patrol ranger 7027330 in the vicinity of Yidney Rocks a dingo 
positively identified as GGPi13f was seen heading south. The dingo saw a man and woman worming on 
the beach and headed straight to them. At first the wormers tried to ignore the dingo but it came in closer 
lifting its head. The wormers kicked sand at the dingo which backed off a short distance. At this point the 
ranger drove up and threw sand at the dingo and chased it away. The wormers were briefed and told to 
actively deter dingoes. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: This dingo is regularly seen in this area and is difficult to deter. 
 
 
 
 
 
Action taken: Brief wormers and other fishermen in area, report generated 
 
 
 
 
 
 
 
 
Proposed further action: Continue patrolling and briefing regime, monitor animal. 
 
 
 
 
 
Faxed/emailed date:  28Apr14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  7027330 23Apr14 
 

 Photo 2. 
Description (who took 
photo/when):        
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: Code C Dingo ID: GGPi13f 
 
Date (of Interaction): 25/4/13 
Location (of Interaction): 100 m south of Happy 
Valley 

Time (of Interaction 24hrs): 1715 
Reporting Officer/s details: 7026936 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  Other (specify) the dingo continued 

returning after sand had been thrown at it and 
chased away. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile       1       
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GGPi13f 
 
d. Which ears were tagged Right  
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

15-166 File C 216 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 2 

Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: Ranger observed GGPi13f soliciting food from Two fishermen and a woman 
who was standing with them. The dingo was approaching within 2m then would be chased away 
repeatedly by the people. The dingo would persistently return and when one of the fishermen would 
hook up on a fish the dingo would dart in at speed to try to take the fish from the line in the water. 
Ranger also attempted to deter the dingo by chasing it away and throwing sand at it. This was effective 
until the ranger was driving away who noticed the dingo return to the fishermen again.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: GGPi13f persistently loiters around fishermen in this area. The 
interactions between people and GGPi13f have recently escalated to code E. 
 
 
 
 
 
Action taken: briefed fishermen, and congratulated them on making a concerted effort to deter the 
dingo. Early and late patrols were occurring through this period. 
 
 
 
 
 
Proposed further action:       
 
 
 
 
 
Faxed/emailed date:  29/4/14                               Reporting Officers details:  7026936 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: GGG13M 
 
Date (of Interaction): 26Apr14 
Location (of Interaction): Cathedral Beachfront 

Time (of Interaction 24hrs): 1600 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Walked 50m Sth and went to 

sleep on the beach 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GGG13M 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   QPWS employee      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: While on patrol ranger 7027330 saw a dingo loitering around a group of 
fishermen at Cathedrals beachfront. On approaching the dingo was positively identified as GGG13M a 
dingo that frequents the area. It was observed that every time a fisherman hooked and reeled in a fish 
the dingo approached nose in the air. The fishermen were actively discouraging the dingo but it would 
simply back off 5 to 10m and return. The ranger then threw sand and yelled at the dingo which the 
moved south about 50m and went to sleep. The fishermen were briefed and advised to continue actively 
deterring the dingo. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: This dingo is highly habituated with recent reports of it being feed, 
from its behaviour around fishermen it seems it is used to acquiring food from that source. The animal is 
not reported to have displayed aggression at this stage however its behaviour is deteriorating. This 
dingo is also often found asleep on the beach during the day leaving it open to potential car strike. 
 
 
 
 
 
Action taken: Fishermen briefed, RIC informed, report generated. 
 
 
 
 
 
 
 
 
Proposed further action: Monitor animal, continue briefing regime 
 
 
 
 
 
Faxed/emailed date:  28Apr14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
 

 
Release
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Dingo Interaction Report Form Insert Code: C Dingo ID: GGPi13f 
 
Date (of Interaction): 26/04/2014 
Location (of Interaction): 100m north of Yidney 
Rocks 

Time (of Interaction 24hrs): 17:30 
Reporting Officer/s details: 7026936 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile       1       
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Right  
    Details: GGPi13f 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name: Witness -
Address:       
Phone #:
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   Independant      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments       
 
 
 
Detailed report of events: Ranger 7026936 was providing a dingo briefing to who is a guest at 
the Yidney rocks apartments. mentioned that he witness a white, late model, Hilux pull up next to 
GGPi13f and throw items of food out the window. The dingo then proceeded to eat all of the food that 
the occupants of the vehicle threw out.   
 
 
 
Additional comments and notes: did not record the registration of the vehicle. This dingo is a 
part of a known habituated pack in the area and has been involved in several recent code C, D & E 
interactions. 
 
 
 
Action taken: Currently, patrols are being undertaken early morning and late afternoon to monitor the 
behaviour of GGPi13f and provide dingo briefings to visitors in the area. Regular liaison is occurring with 
all accommodation managers and guest in the area and all people are encouraged to record details of 
any feeding of dingoes.  
 
 
 
Proposed further action:       
 
 
 
Faxed/emailed date:  29/04/2014                               Reporting Officers details:  7026936 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):   
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Dingo Interaction Report Form Insert Code: Code C Dingo ID: GY13m 
 
Date (of Interaction): 27/4/13 
Location (of Interaction): One Tree Rocks CZ 

Time (of Interaction 24hrs): 0715 
Reporting Officer/s details: 7026936 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  Other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile       1       
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GY13m 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   click to select      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Unknown 
Comments       
 
 
 
Detailed report of events: Ranger observed GY13m soliciting food from a vacant camp site. The dingo 
was sniffing around under the tarp of a camp in OTR CZ. The dingo was detered by ranger 7026936 and 
continued patroling through the camp zone.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: GY13m is part of a known habituated pack in the area. 
 
 
 
 
 
Action taken: Deterred dingo and circulated report. 
 
 
 
 
 
Proposed further action: Continue patrols in area to brief camps with regard to food security. 
 
 
 
 
 
Faxed/emailed date:  29/4/14                               Reporting Officers details:  7026936 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: BRG13m 
 
Date (of Interaction): 03/05/2014 
Location (of Interaction): Yidney Rocks 
Beachfront 

Time (of Interaction 24hrs): 16:50 
Reporting Officer/s details: 7028020 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: BRG13m 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   Independant      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: While on patrol QPWS Ranger 7028020 observed BRG13m (positively 
identified from tag and photographs) loitering around a group of fishermen at Yidney Rocks Beachfront. 
BRG13m was hanging around within 10m of the group, when chased away, would only move off to 
about 20m before getting close again. 
He spent about 3mins sniffing around a fishing rod that was in a holder on the beach before circling the 
group and their cars again. 
After being chased off again (yelling, clapping hands) for a third time he slowly started making his way 
south along the beach. 
 
 
 
Additional comments and notes: During this interaction a RBAC tag-along tour drove through the area 
- one of the cars was forced to stop as BRG13m continued walking from the water to the dunes right in 
front of the car without stopping. 
 
 
 
Action taken: Report completed & circulated. 
 
 
 
Proposed further action: Continue patrols & briefings in this area, including mornings and afternoons.  
Monitor behaviour of all known habituated dingoes in this area.  Continue with campground closures 
between Poyungan & Eli. 
 
 
 
Faxed/emailed date:  04/05/2014                               Reporting Officers details:  7028020 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  BRG13m, 7028020 
03/05/14, loitering around fishing 
gear. 
 

 

Photo 2. 
Description (who took 
photo/when):  BRG13m, 
702802003/05/14, walking in front 
of RBAC vehicle. 
 

 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unknown dingo 
 
Date (of Interaction): 03 May 2014 
Location (of Interaction): One Tree Rocks 
camping zone 

Time (of Interaction 24hrs): not specified 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             X 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:An unidentfied dingo was sighted near 
to the camp on the campers return from their walk 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #: 

Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Unknown 
Comments       
 
 
 
Detailed report of events: Dingo has destroyed/ shredded tent at site. No food contained within tent as 
it was locked in car. An unidentified dingo was sighted near the camp as the campers were coming back 
from walk. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Reported through EHP wildlife referral hotline (referred from SSQ)  
Lodgement details Record information here 
Date  04/05/2014 
Time 08:50 
Hardphone telephone number 

CSA name 

 
 
 
 
 
Action taken: Report generated 
 
 
 
 
 
 
 
 
Proposed further action: Continue to monitor area and brief camps within this zone. Consider 
temporary closure of One Tree Rocks and Wongai CZ to mitigate problematic dingo activity. 
 
 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Faxed/emailed date:  06052014                             Reporting Officers details:  7026804 
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Dingo Interaction Report Form Insert Code: C Dingo ID: GGG13M 
 
Date (of Interaction): 5.5.14 
Location (of Interaction): Beach in front of 
Gurruman camping zone 

Time (of Interaction 24hrs): 1640 
Reporting Officer/s details: 7027118 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)     . 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Witness -
Address: Mossvale NSW 2577 
Phone #
Mob.
Age:       
 
Name: Witness - 

Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   click to select      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: nd were camping in Gurruman 
Camping zone (Eastern beach Fraser Island) on the 05.05.14. At 1640 in the afternoon and fellow  
campers noticed a dingo walk passed their camp out onto the beach in front of their camp.  

was trying to take photos of the dingo when two vehicles stopped near the dingo. 
 
A Dark Ford Ranger Dual cab with canopy Registration plates:
Travelling with a Maroon dual cab with canopy. 
 
 
The lady from the Ford ranger initially got out of the vehicle and got within a very close range to take 
photographs of the dingo. Soon after this noticed that both the lady and man (driver of ford ranger) 
appeared to be feeding the dingo. Photos of this action were taken by The people remained in the 
area for a five to ten minute period and then decided to leave. 

 
 
 
 
 
 
 
 
 
Additional comments and notes: From photos dingo identified as GGG13M 
 
 
 
 
 
Action taken: Photographs obtained and circulated, report generated, Information forwarded to 
Compliance unit.  
 
 
 
 
 
 
 
 
Proposed further action: Prosecute offenders. 
 
 
 
 
 
Faxed/emailed date:  08.05.14                                              Reporting Officers details:  
7027118 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacysch4p3( 3) Prejudice the protection of an individuals right to privacysch4p3( 3) Prejudice the protection of an individuals right to privacy
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sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  
1640Hrs 5 May 14 
 

 

Photo 2. 
Description (who took 
photo/when): 
1640Hrs 5 May 14 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacysch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photo 3. 
Description (who took 
photo/when):  
1640Hrs 5 May 14 
 
 

 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

15-166 File C 238 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 1 

Dingo Interaction Report Form Insert Code: C Dingo ID: GGG13M, RBW13F 
 
Date (of Interaction): 6/5/14 
Location (of Interaction): Cathedrals Beachfront 

Time (of Interaction 24hrs): 1000 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1 1       
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GGG13M, RBW13F 
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   QPWS employee      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Ranger 270330 was patrolling Nth past Cathedrals beachfront as agroup of 
fishermen were approached two dingoes were seen loitering in the area. The dingoes were Identified as 
GGG13M and RBW13F. While speaking to the fishermen both dingoes were seen approaching 
fishermen as they caught fish lifting their heads.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: These dingoes show no aggression at this stage they are very 
difficult to deter however. 
 
 
 
 
 
Action taken: Brief fishermen to deter these animals, NMU RIC informed, report generated 
 
 
 
 
 
 
 
 
Proposed further action: Breif fishermen and camps, monitor animals 
 
 
 
 
 
Faxed/emailed date:  14May14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unknown 
 
Date (of Interaction): Around 7/5/14 
Location (of Interaction): Oaks Plane Landing? 

Time (of Interaction 24hrs): Unknown 
Reporting Officer/s details: 7028020 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile             1 
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

s.68(4)(c) Copyright infringement
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Questionnaire:                  Specify visitor type   click to select      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: While looking on Instagram the photo below was seen posted by

This photo looks to have been taken using a phone which would mean the photographer was within very 
close proximity of the dingo. 
 
 
 
Additional comments and notes: has been spoken to on numerous occasions about his 
behaviour around dingoes, especially the habituated pack around Oaks/Yidney. 
 
 
 
Action taken: Report generated.  RIC informed. 
 
 
 
Proposed further action: Follow up with and regarding posting of photos 
shwoing inappropriate dingo interactions which may encourage visitors to undertake similar behaviour. 
 
 
 
Faxed/emailed date:  13/05/14                               Reporting Officers details:  7028020 
 
 

s.68(4)(c) Copyright infringement

s.68(4)(c) Copyright infringement

s.68(4)(c) Copyright infringement

s.68(4)(c) Copyright infringements.68(4)(c) Copyright infringement
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  Photo taken from 
Instagram, posted by 

 

 

s.68(4)(c) Copyright infringements.68(4)(c) Copyright infringement
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Dingo Interaction Report Form Insert Code: C Dingo ID: BWR13m 
 
Date (of Interaction): 15 May 2014 
Location (of Interaction): Wongai CZ - northern 
end 

Time (of Interaction 24hrs): 1210hrs 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) chased off by rangers 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: BWR13m 
 
d. Which ears were tagged Left 
    Details: Confirmed identity 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Campers -
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits No 
Did they read the Dingo BrochureNo 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments Should have discouraged dingo 
 
 
 
Detailed report of events: Whilst briefing a camp at the northern end of Wongai camping zone, ranger 
7027308 noticed a dingo sleeping on the dune approximately 15m from the camp. Upon finalising the 
information provision to campers, ranger 7027308 ran slowly towards the dingo, waking it up by clapping 
our hands and yelling at it. We confirmed the identity as BWR13m through an ear tag in its left ear. 
BWR13m moved slowly to the base of the foredune, yawned and slowly sauntered southwards. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Dingo was not wary of QPWS uniform at all. 
 
 
 
 
 
Action taken: Moved along by rangers, encouraged campers not to allow them to loiter. 
 
 
 
 
 
 
 
 
Proposed further action: Consider temporary closure of Wongai camping zone, particularly if a litter of 
pups occurs adjacent this season. 
 
 
 
 
 
Faxed/emailed date:  15May2014                               Reporting Officers details:  7026804 
 Release
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: GGPi13f 
 
Date (of Interaction): 17 May 2014 
Location (of Interaction): Happy Valley 
beachfront - 200m sth of main entry 

Time (of Interaction 24hrs): 1500hrs 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) within 5-10m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) eventually lost interest after 5 

minutes 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile       1       
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GGPi13f 
 
d. Which ears were tagged Right  
    Details: Confirmed identity + photos attached 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:small white tail tip, seems to be 
favouring rear left leg 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Resident - Yidney Rocks 
Phone #:       
Age:
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   resident      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments Was walking alone with a stick 
 
 
 
Detailed report of events: Whilst on patrol, ranger 7026466 and myself noticed local resident

walking along the beach carrying a stick 
We stopped and chatted to her for approximately 5 minutes, and as we were leaving we 

came across GGPi13f 100m north on the beach. We photographed GGPi13f to confirm her identity and 
stopped to observe her behaviour (as continued north along the beach towards us). GGPi13f 
became interested in and began to follow her at a distance of between 5 to 10 metres for a 
couple of minutes before a vehicle pulled up and the occupants began to speak to and a 
Fraser Explorer Bus driven by also pulled up to allow his clients to photograph the dingo. 
GGPi13f was not wary of rangers or QG vehicle. As we again moved away, GGPi13f continued to stand 
and then sit on the beach within approximately 10m of GGPi13f eventually lay on the sand in 
this same location and did not follow when the car drove off and she continued to walk 
northwards. A male and female couple carrying a stick walked out of Happy Valley township and then 
south along the beach and GGPi13f showed no interest in them. We lost sight of GGPi13f as she 
appeared to head towards the foredunes/coffee rocks west of where she had been lying. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: reported two earlier interactions with an unidentified dingo 
at the Yidney Rocks beachfront (separate code Cs) 
 
 
 
 
 
Action taken: Reported 
 
 
 
 
 
 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
sch4p3( 3) Prejudice the protection of an individuals right to privacy sch4p3( 3) Prejudice the protection of an individuals right to privacy
sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Proposed further action: Monitor, continue closure of adjacent camping zones to mitigate risk, 
consider temporary closure of camping zones where litters are identified/present. 
 
 
 
 
 
Faxed/emailed date:  18May2014                               Reporting Officers details:  7026804 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  Two minutes 
before interaction 7026804 
 

 

Photo 2. 
Description (who took 
photo/when):  Two minutes 
before interaction 7026804 
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Photo 3. 
Description (who took 
photo/when):  Two minutes 
before interaction 7026804 
(continuity in observation of 
dingo) 
 

 

 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

15-166 File C 252 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 6 

 

 Initial interest in walker 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified juv 
 
Date (of Interaction): 17/05/2014 
Location (of Interaction): Yidney Rocks 
Beachfront 

Time (of Interaction 24hrs): 14:30 
Reporting Officer/s details: 7026466 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) <1 metre        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) When smacked with a stick 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile             1 
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address: C/ Yidney Cabins 
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   resident      
Did they receive an information pack with their permits Yes 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments Long term resident of Fraser Island 
 
 
 
Detailed report of events: While on patrol QPWS Rangers spoke to a local resident regarding the 
following interaction.  A juvenile dingo was following whilst she was walking alone on the 
beach. The dingo approached her several times from behind to within 1 metre and was eventually 
smacked by a stick. The dingo took off.  
 
 
Additional comments and notes: Rangers were in the vicinity around 15:00 and observed GGPi13f in 
the area. bag that was noisy in the breeze and did not contain 
food inside. This may have caused the initial attaction to her. 
 
 
 
Action taken: Report completed & circulated. 
 
 
 
Proposed further action: Continue patrols & briefings in this area, including mornings and afternoons.  
Monitor behaviour of all known habituated dingoes in this area.   
 
 
 
Faxed/emailed date:  30/05/2014                               Reporting Officers details:  7026466 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified juv 
 
Date (of Interaction): 17/05/2014 
Location (of Interaction): Yidney Rocks 
Beachfront 

Time (of Interaction 24hrs): 14:10 
Reporting Officer/s details: 7026466 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) When smacked with a fishing 

rod. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile             1 
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: C/ Yidney Cabins 
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   resident      
Did they receive an information pack with their permits Yes 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments Part of a family of long term residents of Fraser island 
 
 
 
Detailed report of events: While on patrol QPWS Rangers spoke to a local resident regarding the 
following interaction.  A juvenile dingo was hanging around and while they were 
fishing. The dingo approached them several times from behind and was eventually smacked by their 
fishing rod to deter it. The dingo sat down and watched from  a short distance then moved on.  The 
dingo was described as part of the local Oaks family pack. The interaction was reported as 
approximately 5 minutes in total.  
 
 
Additional comments and notes: Rangers were in the vicinity around 15:00 and observed GGPi13f in 
the area. 
 
 
 
Action taken: Report completed & circulated. 
 
 
 
Proposed further action: Continue patrols & briefings in this area, including mornings and afternoons.  
Monitor behaviour of all known habituated dingoes in this area.  Continue with campground closures 
between Poyungan & Eli. 
 
 
 
Faxed/emailed date:  30/05/2014                               Reporting Officers details:  7026466 
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Dingo Interaction Report Form Insert Code: C Dingo ID: GY13m 
 
Date (of Interaction): 20/5/2014 
Location (of Interaction): Eurong south 
Beachfront 

Time (of Interaction 24hrs): throughout day 
Reporting Officer/s details: 7026466 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Didn't move throughout the 

day 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Left 
    Details: GY13m 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Not obtained 
Address: Rego - 
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   click to select      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments Not sure if resident - vehicle seen a number of times on the island 
 
 
 
Detailed report of events: Ranger observed BY13m on several occassions in the vicinity of a silver 
Landcruiser The owners were fishing and the dingo was sitting in the vicinity watching them. It 
loitered around their vehicle in a non threateneing manner. The owners were approached by ranger and 
advised they did not have any issues with this dingo but a dingo took their worming bag the day before. 
 
Ranger observed this dingo around the vehilce and owners on or around 9:45 am, 11:10am (on return 
trip). 13:30 and after 15:00pm. The same dingo was still loitering at the vehicle. 
 
 
Additional comments and notes: Dingo did not display threatening behaviour. 
 
 
 
Action taken: Report completed & circulated. 
 
 
 
Proposed further action: Continue patrols & briefings in this area, including mornings and afternoons.  
Monitor behaviour of all known habituated dingoes in this area.   
 
 
 
Faxed/emailed date:  03/06/2014                               Reporting Officers details:  7026466 
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Dingo Interaction Report Form Insert Code: C Dingo ID: 2 Unidentified Dingoes 
 
Date (of Interaction): 22May14 
Location (of Interaction): Wyuna CZ 

Time (of Interaction 24hrs): 1800 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
       Bag 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify) Bag 
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults 1             
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #: 
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits No 
Did they read the Dingo BrochureNo 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments No food in tents food secured, most had camped on the island before. 
 
 
 
Detailed report of events: The group arrived to the campsite at approx. 1800 and began to set up 
camp two dingoes began loitering around. One described as a male in good condition and the other as a 
smaller dingo, neither could be confirmed as tagged. The campers chased them off on a couple of 
occasions and found them hard to deter. A short time later on of the campers noticed that a bag had 
been removed from his tent. The bag was found a short distance away torn open, some items missing.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Latter that evening a Code D tent rip occurred at this site. GGG13M 
has been sighted in this area outside his normal pack boundary.  
 
 
 
 
 
Action taken: Briefed campers, Report generated. 
 
 
 
 
 
 
 
 
Proposed further action: Patrol, monitor and brief area. 
 
 
 
 
 
Faxed/emailed date:  23/5/14                                              Reporting Officers details:  
7027330 Release
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: c Dingo ID: GGG13m 
 
Date (of Interaction): 22/5/14 
Location (of Interaction): Beach front Red 
Canyon 

Time (of Interaction 24hrs): 1528 
Reporting Officer/s details: 7027130 / 7027816 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Did not leave 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults 1             
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GGGM 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Four fishermen 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Whislt driving back to base 7027130 observed GGGM eating a fish frame 
three meters away from fishermen cleaning fish. 7027130 spoke to the fishermen who said that the 
dingo had retrived the fish from out of the water, 7027130 warned them that it was an offense to feed or 
leave food avaible for dingoes, instructing them to bury their fish offal. 
 
7027130 arrived in a seprate vehicle shortly after and observed GGGM lotering directly behind 
fishermen still fishing for several minutes until 7027130 left the scence. The fishermen where digging a 
hole to bury their fish frames at this time. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: 7027130 belived that the dingo was fed but did not witness it. 
 
 
 
 
 
Action taken: interaction report 
 
 
 
 
 
 
 
 
Proposed further action:       
 
 
 
 
 

Release
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Faxed/emailed date:  26/5/14                                              Reporting Officers details:  
7027816 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

Photo 
1. 
Descri
ption 
(who 
took 
photo/w
hen):  
7027130 
1528 
22/5/14 
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 Photo 
2. 
Descri
ption 
(who 
took 
photo/w
hen):  
      
 

 Photo 
3. 
Descri
ption 
(who 
took 
photo/w
hen):  
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Dingo Interaction Report Form Insert Code: C Dingo ID: GGG13M 
 
Date (of Interaction): 23May14 
Location (of Interaction): Sth end Wyuna CZ 

Time (of Interaction 24hrs): 1130 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Moved 100m Sth and went to 

sleep 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GGG13M 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

15-166 File C 269 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 2 

Questionnaire:                  Specify visitor type   QPWS employee      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: At approx. 1130hrs ranger 7027330 was patrolling south past Wyuna CZ 
when a dingo was noticed loitering around some fishermen. One of the fishermen was disposing of 
unwanted live pippies this had attracted the attention off the dingo. The dingo was positively identified as 
GGG13M from his ear tag. The fishermen were briefed and told to bury the pippies. At this point the 
ranger chased the dingo away by throwing wet sand at the animal. The dingo retreated 100m down the 
beach layed down and went to sleep. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: This animal displays no aggression at this stage and is regularly 
seen during the day on the beach sleeping, this activity could lead to a car strike as this animal shows 
no fear of vehicles and approaches them. The dingo was also outside its normal pack boundary. 
 
 
 
 
 
Action taken: Report generated, Briefed fishermen. 
 
 
 
 
 
 
 
 
Proposed further action: Monitor animal, continue briefing 
 
 
 
 
 
Faxed/emailed date:  23/5/14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: unidentified 
 
Date (of Interaction): 24/5/14 
Location (of Interaction): Awinya Camping area 

Time (of Interaction 24hrs): 0745 
Reporting Officer/s details: 7027816 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults       1       
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged No 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Campers 
Address: Sydney 
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureNo 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Unknown 
Comments       
 
 
 
Detailed report of events: Untagged Female dingo most likely a subadult (photos shown to rangers 
7027816 and 7027130), was loitering around their campsite, possibly attracted by BBQ breakfast. Dingo 
continued to hang around for several hours at one point following the family as they went for a walk 
along the creek. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Three families camped together. Only ones present at Awinya on 
Saturday. Had arrived previous evening. 
 
 
 
 
 
Action taken: 7027816 and 7027130 breifed campers on dingo saftey, including taking taking their 
rubbish to the WTS. Some rubbish bags had been tied in trees, although overall camps where tidy.  
 
 
 
 
 
 
 
 
Proposed further action: Continued monitioring of area 
 
 
 
 
 
Faxed/emailed date:  26/5/14                                              Reporting Officers details:  
7027816 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: BWRm? 
 
Date (of Interaction): 24/5/14 
Location (of Interaction): Lk Allom  
Carpark 

Time (of Interaction 24hrs): 1402 
Reporting Officer/s details: 7027130 / 7027816 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Scared off by reversing 

beeper 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults 1             
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: See photos 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Tourists 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   click to select      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: 7027130 returned from filling water tanks to find dingo loitering around 
tourists parked in the carpark at lake allom. The dingo was there for approximately 10 minutes while 
7027130 briefed them on dingo saftely. The dingo was scared away by 7027816 as he revsered back 
down to the carpark following other duties. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: interaction report briefed campers. 
 
 
 
 
 
 
 
 
Proposed further action: monitoring of area 
 
 
 
 
 
Faxed/emailed date:  26/5/14                                              Reporting Officers details:  
7027816 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

Photo 
1. 
Descri
ption 
(who 
took 
photo/w
hen):  
7027130 
1402 
24/5/14 
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Photo 
2. 
Descri
ption 
(who 
took 
photo/w
hen):  
7027130 
1402 
24/5/14  
 

15-166 File C 279 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 5 

 Photo 
3. 
Descri
ption 
(who 
took 
photo/w
hen):  
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Dingo Interaction Report Form Insert Code: C Dingo ID: BWR13m & GY13m 
 
Date (of Interaction): 25/05/2014 
Location (of Interaction): Wongai CZ BF 

Time (of Interaction 24hrs): Approx 16:20 
Reporting Officer/s details: 7028020 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) BWR followed p the 

beach 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 2             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes - all dingo(s)  
    Details: BWR13m & GY13m 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: &
Address:       
Phone #:
Age:       
 
Name: 
Address:       
Phone #: 
Age:       
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Questionnaire:                  Specify visitor type   Independant      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments They allowed the dingoes to get close and did not deter them.  They crouched down 
to the dingo’s level to take photos. 
 
 
 
Detailed report of events: Whilst investigating the report of a Code E interaction (see separate report), 
ranger 7028020 was informed of this interaction: 

was driving south along the beach around Wongai CZ when she noticed 
two dingoes very close to two visitors.  As she got closer she observed that the visitors were not 
deterring the dingoes, and were crouching down to take photos.  The dingoes were within 1m of the 
visitors and appeared to be sniffing their clothes on several occasions. 

proceeded to film some of the behaviour, before exiting her vehicle and approaching the visitors.  
and asked the visitors if they could get into their vehicle as the 

behaviour shown by the dingoes and themselves was inappropriate.  She explained the dingo safe 
messaging and the visitors advised that they had been dropped off by some friends who had gone 
fishing and they didn’t have a car. 
Ranger 7028020 spoke to the visitors and they mentioned that they had walked from their 
campsite to the beach to take photos of the sunset and two dingoes had approached them.  The dingoes 
had not got closer than 1m and they never felt threatened by them. mentioned that the dingoes had 
started to 'play' with as she spoke to them (see separate Code E report). 
Ranger 7028020 spoke with on 26/05/2014 in a follow up interview and said that if the 

had not filmed the interaction they would not have reported anything as they did not feel 
threatened at all and were not worried about the behaviour of the dingoes. 
 
 
 
Additional comments and notes: Follow up interviews conducted on 26/05/14 over the phone. 
 
 
 
Action taken: RIC NRM informed (as part of several interactions occurring at the same time). & 

and interviewed.  Footage obtained from
 
 
 
Proposed further action: Continue monitoring behaviour of habituated animals in this area.  Continue 
patrols around the area.  Consider the closure of Wongai CZ while habitauted behaviour is being 
displayed. 
 
 
 
Faxed/emailed date:  26/05/2014                               Reporting Officers details:  7028020 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Green tagged & Red tagged 
 
Date (of Interaction): 25/05/2014 
Location (of Interaction): Approx. 2km south 
Wongai CZ 

Time (of Interaction 24hrs): Between 08:30 & 
13:00 
Reporting Officer/s details: 7028020 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) was deterred but did not 

leave 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile             2 
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: One a 'red' tag and one a 'green' tag 
 
d. Which ears were tagged Unknown 
    Details: Possibly in left ear 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   Independant      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments Has been coming for 40-50years 
 
 
 
Detailed report of events: While fishing approx. 2km south of Wongai CZ had two 
dingoes loitering around and soliciting food. were fishing for 4 to 5hrs and several 
times during that time the dingoes would approach wife ( while she was in the 
water and sniff her bait bag.  They also came very close when she caught any fish, and were not easily 
deterred (yelling, kicking water). 
The dingoes would also retreat just above the water’s edge and lie on the sand for periods of time 
watching the couple. 
 
 
 
Additional comments and notes:       
 
 
 
Action taken: Interaction reported and circulated. 
 
 
 
Proposed further action: Continue patrols and monitoring of habituated behaviour in this area.  
Consider the closure of Wongai CZ while highly habituated dingoes are displaying this behaviour. 
 
 
 
Faxed/emailed date:  27/05/2014                               Reporting Officers details:  7028020 
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Dingo Interaction Report Form Insert Code: C Dingo ID: GY13m 
 
Date (of Interaction): 25/05/2014 
Location (of Interaction): Wongai CZ BF 

Time (of Interaction 24hrs): Approx 16:30 
Reporting Officer/s details: 7028020 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GY13m 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: & 
Address:       
Phone #:
Age:       
 
Name: 
Address:       
Phone #:
Age:       
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Questionnaire:                  Specify visitor type   Independant      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments       
 
 
 
Detailed report of events: After a reported Code E interaction, was 
waiting for QPWS staff and observing the behaviour of GY13m around a campsite in Wongai CZ.  She 
observed the dingo start to sniff at and jump at a tent so started filming the dingo. 
The footage, obtained by QPWS, shows GY13m chewing on a guide rope, jumping up and grabbing the 
fly (ripping it) and then moving around the tent to the front where it jumps onto the tent and rips the front 
open to gain access. 
The dingo enters the tent and is inside for approx 1min before exiting with a bag in his mouth.  GY13m 
then drops the bag in front of the tent and proceeds to eat out of it before picking it up and moving back 
behind the dunes out of site. 
Shortly after the dingo moves on observes & (previous Code C report) return to their 
campsite, enter the tent, remove some of their belongings and start to pack up their campsite. 

approached & and let them know that a QPWS ranger would be coming down soon to 
talk to them about the dingoes. 
Ranger 7028020 spoke with & regarding a previous Code C report, however they did not 
mention the tent rip to the ranger. & had packed up and left before the interview with 
has been completed. 
A follow up discussion was had with on 26/05/14 over the phone: 

admitted that their tent had been ripped into and the dingo has stolen a bag of peanuts.  They didn't 
believe that the dingoes would be attracted to peanuts. also mentioned that if the hadn't 
been there and spoken to them they would not have reported the interactions as they did not feel 
threatened at any time and were not worried. 
Ranger 7028020 explained that it was important for QPWS to know when interactions occur so we can 
monitor the behaviour of dingoes in the area and ensure all visitors are aware of the dingoes and their 
behaviour. 
 
 
 
Additional comments and notes: Follow up interview conducted on 26/05/14 over the phone. 
 
 
 
Action taken: RIC NRM informed (as part of several interactions occurring at the same time). & 

and interviewed.  Footage obtained from 
 
 
 
Proposed further action: Continue monitoring behaviour of habituated animals in this area.  Continue 
patrols around the area.  Consider closure of Wongai CZ if habituated behaviour continues. 
 
 
 
Faxed/emailed date:  26/05/2014                               Reporting Officers details:  7028020 
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Dingo Interaction Report Form Insert Code: C Dingo ID: unidentified dingo(es) 
 
Date (of Interaction): 25-27 May 2014 
Location (of Interaction): Wongai camping zone, 
20m north of southern boundary 

Time (of Interaction 24hrs): overnight 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
   

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) within 1m       
 damaging property (specify)  
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) didn’t leave – continued to loiter 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     3 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile              
Unknown Age             3 

 
c. Were the dingo(s) tagged At least two 
    Details: One with “red tag”, other with 
“green tag”, unsure if other tagged 
 
d. Which ears were tagged Unknown     
Details:  
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details: not described other than “one was 
smaller than the others” 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Tin Can Bay 
Phone #: 
Age: 60-70s 
 
Rego – 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

15-166 File C 287 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 2 

Questionnaire:                  Specify visitor type   camper     
Did they receive an information pack with their permits yes 
Did they read the Dingo Brochure no 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) no 
Comments Regular visitors and locals – been coming here for 40-50 years 
 
 
 
Detailed report of events: reported being “harassed” by three dingoes when she was fishing over a 
number of days (husband nearby). and didn’t feel 
confident reeling in her catch without her husband standing alongside her due to the proximity and 
interest shown by the dingoes. usually likes to walk along the beach when she visits Fraser Island 
but has expressed her reluctance to do so on this trip due to the dingo activity. One of the dingoes was 
within a metre of her at one stage, sniffing at her bait bag over her shoulder. 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:  described the dingo behaviour as being the worst that he’s 
encountered in his 40-50 years of visits. Multiple tent rippings at this camp – generated as a separate 
code C. 
 
 
 
 
 
Action taken: Reported, reiterated dingo safe messaging. 
 
 
 
 
 
 
 
 
Proposed further action: Temporary closure of One Tree Rocks and Wongai CZ to mitigate current 
activity. 
 
 
 
 
 
Faxed/emailed date:  31 May 2014                               Reporting Officers details:  7026804 
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Dingo Interaction Report Form Insert Code: C Dingo ID: unknown dingo(es) 
 
Date (of Interaction): 25-27 May 2014 
Location (of Interaction): Wongai camping zone, 
20m north of southern boundary 

Time (of Interaction 24hrs): overnight 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
  2L long life milk 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)        
  damaging property (specify) power lead 
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)  

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile              
Unknown Age             X 

 
c. Were the dingo(s) tagged Unknown 
    Details:  
 
d. Which ears were tagged Unknown     
Details:  
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:  
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Tin Can Bay 
Phone #:
Age: 60-70s 
 
Rego –
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Questionnaire:                  Specify visitor type   camper     
Did they receive an information pack with their permits yes 
Did they read the Dingo Brochure no 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) no 
Comments Regular visitors and locals – been coming here for 40-50 years 
 
 
 
Detailed report of events: Campers reported that over three days, unknown dingo(es) ripped four large 
(>1m) holes in their tent whilst they weren’t present at their camp. On the first occasion, a 2L long life 
milk was ripped open within the tent, afterwards no food was kept within the tent, but the rippings 
continued until the tent was actually left open for inspection by having the doors pinned back over 
following days. A dingo had chewed through a power lead used for lighting until the plug was detached 
from the lead, and the plug on the light was chewed on also.  
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Dingoes reported to be regularly visiting camp but usually 
discouraged by being threatened by a stick held over head or being chased off. Dingoes reported to 
have a “green tag” and a “red tag” but no ears specified, and a third (smaller) dingo. 
Dingoes were also harassing when she was fishing on the beach (separate Code C generated). 
 
 
 
 
 
 
Action taken: Reported, reminded campers of food security obligations and penalties. 
 
 
 
 
 
 
 
 
Proposed further action: Temporary closure of One Tree Rocks and Wongai CZ to mitigate current 
activity. 
 
 
 
 
 
Faxed/emailed date:  31 May 2014                               Reporting Officers details:  7026804 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unknown 
 
Date (of Interaction): 25/05/2014 
Location (of Interaction): Wongai CZ 

Time (of Interaction 24hrs): Between 08:30 & 
13:00 
Reporting Officer/s details: 7028020 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Unknown 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             ? 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   Independant      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments Has been coming for 40-50years 
 
 
 
Detailed report of events: After returning from fishing south of Wongai found that 
their tent had been ripped into in two places. 
The dingo(es) had ripped through the fly at the front of the tent, then through the side of the tent under 
the fly. 
There were two casks of wine and 2 2l UHT milk containers inside the tent.  The milk containers had 
been punctured and the milk had leaked out, the wine casks were untouched. 
 
 
 
Additional comments and notes:       
 
 
 
Action taken: Interaction reported and circulated. 
 
 
 
Proposed further action: Continue patrols and monitoring of habituated behaviour in this area.  
Consider the closure of Wongai CZ while highly habituated dingoes are displaying this behaviour. 
 
 
 
Faxed/emailed date:  27/05/2014                               Reporting Officers details:  7028020 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Dingo Interaction Report Form Insert Code: C Dingo ID: unknown dingo(es) 
 
Date (of Interaction): 28-29 May 2014 
Location (of Interaction): Wongai camping zone, 
250m from northern boundary 

Time (of Interaction 24hrs): overnight 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
       Tomato sauce from table within awning 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)  

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile              
Unknown Age             X 

 
c. Were the dingo(s) tagged Unknown 
    Details:  
 
d. Which ears were tagged Unknown     
Details:  
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:  
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Not recorded 
Address: Queensland 
Phone #: Rego –
Age:  
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper     
Did they receive an information pack with their permits yes 
Did they read the Dingo Brochure no 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) no 
Comments Regular visitors 
 
 
 
Detailed report of events: Campers reported that a dingo(es) had stolen tomato sauce from atop their 
table inside the awning of the camper trailer, that had been inadvertently left open overnight. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Campers also reported regular dingo activity around their camp and 
on the beachfront, describing behaviour as ‘not aggressive’. 
 
 
 
 
 
Action taken: Reported, reminded campers of food security obligations and penalties. 
 
 
 
 
 
 
 
 
Proposed further action: Temporary closure of One Tree Rocks and Wongai CZ to mitigate current 
activity. 
 
 
 
 
 
Faxed/emailed date:  31 May 2014                               Reporting Officers details:  7026804 
 
 
 

15-166 File C 294 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 1 

Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified tagged sub-
adult female (no colours identified) 
 
Date (of Interaction): 29 May 2014 
Location (of Interaction): Eli Creek parking area 

Time (of Interaction 24hrs): 1525hrs 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) didn't leave - continued to 

loiter 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults       1       
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Right  
    Details: No colours identified 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Observer ranger 7026804 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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  lunging (attempting to nip or bite) 
Questionnaire:                  Specify visitor type   tour participant      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments No one spoken to - FITs, Tag-alongs and CTO passengers present at site at the time. 
 
 
 
Detailed report of events: Whilst cleaning portaloos on the Eli Creek beachfront I observed a tagged 
sub-adult female dingo (unable to determine tag colours) sniffing around the Eli car parking area 
(amongst visitors and vehicles). The dingo was not interested in approaching people, although people 
approached her to within 10m to photograph her. She was not wary of QG vehicle when I drove within 
30m of her when heading off. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: Reported. 
 
 
 
 
 
 
 
 
Proposed further action: Monitor activity in beachfront area. 
 
 
 
 
 
Faxed/emailed date:  02 June 2014                               Reporting Officers details:  7026804 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: unknown dingo(es) 
 
Date (of Interaction): 30 May 2014 
Location (of Interaction): Wongai camping zone, 
50m from northern boundary 

Time (of Interaction 24hrs): 0700hrs 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)  

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile              
Unknown Age             X 

 
c. Were the dingo(s) tagged Unknown 
    Details:  
 
d. Which ears were tagged Unknown     
Details:  
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:  
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Not recorded 
Address: Victoria 
Phone #:       
Age: 40s 
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper     
Did they receive an information pack with their permits yes 
Did they read the Dingo Brochure no 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) yes 
Comments Had done pre-visit reading online 
 
 
 
Detailed report of events: Campers reported a ripped tent (through screen and floor liner), discovered 
when they returned from fishing in front of their camp. Dingo(es) had removed a pillow and bed linen 
from within the tent. There was no food stored within the tent. A heavy, large bag containing fishing 
tackle had also been dragged 5m and teeth marks were evident in the canvas. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: All food was secured appropriately at the camp; a recent spate of 
tent rippings has been prevalent at One Tree Rocks and Wongai CZs. Men suggested that three 
dingoes were regularly sighted around their camp – yellow/green tag in left ear (GY13m); red/white tag 
(possibly BWR13m), and a third dingo described as having “spots on its nose”. Three dingoes were also 
around the men when they were fishing – a female ranger stopped and spoke to them on this occasion. 
 
 
 
 
 
Action taken: Reported 
 
 
 
 
 
 
 
 
Proposed further action: Temporary closure of One Tree Rocks and Wongai CZ to mitigate current 
activity. 
 
 
 
 
 
Faxed/emailed date:  31 May 2014                               Reporting Officers details:  7026804 
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Dingo Interaction Report Form Insert Code: C Dingo ID: unknown dingo(es) 
 
Date (of Interaction): 30 May 2014 
Location (of Interaction): Wongai camping zone, 
50m from northern boundary 

Time (of Interaction 24hrs): 0700hrs 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)  

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile              
Unknown Age             X 

 
c. Were the dingo(s) tagged Unknown 
    Details:  
 
d. Which ears were tagged Unknown     
Details:  
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:  
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Not recorded 
Address: Victoria 
Phone #:       
Age: 40s 
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper     
Did they receive an information pack with their permits yes 
Did they read the Dingo Brochure no 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) yes 
Comments Had done pre-visit reading online 
 
 
 
Detailed report of events: Campers reported a ripped tent (through screen and floor liner), discovered 
when they returned from fishing in front of their camp. Dingo(es) had removed a pillow and bed linen 
from within the tent. There was no food stored within the tent. A heavy, large bag containing fishing 
tackle had also been dragged 5m and teeth marks were evident in the canvas. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: All food was secured appropriately at the camp; a recent spate of 
tent rippings has been prevalent at One Tree Rocks and Wongai CZs. Men suggested that three 
dingoes were regularly sighted around their camp – yellow/green tag in left ear (GY13m); red/white tag 
(possibly BWR13m), and a third dingo described as having “spots on its nose”. Three dingoes were also 
around the men when they were fishing – a female ranger stopped and spoke to them on this occasion. 
 
 
 
 
 
Action taken: Reported 
 
 
 
 
 
 
 
 
Proposed further action: Temporary closure of One Tree Rocks and Wongai CZ to mitigate current 
activity. 
 
 
 
 
 
Faxed/emailed date:  31 May 2014                               Reporting Officers details:  7026804 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified 
 
Date (of Interaction): 3rd June 2014
Location (of Interaction): Eurong Beach Front  

Time (of Interaction 24hrs): Approx. 13:00
Reporting Officer/s details: 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #:
Age:       
 
Name:
Address:       
Phone #: 
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   unknown      

Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments Intentional feeding of wildlife 
 
 
 
Detailed report of events: On the 12/06/14 reported a possible 
dingo feeding interaction to QPWS. Ranger 7028018 investigated the reported interaction. 
 
On the 3rd June 2014 at approx. 13:00, a guest (identity unknown) staying at Second Valley came into 
the Eurong bakery visually upset. The guest reported to bakery staff that he had just 
witnessed a tall, slim man wearing a and a white hat on the beach, encouraging and 
feeding a dingo bread so he could take its picture. The man reporting the interaction was upset because 
he was concerned about the long term implications of feeding and his 2 year old daughters safety. 
 
 
 
 
Additional comments and notes: The man feeding the dingo was identified as a new
staff member, however this will be further investigated in collaboration with management.   
 
 
Action taken: Reported interaction investigated. Report generated and circulated. RIC notified. 
 
 
Proposed further action: Continue further investigation and respond accordingly.
 
 
Faxed/emailed date:  13/06/2014                               Reporting Officers details:  7028018 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Dingo Interaction Report Form Insert Code: C Dingo ID: BWY13M 
 
Date (of Interaction): 5/6/14 
Location (of Interaction): Eugarie CZ 

Time (of Interaction 24hrs): 1445 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Moved away did not leave 

area 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: BWY13M 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   QPWS employee      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Ranger 7027330 was briefing a camp in Eugarie CZ when fishermen were 
seen chasing a dingo away from where they were fishing. On closer inspection the dingo was identified 
as BWY13M. The fishermen were spoken to and said the dingo was not displaying any aggression 
however it was very difficult to deter. The fishermen were asked to continue chasing the dingo away. At 
this point the dingo had moved approx. 50m up the beach and layed down.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: At this stage the animal is displaying no signs of aggression, 
however is highly habituated. Seems to be copying GGG13M his deceased sibling’s behaviour. 
 
 
 
 
 
Action taken: Briefed fishermen, RIC NMU informed, Report generated  
 
 
 
 
 
 
 
 
Proposed further action: Continue briefings, Monitor animal 
 
 
 
 
 
Faxed/emailed date:  9/6/14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified male 
 
Date (of Interaction): 5/6/14 
Location (of Interaction): Eurong Township 

Time (of Interaction 24hrs): 1330 
Reporting Officer/s details: 7026936 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Let out of vehicle gate near 

beach bar. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age 1             

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: N/A 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   click to select      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: At 1330 on the 5/6/14 the Eurong resort reported a sighting of a dingo inside 
the fence to the Eurong QPWS office. Ranger 7026936 was able to confirm this report, as dingo tracks 
seen crossing the front vehicle grid. Enough sand had built up in the middle of the grid to allow the dingo 
to gain access over it. 
 
Ranger 7026936 opened the vehicle gate near the beach bar as this area tends to be frequented when 
dingoes are inside the Eurong fence. The dingo was released at 1430. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Resort staff were notified of the dingoes release immediately and 
thanked for their prompt report. 
 
 
 
Action taken: Dingo released and excess sand dug from all grids around Eurong township. Fence 
inspection was carried out and grid wires were tested and working 
 
 
 
 
 
Proposed further action: Complete regular checks of sand build up especially in the high use vehicle 
access grids to Eurong and Happy Valley townships. Timely clean out crucial as fence breaches are 
usually avoidable and are resource intensive. 
 
 
Faxed/emailed date:  10/6/14                               Reporting Officers details:  7026936 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified Dingo 
 
Date (of Interaction): 6/6/14 
Location (of Interaction): Burad CZ 

Time (of Interaction 24hrs): 2200 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
       Bag 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify) air mattress 
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments After reading brochures packed food and rubbish into vehicles 
 
 
 
Detailed report of events: party arrived at Burad CZ set up camp and then read the supplied 
brochures on dingo safety. Prior to reading the information they had their food stored in canvas camp 
cupboards, they then packed the food away in their vehicles. Later in the evening the party went down 
the beach to fish. At approx. 2200hrs the party returned and found a dingo dragging a bag containing 
clothes and personal items away from the camp, the unidentified dingo was chased off and the bag 
retrieved. On inspection of the camp a tent was found to have been torn open and the air mattress 
damaged. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: A similar incident occurred in Wyuna CZ earlier the same evening. 
BBR10M has been seen in the area and is a known tent ripper. 
 
 
 
 
 
Action taken: Interview conducted, RIC NMU informed, report generated 
 
 
 
 
 
 
 
 
Proposed further action: Monitor area; continue briefings of all camps in area. 
 
 
 
 
 
Faxed/emailed date:  8/6/14                                              Reporting Officers details:  
7027330 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

15-166 File C 311 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 3 

Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified Dingo 
 
Date (of Interaction): 6/6/14 
Location (of Interaction): Cathedrals Resort 

Time (of Interaction 24hrs): 1830 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
       Loaf of bread 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Ran off with bread 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments Should have discouraged the dingo when first seen. 
 
 
 
Detailed report of events: and her partner were cooking in the camp kitchen. They had noticed 
a dingo with an orangey tag loitering around the area, they ignored the dingo. On finishing dinner they 
were packing up, when they turned their backs to gather the cooking equipment the dingo jumped on the 
table and ran away with a loaf of bread.  
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: was informed that they should have discouraged the dingo 
as soon as it was seen loitering in the area.2Y06F, ORW09M, RBW13F, BWY13M and an untagged 
Juvenile male have been sighted in the area at times inside the fence line. Until the grids are energised 
and the dingoes removed from the compound this will continue being an issue.    
 
 
 
 
 
Action taken: RIC NMU informed, briefed camps in Cathedrals, report generated 
 
 
 
 
 
 
 
 
Proposed further action:  Monitor activity, brief campers, Energise grids ASAP, remove dingoes from 
fence line, 
 
 
 
 
 
Faxed/emailed date:  7/6/14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
 

 
Release
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified Dingo 
 
Date (of Interaction): 6/6/14 
Location (of Interaction): Cathedrals Resort 

Time (of Interaction 24hrs): 1900 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) 1M        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) When torch shone in eyes 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: and his young son were walking back from the toilet when they 
noticed a dingo following them. They kept their eyes on the animal and continued to walk toward their 
campsite. The dingo continued to follow and closed the distance between them to 1m at this point 

shone the torch he was carrying in the dingo's eyes. At this point the dingo ran away. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: .2Y06F, ORW09M, RBW13F, BWY13M and an untagged Juvenile 
male have been sighted in the area at times inside the fence line. Until the grids are energised and the 
dingoes removed from the compound this will continue being an issue.    
 
 
 
 
 
Action taken: RIC NMU informed, briefed camps in Cathedrals, report generated 
 
 
 
 
 
 
 
 
Proposed further action: Monitor activity, brief campers, Energise grids ASAP, remove dingoes from 
fence line, 
 
 
 
 
 
Faxed/emailed date:  7/6/14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified Dingo 
 
Date (of Interaction): 6/6/14 
Location (of Interaction): Wyuna CZ 

Time (of Interaction 24hrs): 1700 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify) mattress 
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #: 
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Had reported all food and rubbish was stored in their vehicle. 
 
 
 
Detailed report of events: and his partner had set up camp and went down the beach to fish. An 
unidentified dingo was seen trotting along the beach sniffing, the dingo then went up into the dunes and 
was lost sight of. was not concerned as the camp area had no food available. On returning to their 
camp they found their tent ripped, the blow up mattress torn and some of their belongings moved around 
inside the tent. They tidied up their camp, on dark an unidentified dingo was sighted around their camp. 
At this stage they decided to pack up and move to Cathedrals Resort.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: and his partner were confused as to why the dingo accessed 
their tent as they had complied with all instructions and had no food available. They had camped at 
Sandy Cape with no incident. It was explained that it may have been a curious juvenile or smells that 
had been generated while camping may have caught the dingo's attention. 
 
 
 
 
 
Action taken: NMU RIC informed, report generated 
 
 
 
 
 
 
 
 
Proposed further action: Patrol and brief in area, monitor dingo activity. 
 
 
 
 
 
Faxed/emailed date:  7/6/14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified Dingoes 
 
Date (of Interaction): 6Jun14 
Location (of Interaction): Cathedrals Resort 

Time (of Interaction 24hrs): 0800_1600 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify) Plastic 

containers 
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     3 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             3 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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  lunging (attempting to nip or bite) 
Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Had left camp free of food sources the containers were new and empty. 
 
 
 
Detailed report of events: and her partner set up camp and packed all food in their car as 
advised by resort staff. At 0800 they left camp for the day, on their return plastic containers left in front of 
their tent were found to be damaged. On speaking to other campers they were informed that three 
dingoes had been seen in the area of their tent. One had been seen trying to drag away a 10L water 
container. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: 2Y06F, ORW09M, RBW13F, BWY13M and an untagged Juvenile 
male have been sighted in the area at times inside the fence line. Until the grids are energised and the 
dingoes removed from the compound this will continue being an issue.   
 
 
 
 
 
Action taken: RIC NMU informed, briefed camps in Cathedrals, report generated 
 
 
 
 
 
 
Proposed further action:  Monitor activity, brief campers, Energise grids ASAP, remove dingoes from 
fence line, 
 
 
 
 
 
Faxed/emailed date:  7/6/14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: BWY13M 
 
Date (of Interaction): 7Jun14 
Location (of Interaction): Yuru CZ 

Time (of Interaction 24hrs): 1600 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: BWY13M 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   QPWS employee      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Rangers 7027330 and 7027816 were patrolling north on the beachfront of 
Yuru CZ when a dingo was seen lying near a vehicle on the beach. The rangers pulled up to the vehicle 
and identified the dingo as BWY13M. The dingo was chased away by ranger 7027330. The campers 
who were at the vehicle were cleaning fish and explained they had been chasing the dingo away but it 
continued to return. The campers were advised to continue chasing the dingo away and to dispose of 
the fish frames in the required manner. When the rangers drove off the dingo was still in the area. 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: This dingo is highly habituated and is demonstrating similar 
behaviours to GGG13M his deceased sibling. 
 
 
 
 
 
Action taken: Report generated 
 
 
 
 
 
 
 
 
Proposed further action: Monitor animal, continue camper briefings 
 
 
 
 
 
Faxed/emailed date:  8/6/14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified Dingo 
 
Date (of Interaction): 7/6/14 
Location (of Interaction): Burad CZ 

Time (of Interaction 24hrs): Early Morning 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
       eggs and cooked pasta 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify) Esky 
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) After accessing the esky and 

eating some of the contents 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments The campers believed the esky to be secure after read the brochure supplied 
 
 
 
Detailed report of events: The campers woke on the morning of the 7th to find one of their eskies had 
accessed sometime in the early morning. On inspection the rubber latches had been chewed and food 
had been taken out and eaten in the camp. No dingo was sighted at the time. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: This camp had had a tent rip the night before; BBR10M has been 
seen in the area. This animal is known to rip tents. 
 
 
 
 
 
Action taken: Interview conducted, RIC NMU informed, report generated 
 
 
 
 
 
 
 
 
Proposed further action: Monitor area; continue briefings of all camps in area. 
 
 
 
 
 
Faxed/emailed date:  8/6/14                                              Reporting Officers details:  
7027330      
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified Dingo 
 
Date (of Interaction): 7/6/14 
Location (of Interaction): Burad CZ 

Time (of Interaction 24hrs): Afternoon 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged click to select 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: The party had been out fishing for the afternoon on their return they found 
their tent ripped again in a different spot (this camp had a tent rip on the evening of the 6th). Nothing else 
in the camp had been disturbed and nothing was taken from the tent. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: This is the 3rd incident in two days for this camp. A dingo described 
as a male with an orange/red tag with a high front sock was seen on the beach the afternoon of this 
interaction. The description is consistent with BBR10M as is this behaviour.   
 
 
 
 
 
Action taken: Interview conducted, RIC NMU informed, report generated 
 
 
 
 
 
 
 
 
Proposed further action: Monitor area; continue briefings of all camps in area. 
 
 
 
 
 
Faxed/emailed date:  8/6/14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: 2Y06F RBW13F 
Untagged Juvenile 
Date (of Interaction): 9/6/14 
Location (of Interaction): Cathedrals Resort 

Time (of Interaction 24hrs): 0745 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     click to select 
b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults       1       
Sub adults                   
Juvenile 1 1       
Unknown Age                   

 
c. Were the dingo(s) tagged 
No -not all dingo(s) (detail) 
    Details:       
 
d. Which ears were tagged Right  
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   QPWS employee      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: While patrolling through the top campground in Cathedrals Resort rangers 
7027330 and 70227816 saw three dingo's trotting from the west through the camp area. The dingoes 
were positively identified as 2Y06F, RBW13F and an untagged juvenile. The dingo's trotted across the 
camp area toward the eastern perimeter fence. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: The grid at Cathedrals has not been energised; the Dundubara pack 
has been accessing the Resort via the grid. The personal gate has been wired open until the grid is 
wired and energised. For future reference the perimeter fence should not be closed until the grid is 
active.  
 
 
 
 
 
Action taken: Wired gate open, report generated. 
 
 
 
 
 
 
 
 
Proposed further action: Patrol area, brief camps, energise grid ASAP. 
 
 
 
 
 
Faxed/emailed date:  9/6/14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
 

 

15-166 File C 336 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 1

Dingo Interaction Report Form Insert Code: C Dingo ID: unknown 
 
Date (of Interaction): 11/6/14 
Location (of Interaction): Yurru CZ 

Time (of Interaction 24hrs): 8:00am-2:30pm 
Reporting Officer/s details: 7027146 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
       Multiple food items 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) unknown 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Gatton QLD 4311 
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureNo 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments The day after their food was taken these campers left their campsite with a bag of 
onions, apples and bread unsecured in the annexe of their tent (they indicated they "didn't think 
dingoes would eat that") . 
 
 
 
Detailed report of events: * Campers returned to their tents at approximately 2:30pm to find multiple 
food items on the ground in the vicinity of their tents. 
* It was evident that a dingo/es had gained entry to the front/annexe section of their tent and opened 
their fridge and subsequently removed numerous items of food. 
* The tent annexe had been ripped in two places. 
* The latch on the fridge was actually quite difficult to access and undo. The group of campers had no 
understanding that it would be possible for a dingo to attempt this. 
* The campers had booked their permits through Manta Ray barges and received a small format 
"Dingoes can be dangerous" flier in addition to a FIVG. 
* The group acknowledged that they had not read the information contained in these publications. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: Code C Interaction Report completed and emailed to distribution list 
 
 
 
 
 
 
 
 
Proposed further action: Refer to NRM for action 
 

Release
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Faxed/emailed date:  18/6/14                                              Reporting Officers details:  
7027146 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):        
 

 Photo 2.
Description (who took 
photo/when):        
 

 Photo 3.
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unknown 
 
Date (of Interaction): 12th June 2014
Location (of Interaction): Wongai CZ   

Time (of Interaction 24hrs): Approx. 00:00
Reporting Officer/s details: 7026466 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify) tarp 
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) When tent wall was banged 

on making noise. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 seen 

 
c. Were the dingo(s) tagged Unknown 
    Details: Too dark to see 
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Western Australia 
Phone #:       
Age:

Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      

Did they receive an information pack with their permits No 
Did they read the Dingo BrochureNo 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Permits obtained at Rainbow Beach. Brochures were not provided. They bought a 
map at Eurong Resort. Ranger proved them with brochures and briefing after interaction 
reported. 
 
 
 
Detailed report of events:  
Ranger 7026480 was patrolling for a reported injured dingo and enquiring with passing motorists when 
this interaction report was obtained.  
 

and his wife were camping at Wongai camping zone. had wrapped his plastic food storage 
containers in a large tarp and tied off with a rope before pushing them under the trailer. He woke at 
around midnight to the sound of the tarp being ripped at by a dingo or dingoes. banged on the side 
of the tent which scared off the dingo he observed.   
 
No food was accessed.  
 
 
Additional comments and notes: Wongai and One Tree Rock have been assessed as high risk for 
closing due to numerous tent ripping interactions. Camping zones are to be temporarily from 14 June 
2014. This was an opportunistically obtained interaction report.  

reported seeing several dingoes during their stay. 
 
 
Action taken: Report generated and circulated. Wongai camping area temporarily closed. 
 
 
Proposed further action: Continue monitoring dingo activity in this area 
 
 
Faxed/emailed date:  15/06/2014                               Reporting Officers details:  7026466 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unid tagged male 
 
Date (of Interaction): 13th June 2014
Location (of Interaction): Eli Creek  

Time (of Interaction 24hrs): Approx. 12:00
Reporting Officer/s details: 7026466 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Didn't observe when the 

dingo left. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: Too far to see colour combination 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address: Western Australia 
Phone #:       
Age: 60+ 
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      

Did they receive an information pack with their permits No 
Did they read the Dingo BrochureNo 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Permits obtained at Rainbow Beach. Brochures were not provided. They bought a 
map at Eurong Resort. Ranger proved them with old dingo brochure and briefing after 
interaction reported. Previous brochure not being reprinted or readily available. 
 
 
 
Detailed report of events:  
Ranger 7026480 was patrolling for a reported injured dingo and enquiring with passing motorists when 
this interaction report was obtained.  
 

and his wife were at Eli creek when a group of males that looked to be in their 20's approached a 
dingo with a tag in its left ear. One of the men held out his hand for the dingo to sniff. The dingo 
approached the man. 
 

and his wife observed a family in the vicinity that included a child in nappies. The parents were 
observing the interaction and moved the family away further down the creek. 
 

and his wife moved away from the interaction to go and have lunch. When they returned approx. 
half an hour later the dingo was still in the area asleep under a car.  
 
 
Additional comments and notes: Several interactions are being reported of dingoes being encouraged 
in this area.  This was an opportunistically obtained interaction report. reported seeing several 
dingoes during their stay. 
 
 
Action taken: Report generated and circulated.  
 
 
Proposed further action: Continue monitoring dingo activity in this area where resourced available. 
 
 
Faxed/emailed date:  15/06/2014                               Reporting Officers details:  7026466 
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Dingo Interaction Report Form Insert Code: C Dingo ID: BRG13m 
 
Date (of Interaction): 14th June 2014
Location (of Interaction): Eurong Beach Front  

Time (of Interaction 24hrs): Approx. 11:15
Reporting Officer/s details: 7026466 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: BRG13m 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Unit owner resort (not the 
alleged offender). 
Phone #:       
Age: 40+ 
 
Name: KBRV driver 
Address: C/- KBRV resort 
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

15-166 File C 345 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 2

Questionnaire:                  Specify visitor type   resident      

Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments Alleged feeding of wildlife - denied. One visitor is a unit owner and regular visitor  
 
 
 
Detailed report of events: While conducting a search for a reported injured dingo ranger 7026466 was 
approached by KBRV driver regarding an alleged feeding of a dingo that occurred approx. 
200metres north of Yidney rocks by 3 men fishing near a blue jeep. The driver allegedly witnessed fish 
being thrown to the dingo by 1 of the men. 
 
Ranger 7026466 immediately went to investigate the reported interaction observing juvenile dingo 
BRG13m heading south from the reported interaction area. When interviewed, the men denied all 
knowledge of the alleged offence and stated the dingo picked up a piece of something possibly washed 
in bait at the waters edge.  
 
Ranger 7028018 arrived approximately 5 minutes into the discussion.  
 
 
 
 
Additional comments and notes: Thirty minutes prior, ranger 7026466 had spoken to 1 of the three 
men with the at the described vehicle. The ranger enquired about the 
reported injured dingo, that another female dingo in the vicinity may come their way to solicit food and to 
keep their bait and catch secure. stated he was a unit owner at Resort and a regular 
visitor to the island and was aware of the obligations regarding Dingo safe messages and food security. 
 
 
Action taken: Reported interaction investigated, fishers involved reminded of dingo safety and food 
storage messages. Interaction report generated and circulated. An offence could not be determined 
based on circumstantial evidence - an infringement was not issued in this instance. 
 
 
Proposed further action: Continue education of visitors regarding bait and food security.  Continue 
regular liaison with CTO operators to report dingo interactions. 
 
 
Faxed/emailed date:  16/06/2014                               Reporting Officers details:  7026466 
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Dingo Interaction Report Form Insert Code: C Dingo ID: PuGR13m 
 
Date (of Interaction): 14 June 2014 
Location (of Interaction): Beachfront, Wongai 
camping zone (northern end) 

Time (of Interaction 24hrs): 0955hrs 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) continued patrolling along 

beach 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: PuGR13m 
 
d. Which ears were tagged Left 
    Details: confirmed identity - see photos 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Observed by Rangers 7026804 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   QPWS employee      

Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Whilst on patrol, ranger 7027904 and myself observed PuGR13m loitering 
on the Wongai beachfront. It was not wary of the QG whilst we got photographs from a distance to 
confirm identity. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: Photographed to confirm identity. 
 
 
 
 
 
 
 
 
Proposed further action: Monitor behaviour. 
 
 
 
 
 
Faxed/emailed date:  16 June 2014                               Reporting Officers details:  7026804 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who 
took photo/when):  
7026804 during 
interaction 
 

 

Photo 2. 
Description (who 
took photo/when):  as 
above 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unid_ tagged female 
 
Date (of Interaction): 14th June 2014
Location (of Interaction): Eli Creek Beach   

Time (of Interaction 24hrs): Approx. 16:45
Reporting Officer/s details: 7026466 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) When person stood up 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults       1       
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Right  
    Details: Not identified. Described as "brownie 
colour and white". 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Looked older than juvenile. 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Not obtained 
Address:       
Phone #:       
Age:       
 
Name:
Address:
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   Independant      

Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments       
 
 
 
Detailed report of events:  

and his colleague observed an older man (60ish) bending down on his knees with an outstretched 
arm encouraging a tagged dingo to approach him. The dingo approached him and his 6-8 mature aged 
friends.  
CTO tour drivers in the vicinity including yelled at the man to stop what he was doing. 
 
The man responded by stating he'd been coming to the island for 40 years and knows dingoes. The man 
got up and moved on.  
 
 
Additional comments and notes: This dingo is seen regularly in the Eli Creek area.  
ROR13f is regularly observed in this area. 
 
 
Action taken: Report generated and circulated. Encouraged CTO observations of this nature to assist 
with risk mitigation against human initiated interactions with dingoes. 
 
 
Proposed further action: Continue monitoring dingo activity in this area 
 
 
Faxed/emailed date:  15/06/2014                               Reporting Officers details:  7026466 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified Dingo 
 
Date (of Interaction): 20 Jun 2014 
Location (of Interaction): Eugarie CZ 

Time (of Interaction 24hrs): 0830-1500 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify) Strap on fridge 
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Nambour 
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Long time visitors no food or rubbish available, fridge secured with strap and metal 
clips. 
 
 
 
Detailed report of events: and his wife left camp at 0830 for a trip to the western beach. On their 
return they found a dingo had accessed their tent under the front door. The dingo had dragged their 
fridge toward the door damaging the securing strap and tore the fly screen on the sleeping area of the 
tent. The dingo did not access any food or rubbish as they had taken it all with them in their vehicle. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: The campers reported seeing dingoes in the area regularly. The 
Dundubara pack juveniles have been loitering through this area. 
 
 
 
 
 
Action taken: Interview conducted, briefed campers,RIC Nth informed, report generated. 
 
 
 
 
 
 
 
 
Proposed further action: Continue briefing and patrolling regime. 
 
 
 
 
 
Faxed/emailed date:  23/6/14                                              Reporting Officers details:  
7027330 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):        
 

 Photo 2.
Description (who took 
photo/when):        
 

 Photo 3.
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: BWY13m 
 
Date (of Interaction): 24 June 2014 
Location (of Interaction): Cathedral Beach Resort 

Time (of Interaction 24hrs):15:30  
Reporting Officer/s details: 7027330 & 7056480 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line Cathedral 
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) When let out 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: BWY13m 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Staff and visitors to Cathedrals Resort 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   click to select      

Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments Not relevant for this interaction report 
 
 
 
Detailed report of events: Dingo BWY13m was initially reported inside the fence line on or around 
17:30 24/6/2014. Ranger 7027330 responded to the event. Dingo seen by ranger and attempted to 
remove 25/06/2014 - 09:30.  
 
Liaison between resort managers/owners and rangers 7026466 & 7028018 continued until dingo release 
15:30 25/06/2014. No obvious signs of entry around the grid areas and immediate gates. 
 
Dingo released by following a scent lure attractant and walking through an open gate. 
 
 
 
Additional comments and notes: Dingo did not show signs of aggression or risk whilst inside the fence 
line. 
 
 
Action taken: Interaction responded to, dingo released and report produced. 
 
 
Proposed further action: Continue fence security until activity settles and any breach areas are 
secured. 
 
 
Faxed/emailed date:  26 June 2014                               Reporting Officers details:  7026486 
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Photos  

 

Photo 1.
Description: BWY13m at out 
grid 17:37 24/6/14. QPWS 

 

Photo 2.
Description: BWY13m at out 
grid 17:37 24/6/14. QPWS  

 

Photo 3.
Description: BWY13m at out 
grid 23:29 24/6/14. QPWS 
 

 

Photo 2.
Description: BWY13m at in 
grid 23:33 24/6/14. QPWS  
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Dingo Interaction Report Form Insert Code: C Dingo ID: GGPi13f 
 
Date (of Interaction): 27/ June 2014 
Location (of Interaction): Eli Creek car park area 

Time (of Interaction 24hrs): 15:30 
Reporting Officer/s details: 7026480 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged allowing dingo to 

approach and lick face for photograph. 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes  

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile       1       
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GGPi13f 
 
d. Which ears were tagged Right  
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Not taken 
Address:       
Phone #:       
Age:       
 
Reported by: 
Name: KBRV Driver 
Address: C/- KBRV 
Phone #:       
Age:       
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   tour participant      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments Driver had given all the passengers the dingo safety speal. 
 
 
 
Detailed report of events: Rangers 7026466 & 7028018 were approached by CTO driver who 
stated the following in conversation. A female tour participant with a KBRV tour driven by was 
observd by the drivers crouching low behind the tour bus taking a 'selfie' with a dingo licking her face. 
The CTO drivers dealt with the situation. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: This dingo has been regularly observed in this area and is 
conducting regular code C behaviour. KBRV drivers are all aware of the dingo safe messages and 
deliver these messages to their tour participants 
 
 
 
 
Action taken: Interaction reported.  
 
 
 
 
 
Proposed further action: Continue regular liaison with CTO operators and appropriate behaviour 
around dingoes. 
 
 
 
 
 
Faxed/emailed date:  30 June 2014                               Reporting Officers details:  7026466 
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Dingo Interaction Report Form Insert Code: C Dingo ID: GGPi13f 
 
Date (of Interaction): 27/ June 2014 
Location (of Interaction): Eli Creek car park area 

Time (of Interaction 24hrs): 15:30 
Reporting Officer/s details: 7026480 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged       
  living under or in infrastructure 
  following closely (distance) Chased at 

distance         
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes  

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile       1       
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GGPi13f 
 
d. Which ears were tagged Right  
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Tour participants - not obtained 
Address:       
Phone #:       
Age:       
 
Reported by: 
Name: KBRV Driver 
Address: C/- KBRV 
Phone #:       
Age:       
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   tour participant      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments Driver had given all the passengers the dingo safety speal. 
 
 
 
Detailed report of events: Rangers 7026466 & 7028018 were approached by CTO driver who 
stated the following in conversation. Tour participants with KBRV were in the water at Eli Creek when 
dingo GGPi13f approached two Asian guests as they splashed in the water. The tourists ran up the 
creek and the dingo 'chased' their movements from the shore not entering the water.  
 
The dingo was chased off. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: This dingo has been regularly observed in this area conducting 
regular code C behaviour. The 'Following closely' category was used as the most appropriate category 
in the code C selections. 
 
 
 
 
Action taken: Interaction reported.  
 
 
 
 
 
Proposed further action: KBRV drivers are all aware of the dingo safe messages and deliver these 
messages to their tour participants. 
 
 
 
 
 
Faxed/emailed date:  28 June 2014                               Reporting Officers details:  7026466 
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Dingo Interaction Report Form Insert Code: C Dingo ID: GGPi13f 
 
Date (of Interaction): 27/ June 2014 
Location (of Interaction): Eli Creek car park area 

Time (of Interaction 24hrs): 15:00-15:30
Reporting Officer/s details: 7026480 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify) Towel and 
shoe 

  soliciting food 
  being fed or encouraged       
  living under or in infrastructure 
  following closely (distance)               
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes  

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile       1       
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GGPi13f 
 
d. Which ears were tagged Right  
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Tour participants - not obtained 
Address:       
Phone #:       
Age:       
 
Reported by: 
Name: KBRV Driver 
Address: C/- KBRV 
Phone #:       
Age:       
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   tour participant      

Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Unknown 
Comments       
 
 
 
Detailed report of events: Rangers 7026466 & 7028018 were approached by CTO driver who 
stated the following in conversation.  
 
GGPi13f Stole a shoe then returned to steal a towel from the creek edge at the car park. Dingo was 
chased and items retrieved. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: This dingo has been regularly observed in this area conducting 
regular code C behaviour. The 'Following closely' category was used as the most appropriate category 
in the code C selections. 
 
 
 
 
Action taken: Interaction reported.  
 
 
 
 
 
Proposed further action: Continue to monitor this area especially during school holiday period. 
KBRV drivers are all aware of the dingo safe messages and deliver these messages to their tour 
participants. 
 
 
 
 
 
Faxed/emailed date:  28 June 2014                               Reporting Officers details:  7026466 
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Dingo Interaction Report Form Insert Code: C Dingo ID: GGPi13f 
 
Date (of Interaction): 28/06/2014 
Location (of Interaction): Happy Valley Beach 
Front 

Time (of Interaction 24hrs): 16:30 
Reporting Officer/s details: 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Wouldn’t leave 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile       1       
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GGPi13f 
 
d. Which ears were tagged Right  
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: A number of fishermen on the beach 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

15-166 File C 364 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 2 

Questionnaire:                  Specify visitor type   unknown      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments The boy was puffing himself up to appear large in an attemp to deter the dingo 
 
 
 
Detailed report of events: At approx. 16:30 ranger 7028018 was patrolling the beach and noticed a 
dingo in the surf standing next to a teenage boy fishing. Ranger 7028018 drove up to the boy who was 
puffing his chest up in an attempt to look large and to deter the dingo. The boy stated that the dingo 
(GGPi13f) was trying to access the bait in his front pocket. 
 
 
 
Additional comments and notes: It was suggested by the ranger that the boy put the bait into the 
bucket with a lid he had and place it in his parents car.  
 
GGPi13f (multiple code C, D & E interactions) is known for behaving problematically towards vistors on 
the beach.  
 
 
Action taken: All fishermen on the beach within close proximity to GGPi13f were briefed on dingo safety 
procedures. Report generated and circulated.  
 
 
Proposed further action: Continue ranger patrols along the beach and monitor dingo behaviour in the 
area  
 
 
 
 
 
Faxed/emailed date:  29/06/2014                               Reporting Officers details:  7028018 
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Dingo Interaction Report Form Insert Code: c Dingo ID: unknown 
 
Date (of Interaction): 28/06/14 
Location (of Interaction): Marloo CZ 

Time (of Interaction 24hrs): 0620 
Reporting Officer/s details:  7027848 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
       Stole "Go Pro" camera and tripod 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)          
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)   

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Black markings on back  
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Calamvale 4116 
Phone #:
Age: 45 
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: and a four other members of their camping group were enjoying a cup 
of tea and looking at the sunrise at approximately 6.20am in Marloo CZ, when a dingo approached their 
area and ran away with a camera and tripod. The dingo seemed to be a young male with black markings 
on it's back and it is believe not to have had an ear tag. The campers chased the dingo north along the 
dunes and then inland into the bush. They were unsuccessful in relocating their "Go Pro" and tripod, 
after searching adjacent bush for some time.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: The campers were regular visitors to the Island and kept a tidy camp 
area, free of food items and rubbish. 
 
 
 
 
 
Action taken: Reported incident and continued patrols in camp zones. 
 
 
 
 
 
 
 
 
Proposed further action:       
 
 
 
 
 
Faxed/emailed date:  30/06/14                                              Reporting Officers details:   

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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7027848 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
 

 

15-166 File C 369 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 1 

Dingo Interaction Report Form Insert Code: c Dingo ID: RBW13F 
 
Date (of Interaction): 29/06/2014 
Location (of Interaction): Dundubara beach front 

Time (of Interaction 24hrs): 1610 
Reporting Officer/s details: 7027334/7027848 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) 5m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults       1       
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: RBW13F 
 
d. Which ears were tagged Right  
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureNo 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments       
 
 
 
Detailed report of events: A dingo was hanging around vehicles and people, when rangers watched 
the dingo approched 2 young boys at the back of the vehicles while Dad and Uncle watching whales not 
their children. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: Went up to the people and gave them a good talking to about dingo safety as they are 
from another country 
 
 
 
 
 
 
 
 
Proposed further action: Nil 
 
 
 
 
 
Faxed/emailed date:                                                     Reporting Officers details:  
7027334/7027848 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
 

 

15-166 File C 372 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 1 

Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified 
 
Date (of Interaction): 29/6/14 
Location (of Interaction): Wyuna CZ 

Time (of Interaction 24hrs): 09:10 
Reporting Officer/s details: 7027202 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     6 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults 1 1       
Sub adults             4 
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:
Hornsby  NSW  2077 
Phone #: 
Age: Adult 
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

15-166 File C 373 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 2 

Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: Encounter started approx 9:10am, with the first sightings being a pair, one 
male, one female.! ! 
Breakfast was finished approximately 10 to 15 minutes earlier, dirty dishes and cooking utensils had not 
been washed, and where on the table.! ! 
Initial pair came within 2 metres of both of us, the dingo pair where sniffing the ground and area, at times 
pausing and making eye contact. At no stage did the dingoes show what we would deem aggressive 
behaviour. Ears where upright and alert, tail too.! ! 
One of this pair moved around our vehicle, and at this point we noted that the back of the utility was 
open, tailgate down, and this is where we kept our food. One of us moved to shut the back of the utility, 
the whole time the Dingo stood and watched. It was then noted that there appeared to be another 4 
more Dingoes 
following this initial pair.! ! 
We had an approximate counter of 6 Dingoes visible at the same time, uncertain if there were any 
more.! ! 
During the entire encounter, my wife and I stood, with arms folded, moving to keep the nearest Dingoes 
in sight at all times. Trying to act as a barrier (between them and our tent/camping space), more as 
standing our ground, but trying not to be aggressive. The initial pair did move to walk into our camping 
zone, more than once, and each time my wife and I stood our ground, stopping them from walking 
through.! ! 
I did arm myself with a folding shovel, but at no point was this lifted, or swung in an aggressive manor.! ! 
One of the initial pair moved around the back of our camping site, myself moving to maintain eye 
contact, and my wife staying to maintain eye contact/barrier with the remainder. Just as this unfolded, 
the pack then moved away from our camping site.! ! 
The remainder of the pack stayed their distance, during this encounter.! !! 
After some minutes had passed, we had noted that a Dingo had re-appeared on the north side of site. 
We are guessing that the pack had not moved away, but had instead circled around the rear of our 
campsite, using the small dunes behind our tent. We had three Dingoes walk through, then a fourth ran 
from the top of the small dune behind our tent, to within 2 metres of our tent, and me (who stood there 
with folding shovel hanging by my side). These four then moved in an easterly direction to stand on top 
of the dune overlooking the beach, which placed them between us and the beach. They watched for a 
few moments, then another two appeared and when they joined the other four they then continued north 
of our location.! ! 
Camp site GPS coordinates: 25 degrees, 6 minutes, 32 seconds, South! ! ! ! ! 153 degress, 18 minutes 
43 seconds, East.! !! 
We had had other encounters, but never more than one Dingo each time was seen. Most times the 
Dingo would come within 2 metres of camp, even being bold enough to mark a tree, yawning twice 
whilst led was cocked, and maintaining eye contact at all times. This is what we both deemed, bold 
behaviour.! ! 
Every day we would see signs (paw prints on our shade cloth ground cover) that a Dingo had been 
through our campsite whilst we were out.! ! 
Everyday that we were away from camp we were diligent in cleaning up, and making sure that our site 
was of little interest to a passing Dingo. Our foods, toiletries and the likes travelled with us. There was no 
hanging towels, cords, ropes, or otherwise about our site. Our camp chairs also travelled with us. All that 
was left outside our tent was a table, gas stove, gas bottle, kettle and water container. Inside the tent 
was our clothes bag, clean and dirty clothes, and bedding. 
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Additional comments and notes:  The above report was submitted by the camper electronically and is 
written as firsthand experience. The pack of six dingoes has been sighted recently with 2 yellow and an 
alpha male with the sub adults. 
 
 
 
 
 
Action taken: report generated 
 
 
 
 
 
 
 
 
Proposed further action: Continued briefings and patrols 
 
 
 
 
 
Faxed/emailed date:  30/6/14                                              Reporting Officers details:  
7027202 
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Dingo Interaction Report Form Insert Code: C Dingo ID: BRG13M 
 
Date (of Interaction): 30/6/14 
Location (of Interaction): Maheno – Sand dunes 
behind wreak 

Time (of Interaction 24hrs): 1130
Reporting Officer/s details: 7027816 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) 20m         
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) swung rod holder in air while 

yelling at and chasing Dingo 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults 1             
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Left 
    Details: BRG13M 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Clear photo of tag seen by 7027816 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #: 
Age: Adult 
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: Four children (two twelve years + two fourteen years), playing on the sand 
dune behind the Maheno wreck. Dingo approached along back of beach and started running up the 
sand dune towards the children. The children’s father who saw the incident unfold, picked up a fishing 
rod holder and started running towards the dingo and yelling at it. At this point the dingo stopped running 
towards the children and briefly sat down. As the father approached closer it trotted sideways down the 
dune and continued on its way, along the beach. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Report only received yesterday afternoon at Cathedral shop. 
7027816 saw several photos of dingo taken by fourteen year old and was able to clearly identify it. 
 
 
 
 
 
Action taken: Notified RIC NRM, Notified NMU Dingo Ranger, report generated 
 
 
 
 
 
 
 
 
Proposed further action: Continued briefings and patrols 
 
 
 
 
 
Faxed/emailed date:  3/7/14                                              Reporting Officers details: 7027816
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):        
 

 Photo 2.
Description (who took 
photo/when):        
 

 Photo 3.
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: GY13M and Unidentified 
Tagged Male 
 
Date (of Interaction): 2Jul14 
Location (of Interaction): Hook Point Barge 
Landing 

Time (of Interaction 24hrs): 1618-1630 
Reporting Officer/s details: 7026804-7027292 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) 1-2m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     click to select 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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  lunging (attempting to nip or bite) 
Questionnaire:                  Specify visitor type   click to select      

Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: 7026804 and 7027292 pulled up into the queue for the barge and we 
observed GY13m and another tagged male dingo loitering around the barge landing area, around 
queued vehicles and a group of hikers sitting on the dunes waiting to be collected by the FI taxi. GY13m 
was closest to the group of hikers, whilst the other tagged male loitered around the front of the queue. 
Neither were wary of vehicles. 7027146 was already present in the queue and had spoken to the hikers 
about dingo safety and their appropriate behaviour. The dingoes were present until the barge pulled 
away to head back to the mainland, and were observed to approach the group of hikers within 1-2m 
when the taxi pulled up and they began to load their gear into the car. One of the male group members 
eventually ran at one of the dingoes, yelling at it and trying to discourage its presence. The dingo 
retreated slightly at this action. No other efforts to discourage the dingoes were evident from any other 
parties present. 
 
 
 
 
 
Additional comments and notes: GY13m tag had a blue button inside the ear, front left sock to top of 
toes, front right sock to top of toes but angling upwards inside leg. Small horizontal mark evident on 
forehead, equidistant between eyebrows (refer photos). 
Other tagged male dingo too distant to ascertain identity. 
 
 
 
 
 
Action taken: Report Generated 
 
 
 
 
 
 
 
 
Proposed further action: Patrol and monitor animals
 
 
 
 
 
Faxed/emailed date:  18Jul14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1.
Description (who took 
photo/when):  7026804 2Jul14 
 

 

Photo 2.
Description (who took 
photo/when):  7026804 2Jul14 
 

 Photo 3.
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: GGPu13M and GGR12F 
 
Date (of Interaction): 4th July 2014 
Location (of Interaction): Hook Point Barge 
Landing Area 

Time (of Interaction 24hrs): 0700
Reporting Officer/s details: 7027518 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Did not leave were still there 

when barge left with visitors 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults       1       
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GGPu13M and GGR12F 
 
d. Which ears were tagged click to select 
    Details: GGPu Left GGR Right 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   QPWS employee      

Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: At 0700 Friday 4th July 7027518 observed two dingoes walking towards 
vehicles waiting for the barge both dingoes walked around vehicles and people for over 15 minutes. 
Both were approaching people and vehicles with noses in the air sniffing for food. Both walked within 
three metres of people. Some people tried to shoo them away unsuccessfuly. They would retreat to the 
foredune but then come straight back. 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Before GGPu13M got to the vehicles BRR12M approached him and 
dominated him. GGPu cowered and snarled and BRR12M lost interest and walked up onto the foredune.
 
 
 
 
 
Action taken:      
 
 
 
 
 
 
 
 
Proposed further action: Continue monitoring area. 
 
 
 
 
 
Faxed/emailed date:  5/7/14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1.
Description (who took 
photo/when):  GGPu13M 
Scavenging around vehicles 
7027518 0700 4/7/14 
 

 

Photo 2.
Description (who took 
photo/when):  GGPu13 
Scavenging around 
vehicles7027518 0700 4/7/14 
      
 

 

Photo 3.
Description (who took 
photo/when): GGPu13M and 
GGR12F on foredune. 7027518 
0700 4/7/14 
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Dingo Interaction Report Form Insert Code: C Dingo ID: BRG13m & ROR13f 
 
Date (of Interaction): 5/7/14 
Location (of Interaction): Eli Creek Day use area 

Time (of Interaction 24hrs): Entire day 
Reporting Officer/s details: 7026936 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1 1       
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: BRG13m & ROR13f 
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   click to select      

Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Ranger 7026936 was carrying out pest conroll work at the Eli Creek day use 
are on the 6/7/14. BRG13m and ROR13f were observed loitering constantly around visitors at the creeks 
edge throughout the entire day. There were no signs (or reports) of aggressive behaviour observed by 
ranger 7026936, however both dingoes were approaching visitors within 1m, soliciting food. Visitors 
were observed attempting to deter the dingo from approaching closely, to no avail.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: These dingoes are from a litter that is known to be highly habituated. 
It is highly likely that these dingoes were loitering around the Eli ck DUA due to the 10kg (approx) of 
whole fish that was found buried at this site on the morning of 5/7/14.  
 
 
 
 
 
Action taken: report generated and circulated 
 
 
 
 
 
 
 
 
Proposed further action: continue regular patrols to Eli ck during high visitation.
 
 
 
 
 
Faxed/emailed date:  8/7/14                               Reporting Officers details:  7026936 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):  7026804 during 
interaction 
 

 Photo 2.
Description (who took 
photo/when):  as above 
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Dingo Interaction Report Form Insert Code: C Dingo ID: BRG13M and 
Unidentified Dingo 
 
Date (of Interaction): 5Jul14 
Location (of Interaction): Eli Ck 

Time (of Interaction 24hrs): 0800
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1       1 
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details: BRG13M 
 
d. Which ears were tagged Unknown 
    Details: BRG13M right ear 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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  lunging (attempting to nip or bite) 
Questionnaire:                  Specify visitor type   QPWS employee      

Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: On morning patrol 7027330 sighted an unidentified dingo high up on the 
south bank of Eli creek another dingo was sighted near the portable toilets and was identified as 
BRG13M. On closer inspection of the creek bank three holes were found full of under sized whole Dart. 
Dingoes and birds had been feeding on the exposed fish which had been buried very shallow on the 
north bank of the creek 30m from the entrance to the board walk. Dead fish were also sighted in the 
creek. BRG13M showed no interest in the exposed and went to sleep in the sun on the south bank of 
the creek. 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: As the fish were whole and buried very shallow in large numbers it is 
believed that this was to feed and attract dingoes to the area.  
 
 
 
 
 
Action taken: All fish removed and reburied away from the area. RIC Nth informed, report generated. 
 
 
 
 
 
 
 
 
Proposed further action: Patrol area 
 
 
 
 
 
Faxed/emailed date:  5/7/14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  7027330 0800 
5Jul14 Eli Ck 
 

 Photo 2. 
Description (who took 
photo/when):        
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 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: RBW13F 
 
Date (of Interaction): 5/7/14 
Location (of Interaction): South Guraman Camp 
zone 

Time (of Interaction 24hrs): 1530
Reporting Officer/s details: 7027816 / 7027130 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify) Attempted 
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) did not leave even after being 

chased several times 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults       1       
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Right  
    Details: RBW 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Fishermen 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      

Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Dingo hanging around two fishermen for over half an hour. Trying to steal 
fish, but unsuccessful. Dingo was consistantly chased away but persisted in hanging around. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Dingo approached to within two meters of rangers car, whislt talking 
to fishermen. Entire pack of six dingoes loitering on beach from Cathedrals north in the afternoon, RBW 
exibiting the most habituated behaviour. 
 
 
 
 
 
Action taken: Notified Dundubara dingo ranger, report generated.  
 
 
 
 
 
 
 
 
Proposed further action: Continued monitoring and patrols 
 
 
 
 
 
Faxed/emailed date:  6/7/14                               Reporting Officers details:  7027816 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):  7026804 during 
interaction 
 

 Photo 2.
Description (who took 
photo/when):  as above 
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Dingo Interaction Report Form Insert Code: C Dingo ID: BWY13M 
 
Date (of Interaction): 6 Jul 14 
Location (of Interaction): Yuru CZ 

Time (of Interaction 24hrs): 0730
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) moved away short distance  

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: BWY13M 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   QPWS employee      

Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: On morning patrol 7027330 sighted a dingo sitting on the beach behind a 
fisherman. On approaching the dingo was identified as BWY13M. When approached the dingo moved a 
short distance away and layed down in a wheel rut. The fisherman was spoken to and advised to 
actively deter dingoes. The fisherman was not aware that the dingo was behind him. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: This dingo is regularly seen during the day on the beach, it is highly 
habituated. This dingoes behavior show potential for a car strike. 
 
 
 
 
 
Action taken: RIC Nth informed, report generated 
 
 
 
 
 
 
 
 
Proposed further action: Monitor animal, Continue patrolling and briefing regime. 
 
 
 
 
 
Faxed/emailed date:  6/7/14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):        
 

 Photo 2.
Description (who took 
photo/when):        
 

 Photo 3.
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified Dingo 
 
Date (of Interaction): 7 Jul 14 
Location (of Interaction): Happy Valley 
Beachfront 

Time (of Interaction 24hrs): 1500
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) 5m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) People left in car 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age 1             

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   Independant      

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: At approx. 1500 and his grandson went down to the Happy Valley 
beachfront. and his grandson began playing with a ball, the young boy ran after the ball when he 
saw a dingo approaching. The boy ran back to his grand father. The dingo approached to within 5m  and 
continued to follow them around. The dingo was described as a small skinney male with possibley a 
yellow ear tag. At this point a vehicle pulled up and offered to take them to Happy Valley. On his return 
to Happy Valley rang the dingo hotline and reported the interaction. At 1600 ranger 7027330 
called and conducted an interview. At the conclusion of the interview was going back to the 
beach in a vehicle to see if he was able to to confirm the dingo identification. was later contacted 
and was not able to con firm the dingo identifcation. 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: The dingo showed no aggression. was unsure of the 
identification, no dingo regularly seen in the area matches that description. When spoken to latter
had wittnessed two other interactions on the beachfront that afternoon.  
 
 
 
 
 
Action taken: Interview conducted, report generated. 
 
 
 
 
 
 
 
 
Proposed further action: Monitor dingoes in the area , continue patrolling and briefing regime. 
 
 
 
 
 
Faxed/emailed date:  8/7/14                                              Reporting Officers details:  
7027330 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):        
 

 Photo 2.
Description (who took 
photo/when):        
 

 Photo 3.
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified Dingo 
 
Date (of Interaction): 7 Jul 14 
Location (of Interaction): Happy Valley 
Beachfront 

Time (of Interaction 24hrs): 1630
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Ran off into bush 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   unknown      

Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Unknown 
Comments       
 
 
 
Detailed report of events: At approx. 1630 went to the Happy Valley beachfront to see if he could 
identify a dingo that was involved in an earlier interaction, he was unable to find the dingo involved. 
However he witnessed an unidentified dingo jump into the back of a ute and take a bait bag and run of 
into the bush. 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: The Oaks pack are highly habituated, occurrences like this are 
increasing in frequency. 
 
 
 
 
 
Action taken: Interview conducted, report generated. 
 
 
 
 
 
 
 
 
Proposed further action: Monitor dingoes in the area, continue patrolling and briefing regime.
 
 
 
 
 
Faxed/emailed date:  8/7/14                                              Reporting Officers details:  
7027330 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):        
 

 Photo 2.
Description (who took 
photo/when):        
 

 Photo 3.
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified Dingo 
 
Date (of Interaction): 7 Jul 14 
Location (of Interaction): Happy Valley 
Beachfront 

Time (of Interaction 24hrs): 1630
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Ran off 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

15-166 File C 405 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 2

Questionnaire:                  Specify visitor type   unknown      

Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Unknown 
Comments       
 
 
 
Detailed report of events: At approx. 1630 went to the Happy Valley beachfront to see if he could 
identify a dingo that was involved in an earlier interaction, he was unable to find the dingo involved. 
However he witnessed an unidentified dingo take a fish from a bucket between a womans legs. The 
dingo then ran off into the dunes. 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: The Oaks pack are highly habituated, occurrences like this are 
increasing in frequency. 
 
 
 
 
 
Action taken: Interview conducted, report generated. 
 
 
 
 
 
 
 
 
Proposed further action: Monitor dingoes in the area, continue patrolling and briefing regime.
 
 
 
 
 
Faxed/emailed date:  8/7/14                                              Reporting Officers details:  
7027330 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):        
 

 Photo 2.
Description (who took 
photo/when):        
 

 Photo 3.
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: BWR13m 
 
Date (of Interaction): 8 July 20144 
Location (of Interaction): Eurong Second Valley 
beachfront, immediately out front of entrance 

Time (of Interaction 24hrs): 0935hrs 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 
X  loitering at recognized visitor sites (people    
       nearby)      
X  stealing food or property (specify) pilchards 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 

X  following closely (distance) approach within 
2m        

  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 

X  other (specify) didn’t leave – only retreated 5-
10m and laid down after approached by QG 
with horn honked 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: BWR13m confirmed by rangers 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details: Confirmed ID 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Not recorded 
Address: 2 x teenage boys 
Phone #:       
Age: estimated age 15 y.o. 
 
Name:       
Address:       
Phone #:       
Age:       
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  lunging (attempting to nip or bite) 
Questionnaire:                  Specify visitor type   Staying in rental accommodation      

Did they receive an information pack with their permits unknown 
Did they read the Dingo Brochure unknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments Teenager closest to dingo was unfamiliar with Dingo Safe messaging 
 
 
 
Detailed report of events: Whilst driving north along the beach towards Eurong office, myself and 
ranger 7026254 observed a dingo (identified as BWR13m through an ear tag in its left ear) within 2m of 
a teenage boy standing near the water’s edge with a plastic shopping bag of pilchards on the ground in 
between the two. BWR13m then moved in quickly and grabbed the bag, removing himself about 3m 
before attempting to consume the pilchards. The teenager did not seem to make an effort to retrieve the 
bag, so we drove the QG vehicle to within 2m of the dingo and honked the horn at him, startling him and 
he then dropped the bag, which the teenager then retrieved. BWR13m retreated approximately 5-10m at 
this point and lay down watching the other teenager fishing. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: BWR13m remained in the area when we left, despite ranger 
7026254 attempting to shoo him away. His behaviour and complacency around vehicles indicates that 
he may be at risk of vehicle strike. 
 
 
Action taken: Ranger 7026254 then spoke to the closest teenager about keeping his bait and catch 
secure, warned him of the $330 fine for failing to secure food and gave him a dingo safe briefing. He 
claimed not to have known any dingo safe information. 
 
 
Proposed further action: Continue opportunistic briefings and patrols. 
 
 
 
 
 
Faxed/emailed date:  09July2014                               Reporting Officers details:  7026804 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):  7026804 during 
interaction 
 

 Photo 2.
Description (who took 
photo/when):  as above 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Untagged adult 
13Green10m – positively identified from photographic comparisons 
 
Date (of Interaction): 9 July 2014 
Location (of Interaction): Central Station day use 
area – edge of vegetated area next to eastern 
toilet block 

Time (of Interaction 24hrs): 1621-1624hrs 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
C) Nuisance or problem. 
X  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

D) Aggressive. 
  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 

X  other (specify) didn’t leave – sniffed around 
ground in general vicinity 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults 1             
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged No 
    Details:       
 
d. Which ears were tagged Nil 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details: Prominent scar above right eyebrow, 
small white tail tip, fading socks – see photos 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 7026804 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   QPWS staff      

Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Whilst walking through Central Station day use area, we noticed a dingo 
lying on the edge of the vegetated area within 40m of the eastern toilet block. A bus was departing the 
parking area at the time. I photographed the dingo with my zoom camera for identification purposes, 
noting that it did not have a tag and was a male. The dingo was not wary of our presence. After showing 
the photographs to dingo rangers, the dingo was confirmed to be untagged adult male 13Green10m 
(had been previously tagged but tag was intentionally removed a couple of years ago). On leaving the 
dingo and continuing through the day use area, about a minute later 13Green10m again lay down and 
then proceeded to howl for approximately 20 seconds. He later arose and continued sniffing around the 
ground in the local area. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: See attached photographs 
 
 
 
 
 
Action taken: Photographed for identification purposes 
 
 
 
 
 
 
 
 
Proposed further action: Consider retagging if appropriate 
 
 
 
 
 
Faxed/emailed date:  10July2014                               Reporting Officers details:  7026804 
 
 

15-166 File C 412 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 3

Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1 
Description (who took 
photo/when):  7026804 during 
interaction 
 

 

Photo 2 
Description (who took 
photo/when):  as above 
 

 

Photo 3 
Description (who took photo/when):  
as above 
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Dingo Interaction Report Form Insert Code: C Dingo ID: ? 
 
Date (of Interaction): 09/07/2014 
Location (of Interaction): Maheno CZ 

Time (of Interaction 24hrs): 2100
Reporting Officer/s details: 7027334 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             2 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: Father and son sitting on fore dune in front of there trailer when a dingo 
walked in front going past they noticed the animal stood up and backed away to the trailer while the 
dingo followed them, the father turned around to go in the trailer and saw another dingo nearby they 
both were in the trailer when the father open the door shorty after he yelled at them and they cleared off. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: Made a report 
 
 
 
 
 
 
 
 
Proposed further action: Keep monitoring, keep patroling
 
 
 
 
 
Faxed/emailed date:  14/07/2014                                              Reporting Officers details:  
7027334 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):        
 

 Photo 2.
Description (who took 
photo/when):        
 

 Photo 3.
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified dingo(es) 
 
Date (of Interaction): 9-10 July 2014 
Location (of Interaction): Ocean Lake camping 
zone 

Time (of Interaction 24hrs): overnight 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 
x  loitering at recognized visitor sites (people    
       nearby)      
x  stealing food or property (specify) work boots 
and bag of clothing 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

E) Dangerous. 
  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

X  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             x 

 
c. Were the dingo(s) tagged unknown 
    Details:       
 
d. Which ears were tagged unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:unsighted – campers were asleep 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   campers      
Did they receive an information pack with their permits unknown 
Did they read the Dingo Brochure unknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) no 
Comments Should have kept their camp less attractive to dingoes 
 
 
 
Detailed report of events: Campers reported having work boots and a bag of clothing stolen overnight 
from their camp at Ocean Lake camping zone. All items were retrieved the following morning. Due to all 
campers being asleep/in bed at the time, the responsible dingo/es weren’t identified. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Nil 
 
 
 
 
 
Action taken: Reported 
 
 
 
 
 
 
 
 
Proposed further action: Monitor dingo activity and continue briefings in local area. 
 
 
 
 
 
Faxed/emailed date:  13July2014                               Reporting Officers details:  7026804 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):  7026804 during 
interaction 
 

 Photo 2. 
Description (who took 
photo/when):  as above 
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Dingo Interaction Report Form Insert Code: c Dingo ID: unknown 
 
Date (of Interaction): 10/07/14 
Location (of Interaction): Maheno CZ 

Time (of Interaction 24hrs): between 2100 and 
0700 
Reporting Officer/s details: 7028595 & 7027848 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)          
  damaging property (specify) fishing waders 
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)   

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address: Palmwoods 4555 
Phone #:
Age: 50 
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: woke up on the morning of the 11/07/14 to find his wife's fishing 
waders down towards the beach with bite marks on them. No dingoes were present.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: No dingoes came within their camping area on the day of the 
interaction, although on the night of 11/07/14 there was a separate dingo interaction that will be 
reported. 
 
 
 
 
 
Action taken: Reported incident and continued patrols in camp zones. 
 
 
 
 
 
 
 
 
Proposed further action:       
 
 
 
 
 
Faxed/emailed date:  16/07/14                                              Reporting Officers details:  
7028595 & 7027848 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Tagged female 
 
Date (of Interaction): 10 July 2014 
Location (of Interaction): Between Maheno and 
Eastern Beach 

Time (of Interaction 24hrs): 12:15 
Reporting Officer/s details: 7026466 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes Hazing 

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) When hazed 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults       1       
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: Not described 
 
d. Which ears were tagged Right  
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Dark back and smaller 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address: Brisbane 
Phone #: 
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   Independant      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Unknown 
Comments The accused mans side of the interaction was not obtained to determine. 
 
 
 
Detailed report of events: Ranger 7026466 was travelling the eastern beach and observed BRG13m, a 
sub adult male dingo loitering around a group of people and digging at fish scraps near them. On further 
investigation the people advised they did not leave the scraps there and the dingo was not approaching 
them. advised the ranger that he and the group were fishing between the Maheno and Cathedral 
Beach the day before (10/7/14) when a dingo tagged in the right ear was hanging around them. No 
further tag details were obtained.  
 
They shooed the dingo away a few times as it was persistent.  
 
A vehicle pulled up ( Holden rego number with a man described as a white man that 
looked to be in his 50's, with a This man got out of the 
vehicle and produced a slingshot. He proceeded to take aim and fire at the dingo. 
 

yelled at the man who stated he was protecting himself. He then unpacked his fishing gear 
and proceeded to start fishing. The dingo moved on and did display any sign of injury. 
 
 
 
 
 
 
 
 
Additional comments and notes: There have been recent reports of visitors using stock whips to deter 
dingoes on the eastern beach.  
 
 
 
 
 
Action taken: Interaction reported. Interaction will not be followed. 
 
 
 
 
 
 
 
Proposed further action: Continue patrolling high risk areas and visitor education regarding Dingo safe 
messages. 
 
 
 
 
 
Faxed/emailed date:  12 July 2014                               Reporting Officers details:  7026466 
 
  

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Dingo Interaction Report Form Insert Code: C Dingo ID: GGPi13f 
 
Date (of Interaction): 10 July 2014 
Location (of Interaction): Beachfront, Poyungan 
camping zone 

Time (of Interaction 24hrs): 0930hrs 
Reporting Officer/s details:7026254 through 
7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 
X  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       

X  interference with dingoes being tailed by tour 
bus 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

E) Dangerous. 
  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 

X  other (specify) didn’t leave – continued north 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile       1       
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GGPi13f (confirmed) 
 
d. Which ears were tagged Right 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details: Confirmed identity 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Recorded by 7026254 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   QPWS staff      

Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Whilst driving northwards along the beach, ranger 7026254 observed 
GGPi13f trotting north along the beach, out the front of the currently closed Poyungan camping zone. 
She was being tailed by a tour bus, perhaps to allow passengers to photograph her from the bus? 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: Reported 
 
 
 
 
 
 
 
 
Proposed further action: Monitor activity, continue closure of camping zone given GGPi13f presence 
 
 
 
 
 
Faxed/emailed date:  12July2014                               Reporting Officers details:  7026804 
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Dingo Interaction Report Form Insert Code: C Dingo ID: GY13m 
 
Date (of Interaction): 10 July 2014 
Location (of Interaction): Cornwells camping 
zone, northernmost site 

Time (of Interaction 24hrs): 1100hrs 
Reporting Officer/s details:       
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 
X  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

X  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GY13m 
 
d. Which ears were tagged left 
    Details:  
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Not recorded 
Address:  
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits unknown 
Did they read the Dingo Brochure unknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) yes 
Comments       
 
 
 
Detailed report of events: Campers reported GY13m (described as ‘young male with green and yellow 
tag in its left ear) wandering into their camp at around 11am, lying down for a couple of minutes before 
standing up and sauntering off without needing to be discouraged. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Nil 
 
 
 
 
 
Action taken: Reported. 
 
 
 
 
 
 
 
 
Proposed further action: Monitor dingo activity, continue briefings. 
 
 
 
 
 
Faxed/emailed date:  13July2014                               Reporting Officers details:  7026804 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):  7026804 during 
interaction 
 

 Photo 2. 
Description (who took 
photo/when):  as above 
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Dingo Interaction Report Form Insert Code: C Dingo ID: ? 
 
Date (of Interaction): 09/07/2014 
Location (of Interaction): Maheno CZ 

Time (of Interaction 24hrs): 2100
Reporting Officer/s details: 7027334 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             2 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: Father and son sitting on fore dune in front of there trailer when a dingo 
walked in front going past they noticed the animal stood up and backed away to the trailer while the 
dingo followed them, the father turned around to go in the trailer and saw another dingo nearby they 
both were in the trailer when the father open the door shorty after he yelled at them and they cleared off. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: Made a report 
 
 
 
 
 
 
 
 
Proposed further action: Keep monitoring, keep patroling
 
 
 
 
 
Faxed/emailed date:  14/07/2014                                              Reporting Officers details:  
7027334 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):        
 

 Photo 2.
Description (who took 
photo/when):        
 

 Photo 3.
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: c Dingo ID: unknown 
 
Date (of Interaction): 10/07/14 
Location (of Interaction): Maheno CZ 

Time (of Interaction 24hrs): between 2100 and 
0700 
Reporting Officer/s details: 7028595 & 7027848 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)          
  damaging property (specify) fishing waders 
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)   

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Palmwoods 4555 
Phone #:
Age: 50 
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: woke up on the morning of the 11/07/14 to find his wife's fishing 
waders down towards the beach with bite marks on them. No dingoes were present.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: No dingoes came within their camping area on the day of the 
interaction, although on the night of 11/07/14 there was a separate dingo interaction that will be 
reported. 
 
 
 
 
 
Action taken: Reported incident and continued patrols in camp zones. 
 
 
 
 
 
 
 
 
Proposed further action:       
 
 
 
 
 
Faxed/emailed date:  16/07/14                                              Reporting Officers details:  
7028595 & 7027848 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):        
 

 Photo 2.
Description (who took 
photo/when):        
 

 Photo 3.
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: c Dingo ID: unknown 
 
Date (of Interaction): 11/07/14 
Location (of Interaction): Maheno CZ 

Time (of Interaction 24hrs): 2200
Reporting Officer/s details:  7027848 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)          
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)   

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     6 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults 4 2       
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:  
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address: 
Phone #:
Age: 50 
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: and his wife were relaxing under their caravan annex at about 10pm 
when a group of seven dingoes came from behind the foredunes. There was seven dingoes present, a 
juvenile male was attacked by two adult males and the younger dingo tried to escape by getting under 

caravan. The young dingo then ran to the north of the camp site with the other dingoes in 
pursuit.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: The campers were regular visitors to the Island and kept a tidy camp 
area, free of food items and rubbish. 
 
 
 
 
 
Action taken: Reported incident and continued patrols in camp zones. 
 
 
 
 
 
 
 
 
Proposed further action:       
 
 
 
 
 
Faxed/emailed date:  16/07/14                                              Reporting Officers details:  
7027848 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):        
 

 Photo 2.
Description (who took 
photo/when):        
 

 Photo 3.
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: BRG13m 
 
Date (of Interaction): 11 July 2014 
Location (of Interaction): Eli Creek beach 

Time (of Interaction 24hrs): 15:10 
Reporting Officer/s details: 7026466 & 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: BRW13m 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Details not obtained 
Address:       
Phone #:       
Age:       
 
Reporter Name: CTO driver
Address: C/ KBRV 
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments       
 
 
 
Detailed report of events: Rangers 70266466 & 8028018 were conducting routine patrolling in high risk 
areas when KBRV CTO Driver informed them that fishermen fishing south of Eli Creek looked to 
be offering a tagged male dingo small fish or bait.  
 

spoke to the fishermen who were not overly receptive to him. They all looked to be drinking. 
Rangers went to Eli creek and observed 4 director-camper chairs with a 750ml bottle of rum half full on 
the ground between two of the chairs, fishing gear and esky and only 1 fisherman fishing at the location 
described by No dingoes were observed in the vicinity south of Eli Creek by the rangers. 
 
Rangers continued to Eli creek (approximately 100 metres away) and observed BRG13m loitering in the 
area scratching at the ground and foraging amongst RBAC vehicles and near other CTO vehicles 
(pictured below). He did not approach humans or act in an aggressive manner while being observed.  
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: BRG13m is regularly seen in this area with other sub adult dingoes. 
There have been regular reports of this pack being allegedly fed and encouraged. CTO operators have 
been asked to assist QPWS in ensuring dingo safe messages are conveyed to their tours and anyone 
they feel they can or need to approach to discuss with if behaving inappropriately towards dingoes. 
 
 
 
 
 
Action taken: Interaction reported. 
 
 
 
 
Proposed further action: Continue regular patrols in this area to educate visitors about dingo safe 
messages and prevent inappropriate interactions that may lead to high risk behaviour. The previous 
dingo booklet/brochure is still unavailable for use and distribution to the public. Education is assisted by 
using brochures such as these when permits are purchased and rangers can refer people to them during 
education. 
 
 
 
 
 
Faxed/emailed date:  12/7/14                               Reporting Officers details:  7026466 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
 

 

Photo 1. 
Description (who took 
photo/when): 7026466 –Eli Creek 
 

 

Photo 2. 
Description (who took 
photo/when): 7026466 –Eli Creek 
 

 

Photo 3. 
Description (who took 
photo/when):7026466 –Eli 
Creek 
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Dingo Interaction Report Form Insert Code: C Dingo ID: GGPi13f 
 
Date (of Interaction): 11/7/2014 
Location (of Interaction): 50m sth Yidney Rocks 
on beach 

Time (of Interaction 24hrs): 13:26 
Reporting Officer/s details: 7026466 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GGPi13f 
 
d. Which ears were tagged Right  
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Not obtained - observed by rangers 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   Independant      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Dingo brochure not available in print. 
 
 
 
Detailed report of events: Rangers observed GGPi13f on the beach 50 metres south of Yidney Rocks 
approach a group of people to within 5 metres in a non-aggressive manner. She continued her activity 
until the people moved on.  
 
 
 
 
Additional comments and notes: GGPi13f is regularly seen in this area along with her siblings. 
 
 
 
 
 
Action taken: Interaction reported 
 
 
 
Proposed further action: Continue regular patrols in high risk area for education of visitors regarding 
Dingo safe messages and preventing adverse human/dingo interaction. Revise and reprint the dingo 
safe booklet/brochure. 
 
 
 
 
 
Faxed/emailed date:  13/7/14                               Reporting Officers details:  7026466 
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Dingo Interaction Report Form Insert Code: C Dingo ID: ROR13f 
 
Date (of Interaction): 11 July 2014 
Location (of Interaction): Eli CZ southern end on 
beach 

Time (of Interaction 24hrs): 13:20 
Reporting Officer/s details: 7026466 & 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) When family stopped 

worming and moved on. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults       1       
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: ROR13f 
 
d. Which ears were tagged Right  
    Details: ROR13f 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Not taken - observed by rangers 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   Independant      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Packed up and moved on away from the dingo activity 
 
 
 
Detailed report of events: Rangers were conducting routine patrol of the high risk visitor areas when 
they observed a family of two adults and two children that looked to be between 8 and 11 years of age 
attempting to worm on the beach.  
ROR13f was persistent in approaching them within 5 metres and followed them to their vehicle as they 
packed up and moved on.  
No aggressive behaviour from ROR13f was observed. 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: ROR13f is a regularly present in this area with her siblings. ROR13f 
was collected deceased 12/7/14 on the beach at Eli Creek. Cause of death to be determined. 
 
 
 
 
 
Action taken: Interaction reported 
 
 
 
 
 
 
 
 
Proposed further action: Continue patrols in this area to educate vistors regarding dingo safe 
messages. 
 
 
 
 
 
Faxed/emailed date:  12/7/14                               Reporting Officers details:  7026466 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Untagged 
 
Date (of Interaction): 11/7/14 
Location (of Interaction): Dundubara 

Time (of Interaction 24hrs): 08:00 
Reporting Officer/s details: 7027202 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
       Shoe 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) 10mtr        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged No 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #: 
Age: Adult 
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureNo 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments       
 
 
 
Detailed report of events: Spoke to camper on the beach where he had an untagged 
male dingo withing 5-10 metres of him, we asked if the dingo had been hanging around while he was 
fishing and he mentioned that it had stolen his shoe, I advised that he needs to have a stick with 
him and a secure box/bucket to keep his gear in or bring his vehicle down, decided to pack up, we 
waited till he was in the fenced area then moved on. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: this dingo is often seen loitering around Dundubara and prints would 
indicate he gets around the fencline. 
 
 
 
 
 
Action taken: report generated 
 
 
 
 
 
 
 
 
Proposed further action: Continued briefings and patrols and making fisherman aware of their 
obligation regarding storage of property. 
 
 
 
 
 
Faxed/emailed date:  14/7/14                                              Reporting Officers details:  

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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7027202 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
 

 

Release
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Dingo Interaction Report Form Insert Code: C Dingo ID: Untagged 
 
Date (of Interaction): 11/7/14 
Location (of Interaction): Dundubara 

Time (of Interaction 24hrs): 08:10 
Reporting Officer/s details: 7027202 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
       fish 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) rangers moved it on 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged No 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age: Adult 
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments       
 
 
 
Detailed report of events: was fishing when rangers saw a dingo sitting at her vehicle eating fish 
out of her bucket. was made aware of the incident and encouraged to leave her buckets in the 
vehicle. She understood the seriousness of the event and couldn’t believe she had let it happen. I 
advised her about her obligations regarding food security and storage and she understood.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: this dingo is a regular to the area and seems to be unwary of 
humans. 
 
 
 
 
 
Action taken: report generated 
 
 
 
 
 
 
 
 
Proposed further action: Continued briefings and patrols and making fisherman aware of their 
obligation regarding storage of property. 
 
 
 
 
 
Faxed/emailed date:  14/7/14                                              Reporting Officers details:  
7027202 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
 

 
Release
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Dingo Interaction Report Form Insert Code: C Dingo ID: BGB01f (described as 
blue/green tag, flopped ear, and ‘old looking’) 
 
Date (of Interaction): 12 July 2014 
Location (of Interaction): Gabala camping zone, 
2nd node from northern boundary 

Time (of Interaction 24hrs): 0900hrs 
Reporting Officer/s details:       
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 
X  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

D) Aggressive. 
  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

E) Dangerous. 
  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 

X  other (specify) continued territorial patrol 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults       1       
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: Blue Green Blue 
 
d. Which ears were tagged Right 
    Details: Ear flopped due to suspected fight 
injury 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Megazzane 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   campers      
Did they receive an information pack with their permits yes 
Did they read the Dingo Brochure yes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) yes 
Comments all food secured at camp 
 
 
 
Detailed report of events: Campers reported ‘old female with blue and green tag in floppy right ear’ 
passing by their camp at a distance close enough to identify tag colours. Through this description, the 
dingo positively identified as BGB01f, whose ear has flopped in recent days, potentially after a fight with 
another dingo. BGB01f did not demonstrate any interest in spending any extended time around the 
campers. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Nil 
 
 
 
 
 
Action taken: Reported. 
 
 
 
 
 
 
 
 
Proposed further action: Monitor wherever possible. 
 
 
 
 
 
Faxed/emailed date:  13 July 2014                               Reporting Officers details:  7026804 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Untagged 
 
Date (of Interaction): 13/07/2014 
Location (of Interaction): Kingfisher Bay resort 
Beachfront 

Time (of Interaction 24hrs): 16:45 
Reporting Officer/s details: 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults             1 
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged No 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: (KBRV ranger) 
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   resort staff      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: At approx. 16:45, from KBRV contacted ranger 7028018 to notify him 
that an untagged dingo was moving in amoungst visitors watching the sunset. The dingo was being 
encouraged and approaching people on the beach. KBRV staff were monitoring and briefing visitors on 
how to behave safely around dingoes.   
 
 
Additional comments and notes: A number of untagged juvenile/sub adults are regularaly seen on the 
beach directly outside the KBRV resort.  
 
 
Action taken: Interaction reported to rangers by KBRV staff. Report generated and circulated. 
 
 
Proposed further action: Contiue monitoring the area. Carry out capture and tagging procedures of 
commonly seen dingoes around KBRV. 
 
 
Faxed/emailed date:  13/07/2014                               Reporting Officers details:  7028018 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified Dingo 
 
Date (of Interaction): 15Jul14 
Location (of Interaction): Woralie CZ 

Time (of Interaction 24hrs): 1230 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Well set up camp regular campers 
 
 
 
Detailed report of events: At approx. 1230 was in her camp at Woralie CZ when a dingo was 
seen in their camp. attempted to chase the dingo away however the dingo took little notice of her. 

called her husband who chased the dingo away. A short time later the dingo was seen sitting on 
the high ground behind the CZ watching their camp. Her husband chased the dingo away with a golf 
club. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: No identification was obtained, this site is the overlap between 
Awinya and Moon point pack 
 
 
 
 
 
Action taken: Interview conducted, report generated 
 
 
 
 
 
 
 
 
Proposed further action: Patrol and camper briefs. 
 
 
 
 
 
Faxed/emailed date:  23/7/14                                              Reporting Officers details:  
7027330 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified Dingo 
 
Date (of Interaction): 17/7/14 
Location (of Interaction): Dundubara Beachfront 

Time (of Interaction 24hrs): 1700 
Reporting Officer/s details: 7027130 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) When another fisherman 

arrived  
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address: St Kilda 
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureNo 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments Should have actively deterred the animal 
 
 
 
Detailed report of events: was surf fishing, as he moved down the beach an unidentified dingo 
followed him closely and into the water as he fished. The dingo continued to loiter around untill another 
fisherman arrived.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: There are several sub adults from the Dundubara pack that are 
displaying high levels of habituation. 
 
 
 
 
 
Action taken: Interview conducted, report generated. 
 
 
 
 
 
 
 
 
Proposed further action: Monitor area, continue patrolling and briefing regime 
 
 
 
 
 
Faxed/emailed date:  23/7/14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified Tagged 
Male 
 
Date (of Interaction): 17Jul14 
Location (of Interaction): Coolooli CZ 

Time (of Interaction 24hrs): 1630
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
       Tinned fish and milk 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) 5m        
  damaging property (specify) Sleeping mat 
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age 1             

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Left 
    Details: No ID given 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #:
Age: 53 
 
Name:       
Address:       
Phone #:       
Age:       
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  lunging (attempting to nip or bite) 
Questionnaire:                  Specify visitor type   camper      

Did they receive an information pack with their permits No 
Did they read the Dingo BrochureNo 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments Had read the Fraser Island brochure (online permit) did not think a dingo would rip a 
tent. Food was left in the tent.  
 
 
 
Detailed report of events: caught the barge on foot at approx. 0900 walked down to the 
Coolooli CZ and set up his camp. Latter in the afternoon walked up the beach past the barge 
landing to the entrance to the inland track and read the signage there. While there he sighted a dingo in 
the area so he picked up a stick and walked on the in road and turned left toward the CZ. As he started 
toward the CZ he noticed a dingo following him within 5m. The dingo lost interest and followed some 
vehicles out the out track to the beach. walked to the CZ without seeing a dingo, on arrival at the 
CZ the same dingo he had seen earlier appeared from the bush along the beachfront. walked to 
his tent and found it had been torn open, his gear spread out and his food stolen. The dingo followed 
him to his camp and stayed in the area. The dingo was identified as tagged in the left ear only. 
attempted to chase the dingo away but it only retreated a short distance and returned. No other attempts 
were made to deter the animal for fear of making the animal aggressive. At 1730 began ringing 
for assistance. At approx. 1800 the dingo lost interest and was believed to have left the area however it 
was dark and could not be sure it was not still in the area. Fraser Island police picked up 
and transported him to Eurong base where he stayed the night.  
 
 
 
 
 
Additional comments and notes: Food was left in the tent and the camping gear had a well used 
smell. was surprised that a dingo would rip a tent and was concerned for his safety especially at 
night. was still visibly shaken by the incident. The Eurong sub adults have been sighted in the 
area regularly and on inspection of the vacated camping area it was evident that multiple dingoes had 
been through the area during the night. 
 
 
 
 
 
Action taken: SR informed, interview conducted, camper returned to barge and seen off, patrol 
conducted of area. 
 
 
 
 
 
Proposed further action: Increase this areas patrols, a stronger message may be required for hikers. 
 
 
 
 
 
Faxed/emailed date:  18/7/14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):        
 

 Photo 2.
Description (who took 
photo/when):        
 

 Photo 3.
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unknown 
 
Date (of Interaction): 18-19/07/14 
Location (of Interaction): Waddy Point Beach 
Front C.Z. 

Time (of Interaction 24hrs): Overnight 
Reporting Officer/s details: 7027940 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
       Food From Esky 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             X 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits No 
Did they read the Dingo BrochureNo 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments The campers said they have been coming to Fraser Island for the past 15 years and 
are aware of food security. I gave them the Fraser Island and dingo brochures with the breifings.  
 
 
 
Detailed report of events: A large group of campers reported that the morning of the 19/07/14 when 
they woke up they noticed that there esky had been dragged a short distance away from there camp and 
was open with food missing, and dingo tracks all round the area. The campers are unsure on how the 
dingo/es got the esky open. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: Report conducted 
 
 
 
 
 
 
 
 
Proposed further action: Continue to moniter and briefings in this area.  
 
 
 
 
 
Faxed/emailed date:  19/07/14                                              Reporting Officers details:  
7027940 
 Release
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: BPuB13M 
 
Date (of Interaction): 20Jul14 
Location (of Interaction): Gurruman CZ 

Time (of Interaction 24hrs): 1700 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) 2m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: BPuB13M 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   click to select      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: While on patrol 7027330 saw a dingo loitering around a fisherman, the dingo 
followed the fisherman into the water untill it was chest deep in the water. The dingo was positively 
identified as BPuB13M. At this point the dingo was chased off by the ranger. The fisherman was then 
informed to actively deter dingoes. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: This dingo is a member of the Dundubara pack recently tagged and 
is displaying high levels of habituation. 
 
 
 
 
 
Action taken: Report generated 
 
 
 
 
 
 
 
 
Proposed further action: Monitor this animal, continue patrolling and briefing regime 
 
 
 
 
 
Faxed/emailed date:  23/7/14                                              Reporting Officers details:  
7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified 
 
Date (of Interaction): 26 July 2014 
Location (of Interaction): Sth Eli Creek 

Time (of Interaction 24hrs): Between 1230 - 13:00 
Reporting Officer/s details: 7026466 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Didn't move off 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Not taken as observers didn't stop. 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Witness to interaction 
Name: 
Address: logan - Brisbane 
Phone #: 
email -
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   Proffessional fisher/wormer      

Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments       
 
 
 
Detailed report of events: On or around 9:30 am called the Eurong QPWS Ranger station 
and spoke to ranger 7026466 regarding an alleged feeding incident he observed in the 26th July 2014. 
 

and his family, including his son driving in a separate vehcile in convoy were travelling 
north along the Eastern beach between Happy Valley and Eli creek within the 40km zone when they 
observed the following interaction.  
 
They were following at approximately 150 metres, a Landrover with registration plates 

partly obscured by over the sides of the 
vehicle. This led to believe this was a local or proffessional fisherman.  
 
The vehicle stopped at a dingo approximately half way between the high and low tide mark in the middle 
of the beach. 
 
A man described as got out of the drivers side door, then got 
something out of the back of the vehicle tray and took approximately 2 steps towards the dingo before 
throwing the obtained object towards the dingo that stood approximately ~20 feet away. The driver then 
returned to the vehicle. 
 
The dingo had not moved at that stage untill the unidentified item landed in front of it. The dingo took 2 
steps towards the object, lowered itself to the sand and proceeded to mouth or chew whatever it was 
that was thrown by the described driver. A gender of the dingo could not be ascertained because the 
dingo was lyng on the ground when convoy passed. 
 

recalls communicating with his son via 2-way radio as they passed and stating "did you just 
see that" refferring to the alleged feeding of a dingo. 
 
They were not able to obtain photographs and did not look to see if the dingo was tagged due to 
watching the fisherman's actions. 
 
 
Additional comments and notes: stated he did not have any numbers or contacts to call the 
department about this incident untill this morning. stated he has knowledge of the Landcruiser 
series he observed therefore the vehcicle details should be accurate.  

 
Action taken: Report taken and advised that the matter may be taken further. He has stated 
that he can be contacted if the compliance matter is to be taken further. 
 
 
 
Proposed further action: Referred to compliance officer due to the matter being a suspected Pro 
fisherman. 
 
 
Faxed/emailed date:  7 Aug 2014                               Reporting Officers details:  7026466 
 
  

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacysch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

15-166 File C 476 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 1 

Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified 
 
Date (of Interaction): 28/7/14 
Location (of Interaction): Dundubara 

Time (of Interaction 24hrs): 0530-1845 
Reporting Officer/s details: 7027202 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) 5-10mtr        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     5 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults             2 
Sub adults             3 
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged No 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 7027202 
Address: Dundubara 
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   QPWS employee      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments       
 
 
 
Detailed report of events: While fishing to the north of dundubara and a pack of five dingoes hung 
around the vehicle and ourselves, at times four dingoes would sit 30 metres away and appeared to send 
one dingo in to check us out, it would stand five to ten metres away standing still with it's tail down and 
ears flat. We constantly tried to move them on but they were persistant and continued to send in the 
single dingo which appeared to be a sub adult. Another fisherman turned up but was driven off and gave 
up after the constant loitering of these dingoes. We had a chat with him and he said he was going home 
as he'd had enough of the dingoes. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: These dingoes are persistant and have the potential to be a problem 
once the tailor fisherman arrive. 
 
 
 
 
 
Action taken: report generated 
 
 
 
 
 
 
 
 
Proposed further action: Continued briefings and patrols and making fisherman aware of their 
obligation regarding storage and personal safety. 
 
 
 
 
 

Release
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Faxed/emailed date:  29/7/14                                              Reporting Officers details:  
7027202 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
 

 

15-166 File C 480 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 1 

Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified 
 
Date (of Interaction): 3/8/14 
Location (of Interaction): Gabala C.Z 

Time (of Interaction 24hrs): During the day 
Reporting Officer/s details: 7028122 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people 
nearby) 

  stealing food or property (specify) Obtained 
lollies from tent 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Unknown 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #: 
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits click to select 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments Unsecured food left in the tent. 
 
 
 
Detailed report of events: On the 3/8/14 returned to his campsite at Gabala C.Z to find 
that his tent had been ripped open and food taken from inside the tent.  
 
 
Additional comments and notes: Initially spoke to a mother looking after numerous children by herself 
on the importance of dingo safety on 7/8/14. Then inspected camp site and discussed the importance of 
removing food from the camp cupboards to a more secure location. The campers showed us the rip in 
the tent. The dingo safety briefing was then delivered to the campers.   
 
 
Action taken: Advised Dingo ranger of interaction, completed interaction report. 
 
 
Proposed further action: Continue patrols and briefings of campers and visitors in this area.  Continue 
monitoring dingo behaviour in this area. 
 
 
Faxed/emailed date:  08/08/2014                               Reporting Officers details:  7028122 
 
 
  

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Dingo Interaction Report Form Insert Code: C Dingo ID: BRG13m 
 
Date (of Interaction): 08/08/2014 
Location (of Interaction): Oaks Beachfront 

Time (of Interaction 24hrs): 12:40 
Reporting Officer/s details: 7028018, 7028020 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes Taking selfie 

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) When QG approached and 

beeped horn 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: BRG13m 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   unknown      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: While observing BRG13m and GGPi13f rangers 7028018 and 7028020 saw 
a white 4wd vehicle stop next to BRG13m.  A male passenger got out of the vehicle and walked towards 
the dingo taking photos on his phone. 
 
The visitor proceeded to crouch down with his back to the dingo and attempt to take a 'selfie'.  The dingo 
started to walk away and the visitor appeared to encourage it to return.  7028018 & 7028020 drove 
towards them (taking photos).  As the rangers got close they beeped the horn of the car which startled 
the dingo who then walked away. 
 
7028018 spoke to the visitor and briefed him on dingo safety.  The visitor said "it was ok as he hadn’t 
touched the dingo".  They were informed that they had to remain in the car to take any future photos of 
the dingoes. 
 
 
 
Additional comments and notes: BRG13m & GGPi13f have been involved in numerous Code C, Code 
D & Code E interactions. 
 
 
 
Action taken: Visitor briefed.  Dingoes monitored until they left the area.  Continued patrol of eastern 
beach. 
 
 
 
Proposed further action: Continue patrols and briefings, including extra patrols being conducted 
around Eli Creek.  Continue closure of camping areas between Poyungan Rocks and Eli Creek. 
 
 
 
Faxed/emailed date:  08/08/2014                 Reporting Officers details:  7028018 & 7028020 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  BRG13m being 
encouraged, Oaks BF, taken by 
7028020 

 

Photo 2. 
Description (who took 
photo/when):  BRG13m being 
encouraged, Oaks BF, taken by 
7028020 
 

 

Photo 3. 
Description (who took 
photo/when):  BRG13m being 
encouraged, Oaks BF, taken by 
7028020 (cropped) 
 

 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Dingo Interaction Report Form Insert Code: C  Dingo ID: unknown  
 
Date (of Interaction): 10-11 August 2014 
Location (of Interaction): Eli Creek beach parking 
area (10m from creek, above high tide mark) 

Time (of Interaction 24hrs): before 0800hrs 11/8 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 

X  being fed or encouraged (buried prawn heads) 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 

X  other (specify) assumed when they had 
consumed some prawns or lost interest 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             X 

 
c. Were the dingo(s) tagged unknown 
    Details:       
 
d. Which ears were tagged unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Not sighted 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Prawn heads removed by QPWS rangers 
7026804, 7027146 and 7027334 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   unknown      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: We bagged up two bags of large, cooked prawn heads (estimated weight 1-
2kg) which had been buried in the Eli Creek parking area (within 10m of the creek) and subsequently 
dug up by a dingo/es (as evidenced by scattered nature and paw prints in sand). Unsure as to quantity 
consumed by dingo/es. Prawns were fresh (not odorous or discoloured) suggesting that they were 
buried within 24 hours prior to our removing them. The large amount of prawn heads suggests that 
possibly a large group of people had consumed them and were responsible for their incorrect disposal 
above the high tide mark. 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Other incidents of fish/fish waste or similar disposal at Eli Creek 
have been noted recently. 
 
 
 
 
 
Action taken: Bagged and removed prawn heads for disposal at waste transfer station. 
 
 
 
 
 
 
 
 
Proposed further action: Monitor, investigate options for appropriate surveillance of this area 
 
 
 
 
 
Faxed/emailed date:  11August2014                          Reporting Officers details:  7026804 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: 3-4 unidentified dingoes 
 
Date (of Interaction): 11 August 2014 
Location (of Interaction): The Oaks housing 
precinct – southernmost house 

Time (of Interaction 24hrs): 2030hrs 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 
X  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 

X  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

X  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     3-4 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             3-4 

 
c. Were the dingo(s) tagged unknown 
    Details:       
 
d. Which ears were tagged unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   private accommodation users      
Did they receive an information pack with their permits unknown 
Did they read the Dingo Brochure unknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) unknown 
Comments       
 
 
 
Detailed report of events: Guest staying at rental accommodation reported 3-4 dingoes loitering 
around the southernmost house in the Oaks area. The unidentified dingoes (no genders or tag 
descriptions able to be provided) were reportedly loitering around under the deck of the house and at the 
base of the stairs onto the deck. The dingoes presence was also observed by 6 other guests. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: No photos available 
 
 
 
 
 
Action taken: Reported 
 
 
 
 
 
 
 
 
Proposed further action: Monitor local area to ascertain identification, consider installation of trail 
cameras locally to aid this. 
 
 
 
 
 
Faxed/emailed date:  12August2014                    Reporting Officers details:  7026804 
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Dingo Interaction Report Form Insert Code: C Dingo ID: BRG13m 
 
Date (of Interaction): 11 August 2014 
Location (of Interaction): Beachfront, northern 
end of Guluri camping zone 

Time (of Interaction 24hrs): 0848-0858hrs 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 
X  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 

X  other (specify) wary of QG ute 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged yes 
    Details: BRG13m (confirmed) 
 
d. Which ears were tagged left 
    Details: refer attached photos 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Reported by - Rego 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits unknown 
Did they read the Dingo Brochureunknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) yes 
Comments Were vigilant with bait and catch security, but weren’t actively discouraging dingo 
 
 
 
Detailed report of events: Whilst on patrol along the beach between Happy Valley and Eli Creek, I 
observed a dingo (identified as BRG13m through tag in left ear – refer photos) lying behind some 
fishers. When we pulled up closer in our QG ute, BRG13m stood up and sauntered off, wary but also 
curious of the QG. I spoke to one of the fishermen, and he reported that BRG13m had been present for 
approximately ten minutes, but had not stolen anything nor acted aggressively.  
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Fisherman also reported that two vehicles had earlier driven at 
BRG13m in an attempt to ‘run it over’. Incident was also witnessed by Air Fraser ground crew who 
texted ranger 7026466 “2 white southbound utes one with canopy and both have rods just covered a 
dingo with sand and chased it down the beach at Happy Valley 15 minutes ago”. No regos or other 
vehicle descriptions provided. I drove south along beach but did not encounter vehicles matching these 
descriptions. 
 
 
 
 
 
Action taken: Reported, spoke to fisherman. 
 
 
 
 
 
 
 
 
Proposed further action: Continue patrolling and opportunistic breifings as required 
 
 
 
 
 
Faxed/emailed date:  11August2014                 Reporting Officers details:  7026804 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who 
took photo/when):  
Initial observation – 
note dingo behind 
fishers 

 

Photo 2. 
Description (who 
took photo/when):  
BRG13m moves 
away past QG ute 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photo 3. 
Description (who 
took photo/when):  
BRG13m moves 
away past QG ute 
 

 
 

 

BRG13m moves away past QG ute 

BRG13m moves away past QG ute 
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Dingo Interaction Report Form Insert Code: C Dingo ID: PuGR13m 
 
Date (of Interaction): 11 August 2014 
Location (of Interaction): Beachfront Cornwells 
camping zone, 300m nth of group camp area 

Time (of Interaction 24hrs): 1150hrs 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 
X  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 

X  being fed or encouraged (live dart) 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged yes 
    Details: PuGR13m (confirmed) 
 
d. Which ears were tagged left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:see attached photos 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Chatswood 2067 
Phone #:
Age: 33 
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits no 
Did they read the Dingo Brochure no 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) no 
Comments Read information on ‘internet’ pre-visit, mostly about fishing (couldn’t specify which 
websites) 
 
 
 
Detailed report of events: Ranger 7028026 and myself dropped into a camp at Cornwells camping 
zone which had some food security concerns. No persons were present, so we left a notice for some 
food storage corrections and then drove onto the beach where we observed the following: 

 Dingo lying on the beach behind two cars and some people fishing, two persons (a male and female) at base of the 
foredune photographing dingo with a long-lensed camera. 

 I photographed the dingo in an attempt to ascertain its ear tag, and observed a small dart fish being thrown to the 
dingo by an unsighted person between the two cars. Ranger 7028026 also observed this action. Dingo identified as 
PuGR13m through tag in left ear. 

 Ranger 7028026 and I left our car, and I formally introduced myself to the two men and one woman present, outlining 
my observation of a fish being thrown to the dingo, and asked the group who could tell me about that. 

 Man made an admission to the effect of “Yeah, I did that”. Other male then queried us “So, you’re not allowed to feed 
dingoes at all?” We responded in the negative. The persons present, all of Asian descent, demonstrated that 
comprehension and use of the English language was not an impediment. 

 I asked the man who made the admission if he had read any information relating to Fraser Island before his trip and he 
stated that he had read information on the internet, but ‘mostly about fishing’. 

 I suggested to the man that information about dingoes and not feeding dingoes was more prevalent than information 
on fishing. 

 I asked the man if he had any identification on him, and he stated that it was back at the camp, so I said that we would 
go back to the camp to retrieve it. 

 I then went and spoke briefly to the male and female couple who had been photographing the dingo and they stated 
their anger and disbelief at what had unfolded. I provided this couple with my work email address as they offered to 
send me photographs of the dingo. 

 I returned to the alleged offender and told him that we would meet him back at his camp to obtain his identification. We 
had established that his camp was the same one with food security concerns as Ranger 7028026 identified the woman 
present with the two men fishing as being from that camp. 

 On his arrival at the camp, I asked the man if he had any justified reason for feeding the dingo, to which he replied “No, 
I just saw it sitting there and decided to throw it the fish.” 

 The man, identified as  claimed that he hadn’t seen any 
information about food security or not feeding dingoes and I pointed out to him that his group was camped opposite the 
Cornwells group camp area at the entrance to which is a sign visible from their camp regarding strapping food 
containers (artwork attached), as well as information appearing on barges, numerous signs across the island and at 
toilet blocks. 

 Ranger 7028026 ran through our camp food security concerns with and he agreed that we could take his 
rubbish bags for disposal. 

 I informed that the next course of action was to refer the matter to my supervisor and that the likely outcome 
was a fine or prosecution. asked if he would be notified by mail, and I confirmed that would be the case, 
usually within a fortnight. I stated to that he would be contacted via mobile phone if our legal team required 
further clarification. 

 then went back to the beach to retrieve a car for securing food in, as per our instructions. We waited at the 
camp to ensure that the food was attended until this time. When the car arrived at the camp, I recorded the camping 
tag details as “  booking number  12 persons, 10-15 August 2014.” 

 
Additional comments and notes: Reported to A/SR Fraser Island and RIC NRM and dingo rangers on 
patrol to Eli Creek – Happy Valley area. Other photos from witnesses will be provided once received. 
 
Action taken: Formal interview conducted. Email address provided to witnesses to provide photos. 
 
 
Proposed further action: Investigating support for prosecution rather than an on the spot fine. 
 
Faxed/emailed date:  11August2014                      Reporting Officers details:  7026804 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Descriptio
n (who took 
photo/when):  
Artwork from 
sign at 
Cornwells 
group area 

 

Photo 2. 
Descriptio
n (who took 
photo/when):  
Initial 
observation 
Pre-feeding 
7026804 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

15-166 File C 497 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 4 

 

Photo 3. 
Descriptio
n (who took 
photo/when):  
Pre-feeding 
7026804 
 

    
 

   

Both photos to 
left taken post 
feeding, but 
before speaking 
to witnessing 
couple 

PuGR13m walks away with dart in 
mouth (photo taken from QG) 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Dingo Interaction Report Form Insert Code: C Dingo ID: GBW11m, BRG13m & 
BGB01f 
 
Date (of Interaction): 13/08/2014 
Location (of Interaction): Eli Creek Beachfront 

Time (of Interaction 24hrs): Approx 06:30 
Reporting Officer/s details: 7028020, 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans   

present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people          
nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or      

unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     4 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults 1 1       
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes - all dingo(s)  
    Details: GBW11m, BRG13m, BGB01f & 
GGPi13f (not involved in interaction) 
 
d. Which ears were tagged click to select 
    Details: GBW11m & BRG13m - Left 
BGB01f - riht 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   QPWS employee      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Whilst on patrol at approx 06:30 rangers 7028020 and 7027330 observed a 
group of fishermen chasing two dingoes and throwing sand at them on the northern side of Eli Creek.  
As the rangers approached they could see that two dingoes were fighting with a third dingo in the surf. 
The fishermen finally chased away two male dingoes (identified as GBW11m & RBG13m) by yelling at 
them and throwing sand.  The female dingo who was walking out of the surf was identified as BGB01f. 
The fishermen said that they had stopped as they thought the two male dingoes were going to kill the 
female and wanted to stop them. 
Once the male dingoes had walked away BGB01f emerged from the surf and stood very close to the 
fishermen and hid under their car until the two male dingoes were out of sight. 
As the two male dingoes headed south along the beach GGPi13f appeared from behind the dunes and 
joined the group.  The three dingoes were excited - playing, mouthing and licking each other before 
heading off into the dunes. 
BGB01f was observed scavenging at the waters edge before heading into the dunes. 
 
 
 
Additional comments and notes: GBW11m, BRG13m & GGPi13f were tracked by the rangers to the 
southern side of the creek where they were wary of the QG (not coming within 15m of the vehicle) and 
were observed pulling a fish frame from a hole, taking it up to the dunes and dropping it without eating it.  
They soon headed off into the dune vegetation and were lost from sight. 
 
 
 
Action taken: Fishermen spoken to regarding the interaction.  Observations made of BGB01f.  RIC 
NRM notified. 
 
 
 
Proposed further action: Continue patrols in this area, including briefings of campers & fishermen.  
Continue closure of campzones between Poyungan & Eli Ck  
 
 
 
Faxed/emailed date:  13/08/14                               Reporting Officers details:  7028020 
 
 Release
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Dingo Interaction Report Form Insert Code: C Dingo ID: unidentified dingo 
 
Date (of Interaction): 13 August 2014 
Location (of Interaction): FI Beach Houses - 
Eurong Second Valley inside fenceline 

Time (of Interaction 24hrs): 1830hrs 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line Eurong 
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) when coralled by manager, 

not sure if/how it's left the fenced area 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:"Larger but not an alpha" 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: FI Beach Houses manager 
Address: Left message at Eurong office 
Phone #: 4127 9205 
Age:       
 
Name: Reported direct to QPWS by QPS 
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   resort staff      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Initial report received from QPS 1914hrs who had been advised by FI Beach 
Resort manager of the presence of a dingo within the Eurong fenceline. I spoke to SR FI and made a 
determination not to immediately respond due to darkness and risk of making dingo wary of rangers 
(and therefore complicating herding efforts during daylight hours). FI Beach House manager left 
message on Eurong office answering service at 1837hrs (retrieved at 0830hrs 13/08/14). 
I returned call to FI Beach Houses manager and he advised of the following: 
Unidentified dingo (unsure of gender or if tagged) observed down 'First Avenue' (first row of houses) and 
then followed into 'Second Avenue' (second row of houses) where, following consumption of something 
outside house 23 (manager thought that item may have been a frog) it entered an enclosed area below 
a house, effectively cornering itself with the manager blocking the only apparent entrance/exit. The dingo 
apparently became frantic at this point and has fled underneath the fence railing (which the manager 
had not thought possible). Dingo was not sighted again after fleeing. Manager made an effort to notify all 
of their guests of the presence of a dingo within the fenced area, due to the high number having children 
with them. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: QPWS staff sweep of the area will occur if further sightings of a 
dingo within the fence are confirmed, as dingo may have self-exited overnight. 
 
 
 
 
 
Action taken: I deployed to Eurong fenced area at 0615hrs 14/8/2104 to investigate, checking grids and 
gates for evidence of entry/exit. Dingo prints were located on the outside of the Second Valley front grid 
and between the Eurong roundabout and Eurong rear grid/pedestrian gate (it was evident that the dingo 
was investigating options for exiting). I contacted Eurong Beach Resort reception to advise that I needed 
to be called in the event of a sighting, and a crew of rangers was deployed to remove sand from the 
Eurong front and rear grids (with the aid of CAT loader) and to complete a full fenceline inspection. 
There was no evidence to suggest that a dingo had entered via a grid or propped/unsecured gate. 
Contractor has been contacted for grid pump out to base of grid to provide more time between required 
maintenance. Release
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Proposed further action: Monitor area, trap and tag as required, respond to further reports of dingo 
within fenceline as required.  
 
 
 
 
 
Faxed/emailed date:  14August2014                               Reporting Officers details:  
7026804 
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Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  0630hrs 14/08/14; 
View back to Eurong roundabout 
[7026804] 

 

Photo 2. 
Description (who took 
photo/when):  Close up of above 
[7026804] 
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 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified Male  
 
Date (of Interaction): 15/8/14 
Location (of Interaction): Maheno Shipwreck 

Time (of Interaction 24hrs): 1015 
Reporting Officer/s details: 7027816 / 7027130 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) When QG's approched to take 

photos 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults 1             
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Left 
    Details : White / Blue discoloured tag 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:black patch on mid tail 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name: Fishermen & tourists 
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type         
Did they receive an information pack with their permits       
Did they read the Dingo Brochure       
Did the people follow ‘dingo safe’ messaging? (Ranger to assess)        
Comments       
 
 
 
Detailed report of events: Whislt on parol 7027816 & 7027130 can across a male dingo lying on the 
middle of the beach, close to fishermen and other tourists. Dingo was scared away as we approached to 
take photos from the vehicle to get a positive identification. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: 7027330 arrived also, as we where getting the photos. 
 
 
 
 
 
Action taken: incident report, aim to id dingo. 
 
 
 
 
 
 
 
 
Proposed further action: Continued briefings and patrols 
 
 
 
 
 
Faxed/emailed date:                                                     Reporting Officers details:  
7027816 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Descriptio
n (who took 
photo/when):  
7027816 1015 
Other vehicle 
outside 
photo to left 
side. 
 

Photo 2. 
Descriptio
n (who took 
photo/when):  
7027816 1015 
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 Photo 3. 
Descriptio
n (who took 
photo/when):  
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Dingo Interaction Report Form Insert Code: C Dingo ID: BWPi13f + two 
unidentified  males 
 
Date (of Interaction): 20 August 2014 
Location (of Interaction): Beachfront Poyungan 
Rocks 

Time (of Interaction 24hrs): 0900hrs 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) within 5m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) stole fish / lost interest 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     3 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults       1       
Juvenile                   
Unknown Age 2             

 
c. Were the dingo(s) tagged 
No -not all dingo(s) (detail) 
    Details: BWPi13f confirmed, other two male 
dingoes unsure if tagged 
 
d. Which ears were tagged Right  
    Details: BWPi13f 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Witnessed by 
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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  lunging (attempting to nip or bite) 
Questionnaire:                  Specify visitor type   Independant      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments Fish catch obviously wasn't secure 
 
 
 
Detailed report of events: Local resident / accommodation onsite manager rang to 
advise of "dingoes harassing fishermen" out front of Poyungan Rocks. A female dingo with a "Pink, 
White and darker coloured ear tag" (confirmed by responding dingo ranger as BWPi13f in area shortly 
after interaction) and two unidentified males approached fishermen from the south, headed north but 
then turned around and headed back towards the fishermen again. One of the dingoes was observed 
running up to a bucket and stealing an unsecured fish from it. The dingoes weren't discouraged easily, 
and were loitering within 5m of fishermen, before eventually losing interest and moving on. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Dingo ranger 7028018 attended area within 10 minutes of report 
being phoned through - observed BWPi13f in area (photo attached) but no other dingoes sighted. 
 
 
 
 
 
Action taken: Dingo ranger responded - attended scene 
 
 
 
 
 
Proposed further action: Monitor area, increase education at rental accommodations, trap and tag as 
required 
 
 
 
Faxed/emailed date:  20August2014                               Reporting Officers details:  
7026804 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

Photo 1. 
Descript
ion (who 
took 
photo/whe
n):  
7028018 
on 
response 
 
BWPi13f, 
condition 
suggests 
may have 
had a 
litter 

 Photo 2. 
Descript
ion (who 
took 
photo/whe
n):        
 

 

15-166 File C 512 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 1 

Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified tagged 
male 
 
Date (of Interaction): 21/08/14 
Location (of Interaction): Middle Rocks 
boardwalk 

Time (of Interaction 24hrs): 0800 
Reporting Officer/s details: 7027848 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) 5m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 7027848 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   QPWS employee      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: I was walking alone along Middle Rocks boardwalk at about 8.00am picking 
up rubbish. I noticed a dingo approximately 25m ahead of me with his head down sniffing at something, 
when he noticed me the dingo ran towards me. I had a long rubbish "grabber" in my hand and I swung it 
in the air and yelled at the dingo, it came within five metres and then backed off. I noticed it was a sub 
adult, male dingo with an ear tag, but I could not ascertain the colours. I went on with my work and the 
dingo kept his distance all the time watching me with his tail up, possibly dominant testing me. I realised 
after a while that the dingo was not going to leave the area so I started walking back to the QG parked 
outside the Middle Rocks toilet block. As soon as I turned to walk the dingo ran towards me from about 
20 m away and I turned to face him and yelled at the dingo, he came within about 5m moving side to 
side and the dingo then ran off up the hill.   
 
 
 
Additional comments and notes: No other vistitors were at risk as there was no one on the boardwalk 
and no cars were in the car park. 
 
 
 
Action taken: Report generated and circulated. Dingo ranger informed. 
 
 
 
Proposed further action: Continue visitor briefings when in the area. 
 
 
 
Faxed/emailed date:  24/08/14                                      Reporting Officers details:  7027848 
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Dingo Interaction Report Form Insert Code: c Dingo ID: GY13m 
 
Date (of Interaction): 28.09.14 
Location (of Interaction): Sandy Cape Lighthouse 
gate  

Time (of Interaction 24hrs): 1400 
Reporting Officer/s details: 7027118 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) Coming within 3m   
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)   

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: Green Yellow - Left ear 
 
d. Which ears were tagged Left 
    Details: GY13m 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name
Address: Sandy Cape Volunteer 
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   QPWS employee      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: Volunteer of Sandy Cape Lighthouse) was oiling the Lighthouse gate 
signs with left the sign to head towards the 
front of their vehicle when noticed a dingo within 3m of looking directly at 
gained the attention of  and they all got in the vehicle. It was when the was in 
the vehicle that the dingo lost interest in the situation and moved away on its own accord. 
 
 
 
Additional comments and notes:   
 
 
 
Action taken: Report generated and circulated.  
 
 
 
Proposed further action: Monitor dingo activity in the sandy cape area - as this individual is originally 
from the Eurong area. Brief camps in area. 
 
 
 
Faxed/emailed date:  1.9.14                               Reporting Officers details:  7027118 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

Photo 1. 
Descripti
on (who 
took 
photo/when
): 
Beach in 
front of 
lighthouse 
gate – 
soon after 
interaction 
occurred. 
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Dingo Interaction Report Form Insert Code: C Dingo ID: PuGR13m 
 
Date (of Interaction): 31.08.2014 
Location (of Interaction): Beach In front of Waddy 
Lodge Fraser Island 

Time (of Interaction 24hrs): 1205 
Reporting Officer/s details: 7027118 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) continued to loiter in the area 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: Green Tag (PuGR13m-delaminated to 
all Green) 
 
d. Which ears were tagged Left 
    Details: Green Tag (PuGR13m-delaminated to 
all Green) 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Photo's below  
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Ranger 7027118 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

Release
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Questionnaire:                  Specify visitor type   click to select      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: PuGR13m was loitering on the beach in front of Waddy lodge - fishermen 
nearby.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: The ear tag of PuGR13m has delaminated to green on both the 
spike (outside) and button (inside) of the tag. Photographs attached below show this.  
 
PuGR13m was originally trapped and tagged at one tree rocks.    
 
 
 
 
 
Action taken: Report generated and circulated 
 
 
 
 
 
 
 
 
Proposed further action: Monitor dingo activity in the area, brief visitors in the area.  
 
 
 
 
 
Faxed/emailed date:  02.09.2014                               Reporting Officers details:  7027118 
 
 

Release
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Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 
Photo 1. Taken By 7027118_PuGR13m Loitering on 
beach infront of Waddy Lodge. Note: Outer tag 
delaminated to base colour - Green 
 
 

 
Photo 2. Taken By 7027118_PuGR13m Loitering on 
beach infront of Waddy Lodge. Note: Outer tag 
delaminated to base colour - Green 
 

 
Photo 3.Taken By 7027118_PuGR13m 
Loitering on beach infront of Waddy Lodge. 
Note: Inner tag delaminated to base colour - Green  
 

 
Photo 4.Taken when originally tagged on the 
23/02/2014. This photo shows the green spike and 
button. 

 
 

 
 

 
Photo 5. PuGR13m_Photo of front paw markings - 
Taken when originally tagged on the 23/02/2014.  
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Dingo Interaction Report Form Insert Code: c Dingo ID: Unidentified Female 
 
Date (of Interaction): 31/08/14 
Location (of Interaction): K"Gari 

Time (of Interaction 24hrs): 1500 
Reporting Officer/s details: 7028595 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     click to select 
b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults       1       
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   click to select      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: At the time of the dingo appearance myself and a colleague were conducting 
a fence check at K'Gari. An unidentified female, adult dingo approached a personal access gate, looking 
around and sniffing around the gate at the rear of the property about a minute after we checked that 
gate. The dingo walked away calmly from us.    
 
 
Additional comments and notes:       
 
 
Action taken:       
 
 
Proposed further action:       
 
 
Faxed/emailed date:  09/09/14                                   Reporting Officers details:  7028595 
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Dingo Interaction Report Form Insert Code: C Dingo ID: GY13m 
 
Date (of Interaction): 1.9.14 
Location (of Interaction): Carree camping zone 
Sandy Cape 

Time (of Interaction 24hrs): 0725
Reporting Officer/s details: 7027118 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     click to select 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GY13m 
 
d. Which ears were tagged Left 
    Details: GY13m 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Sandy Cape Lighthouse Volunteer 
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   QPWS employee      

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: Whist driving past a camp in Caree camping zone noticed GY13m 
eating fish frames on the beach. GY13m then progressed up the beach to the vacant camp and grabbed 
an unidentified item from the camp table.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: took photographs of the animal - identified to be GY13m by 
ranger 7027118. Photographs below. 
 
 
 
 
 
Action taken: Report generated and circulated 
 
 
 
 
 
 
 
 
Proposed further action: Monitor dingo activity in the sandy cape area - as this individual is originally 
from the Eurong area. Brief camps in area. 
 
 
 
 
 
Faxed/emailed date:  1.9.14                               Reporting Officers details:  7027118 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

Photo 1. 
GY13m 
Taken by: 

_1.9
.1   In 
front of 
caree 
camp 
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Photo 2. 
GY13m 
taken by:  

1.9.14  In 
front of 
caree 
camp 
 

 
 
 
 
 
 
 
 
 
 
 
 
  

Photo 3. 
GY13m: 
Both 
pictures 
below 
taken by 
ranger 
7027118 
1.9.14 
@0816 
am. 
Between 
Caree c.z 
& Sandy 
cape 
lighthous
e gate. 
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Dingo Interaction Report Form Insert Code: c Dingo ID: Unknown 
 
Date (of Interaction): 02/09/2014 
Location (of Interaction): One Trees (Northern 
End) 

Time (of Interaction 24hrs): 10.00-16.00 
Reporting Officer/s details: 7028773 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify) clothing 
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     5 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults 2             
Sub adults       3       
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:old dog was mangy, young dogs were 
dark in colouration 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Grafton 
Phone #
Age: Adults 
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Had taken dingo safety message seriously and had an immaculate campsite despite 
the tent ripping  
 
 
 
Detailed report of events: Between 10am and 4pm Tuesday 2/9/2014 ound 
their tent ripped after coming back from a day trip. No food was in the tent however their clothes were 
scattered around the campsite. There had been 4-5 dingoes loitering around the area leading up to the 
incident. They couldn’t see if the dingoes were tagged however describe 1 adult male in good 
condition, 1 adult male in poor condition, and the other 2-3 Dingoes were female or young dingoes.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: Report generated and dingo ranger advised 
 
 
 
 
 
 
 
 
 
Proposed further action: Continued camper briefings and advise visitors on dingo issues within the 
area 
 
 
 
 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Faxed/emailed date:  09/09/2014                               Reporting Officers details:  7028773 
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Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Untagged 
 
Date (of Interaction): 2/9/14 
Location (of Interaction): Eli Creek 

Time (of Interaction 24hrs): AM 
Reporting Officer/s details: 7027202 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
       Shoe 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged No 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 1 Day Tour Participant 
Address: Not supplied 
Phone #:       
Age: Adult 
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   tour participant      
Did they receive an information pack with their permits No 
Did they read the Dingo BrochureNo 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: The photos were taken at Eli Creek where what appears to be a sub adult 
dingo stole a shoe from a man in a tour group, the dingo had been loitering around the area while the 
tour group was there, the dingo lost interest in the shoe and continued to loiter in the area. There were 
other tour operators there and from the advice I was given no one discouraged the dingo from loitering. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: The tour participant passed the photos and details onto me but 
chose to remain anonymous  
 
 
 
 
 
Action taken: report generated 
 
 
 
 
 
 
 
 
Proposed further action: Day use visitors to be advised to secure all items when walking up the creek. 
 
 
 
 
 
Faxed/emailed date:  02/09/2014                                              Reporting Officers details:  
7027202 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  Photos 
from tour participant 
2/9/14 
 

 

Photo 2. 
Description (who took 
photo/when):  Photos 
from tour participant 
2/9/14 
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Photo 3. 
Description (who took 
photo/when):  Photos 
from tour participant 
2/9/14 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Untagged Male 
 
Date (of Interaction): 5/09/2014 
Location (of Interaction): Eli Creek DUA 

Time (of Interaction 24hrs): 08:00 
Reporting Officer/s details: 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged No 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Mid-high right sock and low-mid left 
sock  
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Ranger 7028018 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   click to select      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Ranger 7028018, whilst patrolling the beach, noticed many fresh dingo 
tracks on the sand directly opposite the entry to the Eli Creek boardwalk.  
 
The dingo (untagged sub-adult male) then appeared in front of ranger 7028018, from the north of Eli 
Creek, and both the dingo and the ranger startled when they noticed each other. The dingo promptly ran 
away and sat in the dunes and watched.  
 
The dingo then stood up, walked onto the beach (whilst keeping a wary dinstance) and sat down on the 
sand watching the ranger. Ranger 7028018 photographed the dingo for identification purposes. 
 
The dingo coughed/barked, did a backflip and ran away into the vegetation.     
 
 
Additional comments and notes: The untagged sub-adult male dingo behaved mildly habituated but 
maintained a wary distance.   
 
 
Action taken: Photographs taken. Report generated and circulated. 
 
 
Proposed further action: Continue ranger patrols to and around the Eli Creek DUA to monitor dingo 
activity and to brief campers and visitors.  
 
 
Faxed/emailed date:  5/09/2014                               Reporting Officers details:  7028018 
 
 
 Photos  

 

Photo 1. 
Description (who took 
photo/when):  Untagged sub-
adult male dingo. Eli Creek 
5/09/2014 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified 
 
Date (of Interaction): 06/09/2014 
Location (of Interaction): Marloo cz 

Time (of Interaction 24hrs): 09:10 
Reporting Officer/s details: 7027202 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     click to select 
b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults             1 
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:dark colouration 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address: 
Phone #:
Age: Adult 
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: and his year old son had left there camp at 1100 and returned at 
1400 to find that the small tent his son had been using had been torn open along the screen and his 
clothes had been scattered about the camp. stated that all foodstuffs and rubbish were in the 
vehicle with him while they were away from camp. On inspection his camp was well maintained and all 
food and rubbish was secured. had read his information pack and was following dingo safe 
messaging 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Nearby campers had noticed a lean dark coloured dingo had been 
loitering in the vicinity for the past few days. 
 
 
 
 
 
Action taken: report generated and supervisor advised 
 
 
 
 
 
 
 
 
Proposed further action: Continued briefings and patrols 
 
 
 
 
 
Faxed/emailed date:  09/09/2014                                              Reporting Officers details:  

sch4p3( 3) Prejudice the protection of an individuals right to privacysch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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7028796 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified dingo 
 
Date (of Interaction): 14/09/14 
Location (of Interaction): Poyungan CZ 

Time (of Interaction 24hrs): 1300 - 1530 
Reporting Officer/s details: 7026936 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     click to select 
b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments Campers left chocolate and wraps inside their tent which has encouraged the dingo to 
enter. 
 
 
 
Detailed report of events: The were away from their camp between 1300 and 1530 on the 
14/9 and returned to find that their tent had been torn by a dingo in two places (see photo's below). They 
found that the dingoes had taken a block of chocolate and a packet of wraps that were stored in their 
tent. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: Campers were briefed on the correct storage requirements in order to prevent this 
happening. Report generated and circulated. 
 
 
 
 
 
 
 
 
Proposed further action: Continue dingo safety briefings in all camp zones.  
 
 
 
 
 
Faxed/emailed date:  16/9/14                               Reporting Officers details:  7026936 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  rip has been 
repaired with ductape 

 

Photo 2. 
Description:  Rip has been 
repaired with ductape 
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 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified dingo 
 
Date (of Interaction): 15/09/14 
Location (of Interaction): One tree rocks CZ 

Time (of Interaction 24hrs): 0830-1230 
Reporting Officer/s details: 7026936 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #: 
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: A phone call was received by ranger 7026936 at 1330 on the 15/9, from 

to report that a dingo had ripped into their tent while they were away from their 
camp. also reported that the dingo may have possibly consumed some of her partners Sleeping 
tablets. Ranger 7026936 went to meet with and at their camp immediately to gather details 
of the interaction. 
 
 Between 0830 and 1230 on the 15/9 returned to his camp where he found a dingo had ripped into 
his tent (see photos below). No food or rubbish was stored in the tent found that the dingo had 
chewn a box of his medication (sleeping tablets) and that three tablets were missing. No other items 
were missing from their tent. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: Interviews carried out. Report prepared. Extensive search of all trafficable places in the 
area was carried out in the case that a dingo may have become sick from consuming the medication. 
 
 
Proposed further action: Monitor trail camera footage in surrounding area to ensure resident dingoes 
are still present. 
 
 
 
 
 
Faxed/emailed date:  16/9/14                               Reporting Officers details:  7026936 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
sch4p3( 3) Prejudice the protection of an individuals right to privacysch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description:        

 

Photo 2. 
Description:        
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 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Untagged pup 
 
Date (of Interaction): Between 15-17th Sept 2014 
Location (of Interaction): Moon Point Road 

Time (of Interaction 24hrs): Day time 
Reporting Officer/s details: 7026466 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 

B) Habituated. 
  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes approached and 

picked up a pup. 
 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 

E) Dangerous. 
  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Was returned to the road and 

left. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult                   
Juvenile                   
Pup             1 
Unknown Age                   

 
c. Were the dingo(s) tagged No 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Person reporting: 
Name:
Address: Brisbane 
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   Independant      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments People involved could have either left animal alone or left water at a distance for it 
without interacting with it. 
 
 
 
Detailed report of events: Ranger 7026466 was advised of the following interaction on the 29th Sept 
2014 by who advised he had become aware of the interaction. 
 
The interaction occurred on the Moon Point Road. A dingo pup was observed on the road by visitors 
staying in Happy Valley who stopped, picked it up and, gave it water then returned it to the road and left. 
 
No other details were given regarding the people involved in the interaction.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: The Moon Point road is currently closed to unauthorised traffic. 
Interaction report delayed due to inaccess to the associated photograph.  
 
 
 
 
 
Action taken: Supplied information reported in interaction report. 
 
 
 
 
 
 
 
Proposed further action: Continue QPWS education regarding leaving wildlife alone. 
 
 
 
 
 
Faxed/emailed date:  16/10/20104                               Reporting Officers details:  7026466 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
 

 

Photo 1. 
Description (who 
took photo/when):  
Photograph 
contributed. 
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Dingo Interaction Report Form Insert Code: C Dingo ID: BWPi13f 
 
Date (of Interaction): 19/09/2014 
Location (of Interaction): Eurong Resort/Second 
Valley township 

Time (of Interaction 24hrs): 09:45 
Reporting Officer/s details: 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line Eurong 
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) herded out a fenceline 

vehicle gate 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults       1       
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: BWPi13f 
 
d. Which ears were tagged Right  
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 7028018 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   click to select      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 

 
Detailed report of events: Ranger 7026466 received a phone call from Eurong Resort management at 
approx. 07:45 notifying them of a dingo inside the Eurong fence. 
 
Ranger 7026466 contacted rangers 7028020 & 7028018 who responed by inspecting the reported dingo 
and confirmed the report.  
 
At approx. 09:45 BWPi13f was released through a vehicle access gate. 
 
 
Additional comments and notes: It is suspected that the dingo entered the dingo deterrent fence via 
the Eurong Resort beachside grid due to broken electrical wires.  
 
 
Action taken: NRM rangers notified. Resort and township stakeholders notified. Rangers released the 
dingo. All stakeholders notified of the release. Report generated and circulated. Fenceline and grids 
inspected. 
 
 
Proposed further action: Inspect the grids and fenceline in the following days for any signs of failure. 
 
 
Faxed/emailed date:  21/09/2014                               Reporting Officers details:  7028018 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified 
 
Date (of Interaction): 22.9.14 
Location (of Interaction): Ocean Lake Camping 
Zone 

Time (of Interaction 24hrs): 0900 
Reporting Officer/s details: 7028773 through 
7027118 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) <3m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:   
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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  lunging (attempting to nip or bite) 
Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: A lady and her daughter were walking back up to their camp at Ocean Lake 
c.z when a dingo prevented them from walking towards the camp. The dingo came close to her and her 
daughter. The lady yelled to her husband who came and chased the dingo away.   
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: Dingo ranger notified, report generated and circulated. 
 
 
 
 
 
 
 
 
Proposed further action: Monitor dingo activity levels in area, continue to educate all camps on dingo 
safety during September school holidays.  
 
 
 
 
 
Faxed/emailed date:  24.09.2014                               Reporting Officers details:  7028773 
through 7027118 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified Dingo 
 
Date (of Interaction): 22Sep14 
Location (of Interaction): Wyuna CZ 

Time (of Interaction 24hrs): 1300 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits No 
Did they read the Dingo BrochureNo 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Bucket was lidded and he chased the dingo off. 
 
 
 
Detailed report of events: was fishing in front of his camp when he noticed a dingo looking at his 
bait bucket. As headed back toward his bucket the dingo got the lid off the bucket. At this point 

chased the dingo away. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: was unable to give any identification of the dingo. PuGR13M 
has been sighted in the area. 
 
 
 
 
 
Action taken: Interview conducted, Ric NMU informed, area monitored, camps briefed. 
 
 
 
 
 
 
 
 
Proposed further action: Monitor animals in area, continue patrolling and briefing regime. 
 
 
 
 
 
Faxed/emailed date:  27/9/14                               Reporting Officers details:  7027330 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):  7026804 during 
interaction 
 

 Photo 2. 
Description (who took 
photo/when):  as above 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified 
 
Date (of Interaction): 22/9/14 
Location (of Interaction): Winnam CZ 

Time (of Interaction 24hrs): 1600 
Reporting Officer/s details: 7027146 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) 2m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     3 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                  
Unknown Age             3 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Nil reported 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:
Phone #:
Age: Adult 
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: reported a concerning dingo encounter to Rangers at the Dundubara 
base this morning at 0900hrs. 
She indicated: 
* her family had been camped at Winnam CZ for 2 nights commencing 
20th September 2014 
* At approximately 1600hrs she was sitting in a chair at their campsite with her partner (their daughter 
was in the tent) when a 'large' dingo ran into their camp area 
* the dingo appears to have be moving towards them with some intent to challenge them she believes 
* her partner jumped up when he noticed the dingo was a couple of metres away and grabbed a shovel 
to chase it away 
* as this dingo was running away she noticed that there were two other dingoes moving off from 
immediately behind their campsite - had not been aware of their presence prior to seeing them 
run off 
 
* stated that the dingo that approached them was distinctly larger and in better physical condition 
that the other two that accompanied it. 
* and her family elected to end their beach camping due to this event and their concern that a 
similar or more serious incident may occur - they continued camping at a privately managed fenced 
campground (Frasers at Cathedral - where they are currently staying until Friday) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: indicated that when her family arrived at this camping node 
they noticed a large amount of recent or fresh rubbish had been left there by a previous group of visitors. 
She collected this rubbish to dispose of it. It contained food packets and various scraps. 

also indicated that friends of theirs had been camped in that area a week or so prior and had had 
their tent ripped and food stolen from within the tent. 
 
 
 
 
 
Action taken: Completed report and emailed to distribution list. 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Proposed further action: Refer to NRM for action 
 
 
 
 
 
Faxed/emailed date:  24/9/14                                              Reporting Officers details:  
7027146 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified dingo 
 
Date (of Interaction): 23/9/14 
Location (of Interaction): Winnam CZ 

Time (of Interaction 24hrs): 0200 
Reporting Officer/s details: 7026936 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Campers were storing all of their food in a tent. 
 
 
 
Detailed report of events: At approximately 0200 on the 23/9 was awoken to a dingo ripping into a 
tent next to the one she was sleeping in. She scared the dingo off and found that tim tams and biscuits 
had been stolen. had stored all of her food in a separate tent to the one she was sleeping in. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: Camper was asked to store all food in their vehicle and to be vigilant with food and rubish 
security. 
 
 
 
 
 
 
 
 
Proposed further action: continue to brief campers between Poyungan rocks and Eli creek to ensure 
campers are storing food and rubbish correctly 
 
 
 
 
 
Faxed/emailed date:  1/10/14                               Reporting Officers details:  7026936 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: c Dingo ID: PuGR13M 
 
Date (of Interaction): 24Sep14 
Location (of Interaction): Wyuna CZ 

Time (of Interaction 24hrs): 1500 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: Green 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   click to select      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Ranger 7027330 was patrolling north through Wyuna CZ when a dingo was 
sighted in the surf 20m from some fishermen. The dingo then left the surf and trotted south at this point 
he was positively identified as PuGR13M. The dingo then noticed some children playing in a creek and 
changed direction toward them. Ranger 7027330 placed the vehicle between the children and the dingo 
and moved the dingo south out of the camp zone. 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: PuGR13M has been sighted in the area over recent days and is a 
known code D animal. 
 
 
 
 
 
Action taken: Briefed parents of children in creek, monitor animal untill it left area, Ric NMU informed, 
report generated 
 
 
 
 
 
 
 
 
Proposed further action: Monitor animal, continue patrolling and briefing regime 
 
 
 
 
 
Faxed/emailed date:  27/9/14                               Reporting Officers details:  7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):  7026804 during 
interaction 
 

 Photo 2. 
Description (who took 
photo/when):  as above 
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Dingo Interaction Report Form Insert Code: C Dingo ID: 2 x Unidentified dingo 
 
Date (of Interaction): 24/9/14 
Location (of Interaction): Breakers accom (yidney 
rocks) 

Time (of Interaction 24hrs): 1400 
Reporting Officer/s details: 7026936 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify) Thongs 
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             2 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   Independant      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: At 1400 on the 24/9 returned to their accomodation at Yidney rocks 
to find a dingo running off with on of their thongs. They said that there was a second dingo 20m from 
their house.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: Report generated 
 
 
 
 
 
 
 
 
Proposed further action: continue to brief campers between Poyungan rocks and Eli creek to ensure 
campers are storing food and rubbish correctly 
 
 
 
 
 
Faxed/emailed date:  1/10/14                               Reporting Officers details:  7026936 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: c Dingo ID: unknown 
 
Date (of Interaction): 25/09/14 
Location (of Interaction): Burad CZ 

Time (of Interaction 24hrs): 2300 
Reporting Officer/s details: 7028595 & 7027848 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)          
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults 1             
Sub adults             1 
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged 
No -not all dingo(s) (detail) 
    Details: one dingo had green tag 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address Bellbourie, 4070 
Brisbane 
Phone #:       
Age: 40 
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

15-166 File C 573 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 2 

Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: had an interaction with two dingoes, one being a male with green ear 
tag and the other unknown late on the night of the 25/09/14 in his Burad camping area. He was about to 
exit his large canvas tent to use the toilet when he was met by the dingoes in the front annex area. He 
did not notice them straight away but the dingoes were seemingly looking for food scraps etc and the 
dingoes came within two or three meters of got a fright and yelled at the dingoes and they 
left the camp ground.    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: The dingoes did not rip tent or annex and did not take food/rubbish. 
 
 
 
 
 
Action taken: Reported incident and continued patrols in camp zones. 
 
 
 
 
 
 
 
 
Proposed further action:       
 
 
 
 
 
Faxed/emailed date:  8/10/14                                              Reporting Officers details:  
7028595 & 7027848 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: PuGR13M 
 
Date (of Interaction): 26Sep14 
Location (of Interaction): Wyuna CZ 

Time (of Interaction 24hrs): 1115 
Reporting Officer/s details:       
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile 1             
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: Green tag 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   click to select      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Ranger 7027330 had just completed interviewing a camper involved in a 
code D interaction when a dingo approached the camping area from the west. The dingo was positivly 
as PuGR13M. The dingo was followed north through the camp zone to Kurnung creek were the animal 
went inland. 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: PuGR13M has been sighted in the area over the last week and is a 
known cade D animal 
 
 
 
 
 
Action taken: Dingo monitored untill it left CZ, campers briefed, Ric NMU informed, report generated. 
 
 
 
 
 
 
 
 
Proposed further action: Monitor animal, continue patrolling and briefing regime. 
 
 
 
 
 
Faxed/emailed date:  27/9/14                               Reporting Officers details:  7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  7026804 during 
interaction 
 

 Photo 2. 
Description (who took 
photo/when):  as above 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified dingo 
 
Date (of Interaction): 29/9/14 
Location (of Interaction): Guluri CZ 

Time (of Interaction 24hrs): 1830-1900 
Reporting Officer/s details: 7026936 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify) Thongs 
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: and his familly left their camp at Guluri for a half an hour Between 1830 
and 1900 on the 29/9. On their return they found that a dingo had ripped into their main tent shower tent 
and an inflatable mattress had been ripped (See photos below). According to toothpaste was the 
only thing inside the tent that may have attracted the dingo.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: Report generated 
 
 
 
 
 
 
 
 
Proposed further action: continue to brief campers between Poyungan rocks and Eli creek to ensure 
campers are storing food and rubbish correctly 
 
 
 
 
 
Faxed/emailed date:  1/10/14                               Reporting Officers details:  7026936 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):        

 

Photo 2. 
Description (who took 
photo/when):        
 

 

Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Red Tagged Male 
 
Date (of Interaction): 30/09/14 
Location (of Interaction): Happy Valley BF 

Time (of Interaction 24hrs): 07:00 
Reporting Officer/s details: 7028020 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) within 5m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Left 
    Details: Red tag 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   Independant      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Two adult and 1 teenage visitors were running along the beach in front of 
Happy Valley when they observed two dingoes. 
 
1 dingo, a red tagged male, approached the group to within 5m, and was extremely difficult to 
discourage. 
 
Eventually he moved off and the group returned to happy Valley. 
 
 
 
Additional comments and notes: Reported to Sailfish Resort managers and QPWS rangers.  A red 
tagged male has been involved in previous interactions in this area and has been identified as BWR13m 
through photos. 
 
 
 
Action taken: Interaction reported, visitors advised not to run/jog on the beach, report compiled and 
circulated. 
 
 
 
Proposed further action: Continue visitor briefings in this area.  Monitor behaviour of all dingoes in this 
area. 
 
 
 
Faxed/emailed date:  01/10/14                               Reporting Officers details:  7028020 
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Dingo Interaction Report Form Insert Code: C Dingo ID: 2 Untagged 
 
Date (of Interaction): 02/10/2014 
Location (of Interaction): Guluri CZ 

Time (of Interaction 24hrs): 17:30 
Reporting Officer/s details: 7028728 & 7027772 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults             2 
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged No 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments Ranger had provided dingo safety briefing earlier the same day 
 
 
 
Detailed report of events: and partner returned to their camp at the south end of Guluri 
camp zone to find two untagged sub-adult dingoes loitering at the camp. 
 
After yelling and chasing the dingoes away they found that their tent was ripped. 
 
No food was stored in the tent; however they mentioned that they had eaten in the tent earlier that day. 
 
 
 
Additional comments and notes: Details given to rangers 7028728 & 7027772 on 3/10/14 at Eli Creek 
at 12:30pm. 
 
 
 
Action taken: Report generated & circulated. 
 
 
 
Proposed further action: Continue dingo safety briefings in this area.  Monitor behaviour of all dingoes 
in visitor areas. 
 
 
 
Faxed/emailed date:  03/10/14                               Reporting Officers details:  7028728 & 
7027772 
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Dingo Interaction Report Form Insert Code: C Dingo ID: 13Green10m 
 
Date (of Interaction): 7/10/2014 
Location (of Interaction): Central Station DUA 

Time (of Interaction 24hrs): 10:58 
Reporting Officer/s details: 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Didn’t leave 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     4 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults 1             
Sub adults                   
Juvenile             3 
Unknown Age                   

 
c. Were the dingo(s) tagged No 
    Details: 13Green10m was identified by scars. 
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details: Scar above the left eye. 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 7028018 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   click to select      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Rangers 7028018 & 7028020 were walking through Central Station day use 
area and noticed 13Green10m lying on a walking track with 3 pups foraging near bye.  
 
 
Additional comments and notes: 13Green10m is a known habituated dingo that frequents the 
surrounding areas to Central Station.   
 
 
Action taken: 13Green10m identified. Report generated and circulated. 
 
 
Proposed further action: Continue monitoring the area and brief visitors and tour operators on the 
importance of dingo safe behaviour  
 
 
Faxed/emailed date:  7/10/2014                               Reporting Officers details:  7028018 
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Dingo Interaction Report Form Insert Code: c Dingo ID: unknown 
 
Date (of Interaction): 8/10/14 
Location (of Interaction): 500m South of Indian 
Head 

Time (of Interaction 24hrs): 0830 
Reporting Officer/s details: 7028595 & 7027848 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)          
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) when QG ute was driven 

towards the dingoes 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults 1             
Sub adults             1 
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:larger male dingo had dark markings on 
his back 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events:  My colleague and I (7027848, 7028595) were returning to base after 
completing some duties at Middle Rocks and we were heading south of Indian Head when we notice two 
dingoes ahead of us loitering around parked 4x4's. Fishermen were near by at the water's edge. The 
dingoes had their heads down, sniffing and obviously looking for food. The fishermen had informed us 
that they chased them away but the dingoes slowly made their way back after a while and were loitering. 
I instructed my colleague to drive towards the dingoes to get a photogragh and better ID of the dingoes 
but instead the two dingoes ran up and over the adjacent sand dunes.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: The dingoes did not take food/rubbish from the area. 
 
 
 
 
 
Action taken: Reported incident and continued patrols in camp zones. 
 
 
 
 
 
 
 
 
Proposed further action:       
 
 
 
 
 
Faxed/emailed date:  8/10/14                                              Reporting Officers details:  
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7028595 & 7027848 
 
 

15-166 File C 591 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 4 

Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified Dingo/es 
 
Date (of Interaction): 13/10/2014 
Location (of Interaction): Winnam CA 

Time (of Interaction 24hrs): 17:00 
Reporting Officer/s details: 7028018 & 7028728 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify) Tent 
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult                   
Juvenile                   
Pup                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details: Tent ripping dingo/es unknown 
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address
Phone #:       
Age:       
 
Name
Address: 
Phone #:       
Age:       
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments All food and most possessions were removed from the tent. 
 
 
 
Detailed report of events: On the 13/10/2014 at approx. 17:00, and were 
fishing off the beach opposite the Winnam camping area when they were approached by two dingoes. 
 
The two dingoes headed directly to a closed bait bucket, sniffed it then ran up the dunes towards the 
Winnam camping area. 
 

and decided to stop fishing and head back to their camp (2-3 mins later) at the Winnam 
camping area. 
 
When and arrived back at their camp they noticed that their tent was ripped but nothing was 
missing.   
 
No dingoes were seen at the campsite.   
 
 
Additional comments and notes: The two dingoes on the beach were identified by and as 
the same two dingoes (BWR13m & untagged female) previously encountered by them earlier that 
morning (Code D snarling). 
 
BWR13m has previously displayed tent ripping behaviour and is a known habituated dingo. 
 
The only items and had in their tent was a tube of tooth paste in a side tent pocket.    
 
 
Action taken: Interview conducted and a report generated and circulated. Dingo ranger notified. 
 
 
Proposed further action: Continue ranger camp briefings and dingo monitoring in the area.  
 
 
Faxed/emailed date:  13/10/2014                  Reporting Officers details:  702818 & 7028728 
 
  

sch4p3( 3) Prejudice the protection of an individuals right to privacysch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacysch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacysch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacysch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacysch4p3( 3) Prejudice the protection of an individuals right to privacy
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Dingo Interaction Report Form Insert Code: C Dingo ID: 1x Unidentified 
 
Date (of Interaction): 17/10/14 
Location (of Interaction): Guluri CZ 

Time (of Interaction 24hrs): 19:00 
Reporting Officer/s details: 7027848 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify) Hairbush & 
Medication 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult                   
Juvenile                   
Pup                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Cooperoo, Brisbane, 4151 
Phone #
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events:  

nd three other female visitors were in their camp around 7pm when they were approached by a 
dingo - no sex of tag identified. 
 
The four women got into their car to get away from the dingo. 
 
While they were in their car they observed the dingo rip a hole in their tent and pull all their luggage out. 
 
The dingo stole a hairbrush and some medication (anti-histamine tablets) before moving away about 
20mins and sitting down chewing on the brush. 
 
The ladies were yelling from the car and making noise, however the dingo was not deterred and sat for 
around 30mins before moving off of its own accord. 
 
 
 
Additional comments and notes: A dingo returned on several occasions throughout the evening, 
loitering around the camp. 
 
 
 
Action taken: Dingo safety messaging given to campers.  Report generated & circulated. 
 
 
 
Proposed further action: Continue camper briefings in this area.  Observe and record all dingo 
movements. 
 
 
 
Faxed/emailed date:  19/10/14                               Reporting Officers details:  7028773 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unknown 
 
Date (of Interaction): 18/10/14 
Location (of Interaction): Guluri CZ 

Time (of Interaction 24hrs): Approx 19:00 
Reporting Officer/s details: 7027848 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult                   
Juvenile                   
Pup                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #: 
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events:  

and his friends were sitting on the dunes in front of their tents around 7pm. 
 
When they returned to their tents a short while later they found that a dingo had ripped into the back of 
one of the tents, pulled their pillows out and torn them apart. 
 
They did not see or hear the dingo, and there was nothing in their tents. 
 
 
 
Additional comments and notes:       
 
 
 
Action taken: Dingo safety messaging given to campers.  Report generated & circulated. 
 
 
 
Proposed further action: Continue camper briefings in this area.  Observe and record all dingo 
movements. 
 
 
 
Faxed/emailed date:  19/10/14                               Reporting Officers details:  7028773 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Dingo Interaction Report Form Insert Code: C Dingo ID: 1Unid UT F & 1 Unid M 
 
Date (of Interaction): 23/10/14 
Location (of Interaction): Yidney Rocks 

Time (of Interaction 24hrs): 16:45 
Reporting Officer/s details: 7028020 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Visitors reporting moved on 

and did not witness dingoes move on 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult                   
Juvenile                   
Pup       1       
Unknown Age 1             

 
c. Were the dingo(s) tagged Unknown 
    Details: Female untagged, male unknown 
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   Independant      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: At approx. 16:45 on 23/10/14, and her husband observed 2 
dingoes (1 male 1 female) on the beach near Yidney Rocks in close proximity to a 4WD that had 
stopped to fish. 
 
The dingoes did not appear aggressive but were comfortable and relaxed around the three fishermen, 
lying within 1m of the vehicle. 
 
The fishermen were not doing anything to deter the dingoes. 
 
 
 
Additional comments and notes: Photos provided from 23/10/14 and 24/10/14 from the same spot 
show an untagged juvenile female dingo, and a male dingo possibly tagged. 
 
Interaction report sent via the dingo.range@nprsr.qld.gov.au email address on 27/10/14. 
 
 
 
Action taken: Interaction report completed and circulated. 
 
 
 
Proposed further action: Continue patrols and monitoring of all dingoes in this area.  Continue 
briefings of all visitors in this area. 
 
 
 
Faxed/emailed date:  30/10/14                               Reporting Officers details:  7028020 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  UT13f, Yidney 
Rocks, 23/10/14 - R Robey 

 

Photo 2. 
Description (who took 
photo/when):  Dingo, Yidney 
Rocks, 23/10/14 - R Robey 
 

 

Photo 3. 
Description (who took 
photo/when):  UT13f & Unid M, 
Yidney Rocks, 24/10/14 - R 
Robey 
 

 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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25/10/2014Dingo Interaction Report Form Insert Code: C Dingo ID: 13Green10m 
 
Date (of Interaction): 25/10/2014 
Location (of Interaction): Lake McKenzie Carpark 

Time (of Interaction 24hrs): 13:48 
Reporting Officer/s details: 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes Encouraging to 

take photographs 
 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) didn’t leave 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult 1             
Sub adult                   
Juvenile                   
Pup                   
Unknown Age                   

 
c. Were the dingo(s) tagged No 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Dingo was identified by its sock 
markings and scars. 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 7028018 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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  lunging (attempting to nip or bite) 
Questionnaire:                  Specify visitor type   click to select      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments No the visitors were cooking lunch in the carpark and taking photos of the dingo at  
close proximity.  
 
 
 
Detailed report of events: At 13:48 on the 25/10/2014, ranger 7028018 was visiting Lake McKenzie on 
rostered days off, noticed a dingo loitering around in the carpark.  
 
The dingo was scavenging for food scraps and was completely undetered by the presence of large 
visitor crowds who were trying to encourage it closer to take photographs. 
 
The dingo was identified as 13Green10m by his sock markings and facial scars.  
 
Ranger 7028018 advised visitors who were encroaching too close to maintain a safe distance and not to 
feed or encourage the dingo. 
 
  
 
 
Additional comments and notes: 13Green10m is a known habituated dingo that frequently visits the 
Lake McKenzie area.  
 
13Green10m is the known father of a 2014 born litter. It is anticipated that the litter of pups may follow 
13Green10m's lead when he frequents the Lake McKenzie carpark in the near future.  
 
 
Action taken: Photographs taken. Report generated and circulated. Visitors breifed on dingo safety. 
 
 
Proposed further action: Install trail cameras at Lake McKenzie to monitor dingo movements. Continue 
visitor briefings by rangers conducting regular maintenance duties.  
 
 
Faxed/emailed date:  31/10/2014                               Reporting Officers details:  7028018 
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Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  7028018 
13Green10m at Lake Mckenzie 
on 25/10/2014 

 

Photo 2. 
Description (who took 
photo/when):  7028018 
13Green10m at Lake Mckenzie 
on 25/10/2014 
 

 

Photo 3. 
Description (who took 
photo/when):  7028018 
13Green10m at Lake Mckenzie 
on 25/10/2014 
 

 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Dingo Interaction Report Form Insert Code: c Dingo ID: Unknown 
 
Date (of Interaction): 31/10/14 
Location (of Interaction): Beach front of 'The 
Oaks' 

Time (of Interaction 24hrs): 1720 
Reporting Officer/s details: 7028728, 7029188 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify) Fish in 
bucket 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult 1 1       
Juvenile                   
Pup                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details: Too distant to determine 
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Refer photographs 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #: 
Age:       
 
Name: 
Address:       
Phone #:
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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  lunging (attempting to nip or bite) 
Questionnaire:                  Specify visitor type   unknown      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments Had previously spoken to if he was aware of dingo safety which he confirmed 
he was. 
 
 
 
Detailed report of events: On the 31 October at 1720hrs and were fishing out the front of 
the 'Oaks' when they turned around to notice that two dingoes were running off with a fish from their 
unsealed bucket. Their vehicle and bucket were 40 metres from the water line.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: At 1725hrs officers intercepted dingoes at a vehicle 100m south of 
incident, where the two dingoes then headed for the foreshore dunes. They stayed in this location for 
approximately 10mins. Photos were taken at this location.      
 
 
 
 
 
Action taken:       
 
 
 
 
 
 
 
 
Proposed further action:       
 
 
 
 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacysch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

15-166 File C 606 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 3 

Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  Taken by 
7029188 at 1728 

 

Photo 2. 
Description (who took 
photo/when):  Taken by 
7029188 at 1728 
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Photo 3. 
Description (who took 
photo/when):  Taken by 
7029188 at 1728 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified Dingo 
 
Date (of Interaction): 1/11/2014 
Location (of Interaction): Yidney Rocks 

Time (of Interaction 24hrs): 03:45 
Reporting Officer/s details: 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult                   
Juvenile                   
Pup                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: (Yidney Rocks 
manager) 
Address: Yidney Rocks Accommodation  
Phone #: 07 41279167 
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

15-166 File C 609 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 2 

Questionnaire:                  Specify visitor type   unknown      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureNo 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments The guest tried to deter the dingo by clapping his hands and yelling. 
 
 
 
Detailed report of events: The following is recount of events forwarded onto ranger 7028018 by 

(Yidney Rocks manager). 
 
At approx. 03:45 a guest staying at Yidney Rocks accommodation was woken by the sound of 
scratching on the security screen of his holiday unit door. When the guest opened the door to inspect 
what was making the noise he noticed a dingo scratching the wire mesh on the door.  
 
The guest yelled and clapped his hands in an attempt to deter the dingo, but the dingo did not react and 
moved across to the next apartment’s door and continued scratching the wire mesh. 
 
After approx. 5 minutes the dingo left.   
 
No identification of the dingo was obtained due to the low light.  
 
 
Additional comments and notes:       
 
 
Action taken: Interaction reported. Report generated and circulated. 
 
 
Proposed further action: Maintain regular communication with island residents and private enterprises. 
 
 
Faxed/emailed date:  1/11/2014                               Reporting Officers details:  7028018 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

15-166 File C 610 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 1 

Dingo Interaction Report Form Insert Code: C Dingo ID: WRW11f + 3 juveniles 
 
Date (of Interaction): 2 November 2014 
Location (of Interaction): Central Station day use 
carpark + area behind former office 

Time (of Interaction 24hrs): 1150-1200hrs 
Reporting Officer/s details: 7026804 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) continued to loiter 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     4 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult       1       
Juvenile             3 
Pup                   
Unknown Age                   

 
c. Were the dingo(s) tagged 
No -not all dingo(s) (detail) 
    Details: WGW11f (known but has lost tag), no 
juveniles tagged 
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Refer attached photos 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Witnessed by rangers 7026804 + 
7027904 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   QPWS employee      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments Did not approach - photographed from a distance 
 
 
 
Detailed report of events: Whilst returning to our vehicle, WRW11f (tag absent but previously identified 
through sock heights, markings and known territory) and three juvenile dingoes were observed loitering 
around the Central Station day use parking area. They were within 10m of QG vehicle. When WRW11f 
became aware of my presence, she led the juveniles into the bush, and they were sighted shortly after 
lying behind the former office building in the day use area. They did not approach myself or ranger 
7027904 but it was evident that the juveniles are less wary than WRW11f. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: A couple of people were sitting in their car in the car park, and a 
number of tour bus passengers were down on the boardwalk at the time, so there was a strong chance 
of interaction with humans after we departed. 
 
 
 
 
 
Action taken: Photographed for identification purposes. 
 
 
 
 
 
 
 
 
Proposed further action: Increased ranger/wildlife monitoring camera presence to reduce habituation 
potential through human interference/encouragement. 
 
 
 
 
 
Faxed/emailed date:  3Nov2014                               Reporting Officers details:  7026804 
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Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  WRW11f and 
three juveniles in car park  

 

Photo 2. 
Description (who took 
photo/when):  Three juveniles in 
car park [7026804] 
 

 
 

 

Photo 3. 
Description (who took 
photo/when):  Juveniles in day 
use area behind office building 
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Dingo Interaction Report Form Insert Code: C Dingo ID: PuGR13M 
 
Date (of Interaction): 4Nov14 
Location (of Interaction): Burad CZ 

Time (of Interaction 24hrs): 1500 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Stayed in area 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: PuGR13M 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

Release
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Questionnaire:                  Specify visitor type   QPWS employee      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: 7027330 and a volunteer were patrolling south through Burad CZ when a 
dingo trotted down the dune toward the vehicle. The dingo was identified as PuGR13M. The animal sat 
down beside the vehicle and stayed there untill the ranger drove away. 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: A very habituated animal that is moving between Ocean Lake and 
Wyuna CZ. 
 
 
 
 
 
Action taken: Waddy Point dingo ranger informed, report generated. 
 
 
 
 
 
 
 
 
Proposed further action: Continue breifing and patrolling regime and monitor this animal. 
 
 
 
 
 
Faxed/emailed date:  10/11/14                               Reporting Officers details:  7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Descriptio
n (who took 
photo/when):  
7027330 1500 
4Nov14 
Burad CZ  

 

Photo 2. 
Descriptio
n (who took 
photo/when):   
7027330 1500 
4Nov14 
Burad CZ 
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Dingo Interaction Report Form Insert Code: C Dingo ID: BWR13M 
 
Date (of Interaction): 5/11/2014 
Location (of Interaction): Eli Creek 

Time (of Interaction 24hrs): 0936 
Reporting Officer/s details: 7028728, 7029188 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult 1             
Juvenile                   
Pup                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: Blue, white, red  
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   click to select      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: On the 5 November 2014 at 0936 Rangers 7028728 and 7029188 noticed 
the male dingo tagged Blue, white, red in close proximity (within 5m) of people parked on the bank of Eli 
creek. The dingo after a period of time layed down in this location.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:   
 
 
 
 
 
Action taken: Rangers advised people who were nearby to be aware of the dingo and keep their 
distance.  
 
 
 
 
 
 
 
 
Proposed further action:       
 
 
 
 
 
Faxed/emailed date:  5/11/2014                               Reporting Officers details:  7028728 
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Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified dingo 
 
Date (of Interaction): 5/11/14 
Location (of Interaction): One Tree Rocks CZ 

Time (of Interaction 24hrs): Between 1400 & 1600 
Reporting Officer/s details: 7026936 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) dingoes left before visitors 

return 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult                   
Juvenile                   
Pup                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: and his family were absent from his camp at One Tree Rocks between 
1400 and 1600 on 5/11/14. When he returned back, he found that his tent had been ripped into by a 
dingo in two places. Clothes and pillows were found outside the tent, was adamant that no food 
items were stored in his tent.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: and his family relocated to a fenced camping area in Central 
Station. 
 
 
 
 
 
Action taken: Report generated and circulated, was given the option to move his camp to a fenced 
campground. 
 
 
 
 
 
 
 
 
Proposed further action: Consider closure of OTR & Cornwalls CZ's 
 
 
 
 
 
Faxed/emailed date:  10/11/14                               Reporting Officers details:  7026936 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

15-166 File C 621 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 4 

Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: BWPi13f 
 
Date (of Interaction): 7/11/14 
Location (of Interaction): One Tree Rocks CZ 

Time (of Interaction 24hrs): 0600 
Reporting Officer/s details: 7026936 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify) Bait bag 
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult       1       
Juvenile                   
Pup                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: BWPi13f 
 
d. Which ears were tagged Right  
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Witness - 7027110 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments       
 
 
 
Detailed report of events: At 0600 on 7/11/14 ranger 7027110 was fishing in front of OTR CZ and 
witnessed BWPi13f steal the bait bag of some fishermen close by. The fishermen gave chase and 
retrieved the bait bag. The dingo then loitered around the fishermen for 20 minutes.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: Report generated and circulated. 
 
 
 
 
 
 
 
 
Proposed further action:       
 
 
 
 
 
Faxed/emailed date:  10/11/14                               Reporting Officers details:  7026936 
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Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified 
 
Date (of Interaction): 7 Nov 14 
Location (of Interaction): Wahba CZ 

Time (of Interaction 24hrs): 2100 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify) esky 
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits No 
Did they read the Dingo BrochureNo 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Clean camp everything packed away and had read signs and info boards. 
 
 
 
Detailed report of events: and his partner went to bed early, at approx 2100 heard the 
ice in his esky rattling. On investigating a dingo was seen attempting to drag the esky out of the camp by 
the handle. yelled at the animal and it ran off. 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: No identification was supplied. 
 
 
 
 
 
Action taken: Interview conducted, report generated. 
 
 
 
 
 
 
 
 
Proposed further action: Continue patrolling and briefing regime, monitor animals in the area. 
 
 
 
 
 
Faxed/emailed date:  10/11/14                               Reporting Officers details:  7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):   

 Photo 2. 
Description (who took 
photo/when):   
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified dingo 
 
Date (of Interaction): 9/11/14 
Location (of Interaction): One Tree Rocks CZ 

Time (of Interaction 24hrs): Between 1100 & 1630 
Reporting Officer/s details: 7026936 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) dingoes left before visitors 

return 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult                   
Juvenile                   
Pup                   
Unknown Age             2 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: and his girlfriend were absent from their camp at One Tree Rocks 
between 1100 and 1630 on 9/11/14. When he returned back, they saw 2 dingoes exit their tent and run 
away. They noticed that their tent had been ripped into by a dingo. According to nothing was 
stolen from the tent.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: relocated to a fenced camping area at Dundubara. 
 
 
 
 
 
Action taken: Report generated and circulated, was given the option to move his camp to a 
fenced campground. 
 
 
 
 
 
 
 
 
Proposed further action: Consider closure of OTR & Cornwalls CZ's 
 
 
 
 
 
Faxed/emailed date:  10/11/14                               Reporting Officers details:  7026936 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: BWR13M, GGG13F 
 
Date (of Interaction): 9Nov14 
Location (of Interaction): Eli Ck 

Time (of Interaction 24hrs): 1600 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) did not leave area 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1 1       
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes - all dingo(s)  
    Details: BWR13M, GGG13F 
 
d. Which ears were tagged Right  
    Details: both animals tagged 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   QPWS employee      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Ranger 7027330 was patrolling north toward Eli Ck when a dingo was 
spotted on the waters edge at Eli Ck. On closer inspection the dingo was identified as GGG13F, the 
dingo was followed south until it crossed the creek and headed south. At this point a tourist informed the 
ranger that there was another dingo walking around people further up the creek. Ranger 7027330 then 
found the second dingo walking around tourists. A foreign tourist then called and whistled to the animal 
in an attempt to bring the animal closer. The tourist was informed that this was an offence and was then 
briefed along with others of his group. The dingo was identified as BWR13M. The dingo was foraging for 
scraps in the sand and resisted all attempt to move him on. All tourists in the area were briefed 
especially those with children. At approx. 1645 GGG13F approached from the south and also began 
foraging for scraps. Both animals were monitored until all tourists had left the site.  
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: BWR13M is highly habituated and is difficult to deter, GGG13F is still 
wary however the longer she associates with BWR the more habituated she will become.  
 
 
 
 
 
Action taken: Eurong dingo ranger informed, report generated. 
 
 
 
 
 
 
 
 
Proposed further action: Continue patrolling and briefing with attention to Eli Ck in the afternoon. 
 
 
 
 
 
Faxed/emailed date:  10/11/14                               Reporting Officers details:  7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Descriptio
n (who took 
photo/when):  
7027330 1620 
9Nov14 
during 
interaction 
 

Photo 2. 
Descriptio
n (who took 
photo/when):  
as above 
7027330 1620 
9Nov14 
during 
interaction 
 

 

Release
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified male dingo 
 
Date (of Interaction): 11/11/2014 
Location (of Interaction): Wanggoolba barge 
landing 

Time (of Interaction 24hrs): 16:55 
Reporting Officer/s details: 7027110 &7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult                   
Juvenile                   
Pup                   
Unknown Age 1             

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: QPWS Ranger 7027110 
Address: QPWS ranger base Eurong 
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   QPWS employee      
Did they receive an information pack with their permits click to select 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: Ranger 7027110 and his family were at the Wanggoolba barge landing on 
the 11/11/2014 at 16:55 and notice an untagged male dingo loitering nearby. 
 
The male dingo was unatgged and according to staff working on the barge is regularly seen loitering in 
the area.  
 
 
Additional comments and notes: 13Green10m and an untagged sub-adult male dingo are regularly 
seen in the area. 
 
A positive identification of the dingo from the photos is unattainable.  
 
 
Action taken: Interaction reported to dingo rangers. Report generated and circulated. 
 
 
Proposed further action: Continue monitoring all dingo activity in the area. Capture and tag the 
untagged dingo for identification purposes as per the FIDCRMS 2013 recommendations. 
 
 
Faxed/emailed date:  19/11/2014       Reporting Officers details:  7027110 & 7028018 
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Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  Ranger 7027110. 
Wanggoolba. 11/11/2014 

 

Photo 2. 
Description (who took 
photo/when):  Ranger 7027110. 
Wanggoolba. 11/11/2014 
 

 

Photo 3. 
Description (who took 
photo/when):  Ranger 7027110. 
Wanggoolba. 11/11/2014 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified 
 
Date (of Interaction): 13/11/2014 
Location (of Interaction): Waddy point beachfront 
camping area 

Time (of Interaction 24hrs): 2330 
Reporting Officer/s details: 7028773 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults             1 
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address: Scarborough  
Phone #
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: Late at night heard something scratching at his tent. He went out to 
investigate to find a dingo knocking over rubbish bucket trying to get in. turned his torch on, 
initially tried to shoo the dingo away, the dingo stood its ground. then tried again with a louder 
voice and the dingo ran away.    
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: Report taken 
 
 
 
 
 
 
 
 
Proposed further action:       
 
 
 
 
 
Faxed/emailed date:  24/11/14                               Reporting Officers details:  7028773 
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Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
 

 

15-166 File C 640 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 1 

Dingo Interaction Report Form Insert Code: c Dingo ID: Unknown dingo(oes) 
 
Date (of Interaction): 13/11/14 
Location (of Interaction):  Maheno camping area 

Time (of Interaction 24hrs): Unknown 
Reporting Officer/s details: 7027202 & 7027848 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
       Lamb, chicken, stew, steak 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)          
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) unsure, campers were asleep 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address: Maryborough 
Phone #: 
Age: 45- 50 
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Unknown 
Comments       
 
 
 
Detailed report of events: On the 13/11/2014 her husband (name unspecified) and 
adult son (name unspecified) woke up at their camp in the Maheno camping area to find their eskies 
skattered around their camp site.  
 
One esky had its lid ripped off completely from the hinges and all the contents taken from it; lamb, roast 
chicken, stew etc. They had placed heavy boxes on top of their food cooler boxes but this had not 
deterred the dingo/es from stealing food. The campers did not awake from their sleep. 
 
 
Additional comments and notes: One unidentified dingo had been seen in the general area before 
and after the food stealing interaction. 
 
 
Action taken: Interaction reported to 2IC Dundubara and dingo ranger. Interview undertaken and report 
generated and circulated. 
 
 
Proposed further action: Continue ranger educational briefings on dingo safe messaging to all visitors 
in the area. Continue monitoring all dingo activities in the area.    
 
 
Faxed/emailed date:  16/11/14                Reporting Officers details:  7027202 & 7027848 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Dingo Interaction Report Form Insert Code: C Dingo ID: WRW11f + 1 Juv 
(female) 
 
Date (of Interaction): 14/11/2014 
Location (of Interaction): Central Station Forestry 
Barracks  

Time (of Interaction 24hrs): 14:30 
Reporting Officer/s details: 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

E) High Risk. 
  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) didn’t leave 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult       1       
Sub adult                   
Juvenile       1       
Pup                   
Unknown Age                   

 
c. Were the dingo(s) tagged No 
    Details: WRW11f is missing a tag and the 
juvenile isnt tagged 
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 7028018 (NRM ranger) 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   click to select      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: At approx 14:30 on the 14/11/2014 rangers 7028018 & 7028020 were 
carrying out maintenance duties at Central Station, noticed WRW11f (tag missing but identified by sock 
markings and scars) sleeping under the western side of the forestry barracks with a juvenile female 
dingo.  
 
Both dingoes displayed caution towards the rangers but remained lying under the buildlings undetered. 
  
 
Additional comments and notes: Although WRW11f doesn’t have a recorded management history of 
habituated behaviour, she is currently displaying habituation which she and her mate (13Green10m, a 
known habituated dingo) are teaching to their 2014 born progeny. It is also suspected that the juvenile 
dingoes are becoming habituated to humans through learned behaviour that is being encouraged by 
constant human interactions within the Central Station day use area. 
 
 
Action taken: Interaction report generated and circulated. 
 
 
Proposed further action: Continue opportunistic educational dingo safe briefings to CTO operators and 
visitors and continue monitoring dingoes in the area. 
 
Capture and re-tag WRW11f and 13Green10m for identifiaction purposes. 
 
 
Faxed/emailed date:  15/11/2014                               Reporting Officers details:  7028018 
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Dingo Interaction Report Form Insert Code: C Dingo ID: BWR13M 
 
Date (of Interaction): 15/11/2014 
Location (of Interaction): The Oaks beachfront 

Time (of Interaction 24hrs): 1800 
Reporting Officer/s details: 7027904 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) 3        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) When cut off by QG 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult 1             
Juvenile                   
Pup                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: Blue, white, red  
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: QPWS Ranger 7027904 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   Independant      
Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments The driver should have driven at a pace as so the dingo couldn't keep up. 
 
 
 
Detailed report of events: On the 15 November 2014 at approximately 1800 myself 7027904 and 
ranger 7029188 were called to investigate a dingo incident at "The Oaks", a section of beach between 
Poyungan Rocks and Yidney Rocks. As we passed Yidney Rocks, we were directed by some visitors to 
a vehicle travelling south along the beach. We drove south and as we approached that vehicle, we 
noticed a dingo chasing it. We caught up with the vehicle and observed the dingo chasing the car with 
very strong determination to keep up. There were 2 males hanging cameras out of the left hand side of 
the vehicle. I drove ahead of the dingo and moved in closer to the south bound vehicle and slowed down 
to halt the chase. The dingo slowed and swerved and tried to continue the chase. I kept moving the QG 
to halt the dingo and it finally lost interest in the sth bound vehicle and began walking slowly south. 
 
 
 
 
 
Additional comments and notes:  It was a strong belief that the people in the car had given the dingo 
something to eat or lured it some other way. I had a brief conversation with the people in the car as I 
drove along side and they denied any wrong doing. 
 
 
 
 
Action taken:  Report taken 
 
 
 
 
Proposed further action: Monitor the section of beach between Eli Creek and Eurong for dingo activity. 
 
 
 
 
Faxed/emailed date:  18/11/2014                               Reporting Officers details:  7027904 
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Unattended footware

      

      

2 1

WITNESSED

possibly orange
possibly female
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Dingo Interaction Report Form Insert Code: C Dingo ID: Untagged male 
 
Date (of Interaction): 19/11/2014 
Location (of Interaction): Waddy Point 
Beachfront campground 

Time (of Interaction 24hrs): approx 1000am 
Reporting Officer/s details: 7027118 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age 1             

 
c. Were the dingo(s) tagged No 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address:       
Phone #: 
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: At approximately 1000am on Wednesday the 19.11.14 a 'large' untagged 
dingo was loitering around the waddy beachfront camping ground. The dingo hung in the area (within 
20meters of camps) for a few minutes and left on its own accord.  
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: Report generated and circulated 
 
 
 
 
 
 
 
 
Proposed further action: Monitor behaviour of this individual, trap and tag individual, continue to brief 
camps in the area. 
 
 
 
 
 
Faxed/emailed date:  24/11/2014                               Reporting Officers details:  7027118 
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Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: BWR13M, GGG13F 
 
Date (of Interaction): 20Nov14
Location (of Interaction): Eli Ck 

Time (of Interaction 24hrs): 1500-1700 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1 1       
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GGG13F BWR13M 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   click to select      

Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: While patrolling Eli creek day use area ranger 7027330 sighted a dingo 
moving through parked vehicles and around people. On closer inspection the dingo was identified as 
BWR13M. At approx. 1545 another dingo approached from the south this dingo was identified as 
GGG13F, this dingo was more wary of people than BWR13M and stayed 10-20M awy from people. Both 
animals were foraging for food scraps left by tourists. The dingoes stayed in the area until approx. 1700 
and then moved of toward the north. 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: These animals were involved in a recent code E interaction and it is 
of concern that they are frequenting a busy day use area. These animals are clearly foraging for food 
scraps left inadvertently or on purpose, investigations should be made into restricting eating and food 
preparation at the site. The site is a known attractant and habituation site for dingoes. 
 
 
 
 
 
Action taken: Monitor animals, brief tourists in area, RIC NMU informed, Eurong dingo ranger informed, 
report generated. 
 
 
 
 
 
 
 
 
Proposed further action: Continue monitoring these animals, patrol area, brief tourists, investigated 
closing area to eating and food preparation 
 
 
 
 
 
Faxed/emailed date:  22/11/14                               Reporting Officers details:  7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):   

 Photo 2.
Description (who took 
photo/when):  as above 
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Dingo Interaction Report Form Insert Code: C Dingo ID: BWR13M, GGG13F 
 
Date (of Interaction): 21Nov14
Location (of Interaction): Eli Ck 

Time (of Interaction 24hrs): 1500-1800 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Stayed in area 

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1 1       
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GGG13F BWR13M 
 
d. Which ears were tagged Left 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   click to select      

Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: While patrolling Eli creek day use area ranger 7027330 sighted a dingo 
moving through parked vehicles and around people. The dingo was identified as BWR13M the same 
dingo was sighted in the area the day before. The dingo was seen foraging for food scraps in the area. 
At approx. 1630 a dingo approached from the south this animal was identified as GGG13F, she then 
began to forage for scraps in the area. Attempts were made to deter the animals GGG13F left the area 
for a short time however BWR13M would only move away a short distance and sit down. The animals 
were monitored untill all tourist left the area. 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: These animals were involved in a recent code E interaction and it is 
of concern that they are frequenting a busy day use area. These animals are clearly foraging for food 
scraps left inadvertently or on purpose, investigations should be made into restricting eating and food 
preparation at the site. The site is a known attractant and habituation site for dingoes. 
 
 
 
 
 
Action taken: Monitor animals, brief tourists in area, RIC NMU informed, Eurong dingo ranger informed, 
report generated. 
 
 
 
 
 
 
 
 
Proposed further action: Continue monitoring these animals, patrol area, brief tourists, investigated 
closing area to eating and food preparation 
 
 
 
 
 
Faxed/emailed date:  22/11/14                               Reporting Officers details:  7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):   

 Photo 2.
Description (who took 
photo/when):  as above 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Untagged male 
 
Date (of Interaction): 22/11/2014 
Location (of Interaction): Waddy Point 
Beachfront campground 

Time (of Interaction 24hrs): approx 2300 
Reporting Officer/s details: 7027118 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age 1             

 
c. Were the dingo(s) tagged No 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: Late in the night on the 22/11/14 a 'large, healthy' untagged dingo came into 

camp. said that the dingo was not wary - though didn’t show any aggression. The dingo 
left the area on its own accord with its tail up in the air.  
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: has seen this particular dingo walk past their camp on a 
nightly basis. 
 
 
 
 
 
Action taken: Report generated and circulated 
 
 
 
 
 
 
 
 
Proposed further action: Monitor behaviour of this individual, trap and tag individual, continue to brief 
camps in the area. 
 
 
 
 
 
Faxed/emailed date:  24/11/2014                               Reporting Officers details:  7027118 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacysch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: GGG13F 
 
Date (of Interaction): 24Nov14
Location (of Interaction): Eli Ck 

Time (of Interaction 24hrs): 1600
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Had finished scavenging for 

scraps and moved on 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults       1       
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: GGG13F 
 
d. Which ears were tagged Right  
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   click to select      

Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: Ranger 7027330 was patrolling Eli creek day use area when a dingo was 
sighted approaching from the south. On closer inspection the dingo was positively identified as 
GGG13F. The dingo seen to check areas were people had parked looking for food scraps, she was 
successful in some areas. Once she had checked the area she headed into the dune on the north side 
of the creek. 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: The dingo got to within 5m of vehicles and 10m of people, it is still 
wary however is approaching people and vehicles closer than it has previously. Normally in company of 
BWR13M however this animal was not sighted on this occasion. 
 
 
 
 
 
Action taken: Briefed tourists using area, Informed Ric NMU, report generated. 
 
 
 
 
 
 
 
 
Proposed further action: Continue patrol Eli Ck in the afternoon, monitor animal, and investigate 
restricting food preparation and consumption at this site. 
 
 
 
 
 
Faxed/emailed date:  25/11/23                               Reporting Officers details:  7027330 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):   

 Photo 2.
Description (who took 
photo/when):  as above 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified Dingo 
 
Date (of Interaction): 24Nov14 
Location (of Interaction): Yuru CZ 

Time (of Interaction 24hrs): 1200-1500 
Reporting Officer/s details: 7027330 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify) eggs meat  
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify) tent and fridge 

cover 
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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  lunging (attempting to nip or bite) 
Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments believed a dingo would not be able to access his fridge this was not the case. 
 
 
 
Detailed report of events: left his camp at approx. 1200 on his return he found his tent ripped, his 
fridge cover had been torn off and food in the fridge had been taken.  
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: The camp had set up the night before and had not been briefed. 
Ranger 7027130 sighted an unidentified dingo in Gurruman CZ carrying a bag around the time the tent 
was ripped.  
 
 
 
 
 
Action taken: Camper briefed and advised that the dingo may return. Ric NMU informed, report 
generated.   
 
 
 
 
 
 
 
 
Proposed further action: Continue briefing and patrolling regime, monitor animals in the area 
 
 
 
 
 
Faxed/emailed date:  25/11/14                               Reporting Officers details:  7027330 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):   

 Photo 2. 
Description (who took 
photo/when):  as above 
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Dingo Interaction Report Form Insert Code: C Dingo ID: 13Green10m 
 
Date (of Interaction): 30/11/2014 
Location (of Interaction): Central Station DUA 

Time (of Interaction 24hrs): 07:00 
Reporting Officer/s details: 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     3 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult 1             
Sub adult                   
Juvenile 1 1       
Pup                   
Unknown Age                   

 
c. Were the dingo(s) tagged No 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Scar above the right eye on the adult 
male 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: QPWS ranger 7028018 
Address: Eurong Fraser Island 
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   QPWS employee      

Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: On the 30/11/2014 at approx. 07:00 ranger 7028018 was walking through 
the Central Station day use area and noticed two juvenile dingoes sleeping next to the old office 
building.  
 
On approaching closer (approx. 15 meters from the building) a dingo started growling and barking from 
under the building. An adult male dingo (13Green10m) walked out and started howling. In response to 
his howls a number of other dingoes started howling as well.  
 
The juvenile dingoes ran off into the forest. 13Green10m also walked off into the forest. 
 
    
 
Additional comments and notes: 13Green10m is a known habituated dingo with multiple code C and 
a D interactions recorded in his management history. The howling and growling was most likely a 
warning to stay away from his progeny. Ranger 7028018 did not feel threatened at any time during the 
interaction.  
 
 
Action taken: Report generated and circulated.  
 
 
Proposed further action: Continue monitoring the Central Station day use area using trail cameras and 
ranger patrols. Fence under the area of the old office building where the dingoes are regularly loitering.  
 
 
Faxed/emailed date:  30/11/2014                               Reporting Officers details:  7028018 
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Dingo Interaction Report Form Insert Code: C Dingo ID: BWPi13f 
 
Date (of Interaction): 30/11/2014 
Location (of Interaction): One Tree Rocks 
camping area beach front 

Time (of Interaction 24hrs): 08:15 
Reporting Officer/s details: 7028018 & 7028020 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) After briefing the wormers 

the dingo still remained nearby. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult       1       
Juvenile                   
Pup                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Right  
    Details: BWPi13f 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: A group of wormers (no names 
specified) 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   unknown      

Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: At approx. 08:15am on the 30/11/2014, rangers 7028018 & 7028020 were 
patrolling the beach and noticed a dingo lying close to a group of fishermen worming. 
 
The dingo was identified as BWPi13f. The rangers spoke to a member of the fishing group who said the 
dingo was intermittently approaching closely and smelling their fish bait bags then lying back down on th 
beach.  
 
Rangers briefed the fishermen on QPWS dingo safe messaging.   
 
 
Additional comments and notes: BWPi13f is a known habituated dingo with multiple code C and D 
interactions in her management history. The fishermen said the dingo was not showing any signs of 
aggressive behaviour.  
 
 
Action taken: Interview undertaken. Report generated and circulated. 
 
 
Proposed further action: Continue early morning and evening ranger patrols. Continue ranger briefings 
to campers and visitors on QPWS dingo safe messaging. Continue monitoring the dingoes within the 
area. 
 
 
Faxed/emailed date:  30/11/2014                               Reporting Officers details:  7028018 
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Dingo Interaction Report Form Insert Code: C Dingo ID: BWPi13f & 2 
unidentified dingoes 
 
Date (of Interaction): 30/11/2014 
Location (of Interaction): Eurong beachfront 

Time (of Interaction 24hrs): 07:30 
Reporting Officer/s details: 7028018 & 7027110 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) 5m        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     3 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult       1       
Juvenile                   
Pup                   
Unknown Age 2             

 
c. Were the dingo(s) tagged Yes 
    Details: All dingoes were tagged but id 
unattainable 
 
d. Which ears were tagged Right  
    Details: 2 male in the left 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: QPWS ranger 7027110 
Address: Eurong, Fraser Island 
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   click to select      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: At approx. 07:30am on the 30/11/2014, off duty ranger 7027110 was 
worming on the beach adjacent to the Eurong QPWS ranger base.   
 
The ranger turned around and was startled by a female dingo (tagged) approaching closely and sniffing 
at his bait bag. 
 
Two other dingoes (both male and tagged) also appeared from the beach foredunes and headed directly 
towards him.  
 
A vehicle driving by intervened and asked if the ranger needed a lift to safety which he replied no. 
 
The ranger picked up his bait bag and slowly walked back up the beach to his house. 
 
The dingoes continued travelling along the beach.  
 
 
Additional comments and notes: BWPi13f was identified by rangers 7026466 & 7028018 minutes 
after the interaction. 
 
BWPi13f is a known habituated female with multiple code C and a D interactions in her management 
history.  
 
The two other tagged male dingoes may have been members of BWPi13f's pack.  PiYPi11m and 
OPuO13m. 
  
 
Action taken: Interaction reported. Report generated and circulated. 
 
 
Proposed further action: Continue ranger beach patrols and camper and visitor briefings.   
 
 
Faxed/emailed date:  1/12/2014                               Reporting Officers details:  7028018 
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Code C_Unidentified Dingo_Cornwalls CZ_02Dec14_tent rip 1

Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified dingo 
 
Date (of Interaction): 2/12/14 
Location (of Interaction): Cornwalls CZ 

Time (of Interaction 24hrs): between 1030&1200 
Reporting Officer/s details: 7026936 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult                   
Juvenile                   
Pup                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address: Noosa north shore 
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Code C_Unidentified Dingo_Cornwalls CZ_02Dec14_tent rip 2

Questionnaire:                  Specify visitor type   camper      

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: On the 2nd of December, were away from their 
camp between 1030 and 1200. They arrived back to find their tent had been ripped in two places. 

said that they had not stored any food inside their tent but the dingo had chewed on a 
shampoo bottle. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken:       
 
 
 
 
 
 
 
 
Proposed further action: Continue to patrol and brief camps throughout Cornwalls and One Tree 
Rocks camp zones. 
 
 
 
 
 
Faxed/emailed date:  5/12/14                               Reporting Officers details:  7026936 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Code C_Unidentified Dingo_Cornwalls CZ_02Dec14_tent rip 3

Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):        

 Photo 2.
Description (who took 
photo/when):        
 

 Photo 3.
Description (who took 
photo/when):        
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Code C_Unidentified Dingo_Cornwalls CZ_01Dec14_rubbish bag 1

Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified dingo 
 
Date (of Interaction): 1/12/14 
Location (of Interaction): Cornwalls CZ 

Time (of Interaction 24hrs): 1900
Reporting Officer/s details: 7026936 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult       1       
Juvenile                   
Pup                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: (Palace tag along leader) 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Code C_Unidentified Dingo_Cornwalls CZ_01Dec14_rubbish bag 2

Questionnaire:                  Specify visitor type   Tag along tour      

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: At 1900 on the 01/12/14, noticed a female dingo attempting to gain 
access to a rubbish bag next to where he was cooking dinner. He yelled at the dingo and chased it 
away. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken:       
 
 
 
 
 
 
 
 
Proposed further action:       
 
 
 
 
 
Faxed/emailed date:  5/12/14                               Reporting Officers details:  7026936 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Code C_Unidentified Dingo_Cornwalls CZ_01Dec14_rubbish bag 3

Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1.

Description (who took 
photo/when):        

 Photo 2.
Description (who took 
photo/when):        
 

 Photo 3.
Description (who took 
photo/when):        
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Code C_Unidentified Dingo_Wyuna CZ_01Dec14_Vacant Tent Rip 1 

Dingo Interaction Report Form Insert Code: c Dingo ID: unidentified 
 
Date (of Interaction): 01 December 2014 
Location (of Interaction): Wyuna CZ 

Time (of Interaction 24hrs): unknown 
Reporting Officer/s details: 1423322 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult                   
Juvenile                   
Pup                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address:       
Phone #:
Age:       
 
Name:
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Code C_Unidentified Dingo_Wyuna CZ_01Dec14_Vacant Tent Rip 2 

Questionnaire:                  Specify visitor type   Independant      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Reported to Eurong Ranger and camp site was clean and free of rubbish and food. 
 
 
 
Detailed report of events: had a tent set-up at Wyuna CZ. They were away from the 
camp from Monday night and Tuesday. When they retuned to the camp it appears as though a dingo 
has ripped their tent. When they were absent no food, rubbish, dirty cloths or other items they believe 
would have attracted the dingo were left in the tent or camp ground. They are not aware of any missing 
items. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: Visitors briefed. Report generated and circulated. 
 
 
 
 
 
 
 
 
Proposed further action: Continue morning and afternoon beach patrolling, monitoring all dingoes. 
Continue to educate visitors of the importance to have a "Great camp site! Safe camp site." 
 
 
 
 
 
Faxed/emailed date:  04/12/14                               Reporting Officers details:  1423322 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Code C_Unidentified Dingo_Wyuna CZ_01Dec14_Vacant Tent Rip 3 

Photos  
To add pictures, you will need to first unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: BWR13m 
 
Date (of Interaction): 02/12/2014 
Location (of Interaction): Happy valley 
beachfront 

Time (of Interaction 24hrs): 08:45 
Reporting Officer/s details: 7028018 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) 1 meter        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult 1             
Juvenile                   
Pup                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: BWR13m 
 
d. Which ears were tagged Left 
    Details: BWR13m 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Ranger 7028018 
Address: QPWS ranger base, Eurong FI 
Phone #:       
Age:       
 
Name:
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   QPWS employee      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: At approx. 08:45am on the 02/12/2014 ranger 7028018 was monitoring 
BWR13m dingo (multiple code C, D and E interactions in his management history) heading south along 
the beach towards Happy Valley. 
 
Ranger 7028018 noticed a lady (pregnant) and 4 young children playing in the creek directly adjacent to 
Happy Valley. 
 
BWR13m also notice the family and headed directly towards them. Ranger 7028018 drove up to the 
family and notified them that the dingo was approaching. The lady asked what she should do for which 
the ranger walked over to them and briefed the mother and children on dingo-safe behaviour. 
 
BWR13m approached the group within 1m and lay down in the creek water (the dingo did not display 
any aggressive behaviour). Ranger 7028018 asked the family to slowly and quietly walk backwards 
towards the ranger vehicle and to be prepared to get into the vehicle if the dingo begins to approach 
closer.  
 
BWR13m after several minutes lost interest and continued heading south along the beach.   
 
 
Additional comments and notes: was unaware of QPWS dingo-safe 
MESSAGING. 
 
BWR13m was reported to have been chasing cars along the beach at Eli Creek. 
 
Ranger 7028018 approached BWR13m in their vehicle (100 meters away). BWR13m ran over to the 
ranger vehicle, jumped up onto the driver’s door and stuck his head in the window. BWR13m was 
pushed away by moving the vehicle forward. 
 
BWR13m was also repeatedly approached by visitors driving along the beach. A number of onlookers 
exited their cars and approached to take photos. Ranger 7028018 briefed them all on be-dingo safe 
messaging.   
 
 
Action taken: Dingo monitored. Beach visitors briefed. Report generated and circulated. 
 
 
Proposed further action: Continue addition ranger beach morning and afternoon beach patrolling, 
monitoring all dingoes. 
 
 
Faxed/emailed date:  03/12/2014                               Reporting Officers details:  7028018 
 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Code C_Unidentified Dingo_Yidney rocks_02Dec14_sniffed feet 1

Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified dingo 
 
Date (of Interaction): 2/12/14 
Location (of Interaction): Yidney rocks 

Time (of Interaction 24hrs): night 
Reporting Officer/s details: 7026936 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance) Sniffed feet        
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult                   
Juvenile                   
Pup                   
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address: 
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Code C_Unidentified Dingo_Yidney rocks_02Dec14_sniffed feet 2

Questionnaire:                  Specify visitor type   resident      

Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: On the night of the 2nd of December, was 
asleep inside his premises. He was awoken by a dingo sniffing his feet through the window of the 
building. The dingo left when woke up.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken:       
 
 
 
 
 
 
 
 
Proposed further action: Continue to liaise with owners and managers of residences to gain 
behavioural information on dingoes. 
 
 
 
 
 
Faxed/emailed date:  5/12/14                               Reporting Officers details:  7026936 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unknown 
 
Date (of Interaction): 05/12/14 
Location (of Interaction): Guruman Camp Zone 

Time (of Interaction 24hrs): 0820 hrs 
Reporting Officer/s details: 7028833 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     5 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults 2             
Sub adults 1             
Juvenile             2 
Unknown Age                   

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   QPWS employee      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: While doing beach patrol I noticed the 5 dingos in question leaving Guruman 
camp zone heading north. The 3 males made their way along the beach in front of dunes, the 2 juveniles 
went behind the dunes all meeting up again just before Dundubara Creek. 
Only 1 camp site in Guruman, spoke to them they said the pack had hung around for a while before 
moving on. 6 people in camp 3 adults and 3 children, they were packing up as they didn't feel safe, even 
though dingos showed no signs of aggressive behaviour. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: Notified RIC and filled out incident report 
 
 
 
 
 
 
 
 
Proposed further action:       
 
 
 
 
 
Faxed/emailed date:  06/12/14                                              Reporting Officers details:  
7028833 

Release
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):      
 

 Photo 2. 
Description (who took 
photo/when):        
 

 Photo 3. 
Description (who took 
photo/when):        
 

 
Release
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Code C_BWPi13f_OTR_CZ_13Dec2014_loitering  1

Dingo Interaction Report Form Insert Code: C Dingo ID: BWPi13f & Juvenile 
 
Date (of Interaction): 13 Dec 2014
Location (of Interaction): OTR CZ- midway 

Time (of Interaction 24hrs): 15:50 
Reporting Officer/s details: 7026466 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     2 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult       1       
Juvenile             1 
Pup                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: BWPi13f - Juv untagged 
 
d. Which ears were tagged Right  
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: Not obtained 
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Code C_BWPi13f_OTR_CZ_13Dec2014_loitering  2

Questionnaire:                  Specify visitor type   camper      

Did they receive an information pack with their permits Unknown 
Did they read the Dingo BrochureUnknown 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Attempted to move the dingoes on. 
 
 
 
Detailed report of events: Ranger 7026466 observed BWPi13f and her 2014 born juvenile approaching 
a mature-aged man and his camping area. The juvenile approached on a number of occasions while 
BWPi13f watched and then she also edged forward towards the camper.  
 
When the juvenile continued to approach and got to within 4-5 metres, the man moved towards the 
juvenile and motioned with his arms for it to move on. It was too windy to observe any verbal direction 
from the camper to the dingo. 
 
Both dingoes moved on to the dune area ~10-20 metres away.  
 
 
 
 
Additional comments and notes: Ranger unable to see if the dingoes returned. Interaction reported as 
loitering as there is no longer an approached option. Behviour was consistant with curious rather than 
soliciting for food. 
 
 
 
Action taken: Interaction reported. 
 
 
 
 
Proposed further action: Continue education of campers in this area regarding discouraging dingoes 
approaching camps.  
 
 
 
Faxed/emailed date:  14/12/2014                               Reporting Officers details:  7026466 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified 
 
Date (of Interaction): 14.12.2014 
Location (of Interaction): Yurru camping zone 

Time (of Interaction 24hrs): 0200 
Reporting Officer/s details: 7027130 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
       food 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     3 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             3 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address: Dalby 4405 
Phone 
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments Gained permit online 
 
 
 
Detailed report of events:  

 0200 Sunday 14.12.2014.  
 Three dingoes entered the camp  
 Gained entry to clip to plastic box 
 Removed all dry food - Biscuits, sweets etc. 
 The dingoes left when chased away by campers  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: Dingo ranger notified, report generated and circulated. 
 
 
 
 
 
 
 
 
Proposed further action: Monitor the area, identify dingoes within the area. 
 
 
 
 
 
Faxed/emailed date:                                                   Reporting Officers details:  7027130 
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified 
 
Date (of Interaction): 14.12.14 
Location (of Interaction): Maheno camp zone 

Time (of Interaction 24hrs): 2330 
Reporting Officer/s details: 7027130 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address Cavew 
Phone #
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: An unidentified dingo ripped a tent during the night. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: Report taken & circulated 
 
 
 
 
 
 
 
 
Proposed further action:       
 
 
 
 
 
Faxed/emailed date:  23.12.14                                     Reporting Officers details:  7027130 
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Code C_ORW09m_Euragarie CZ_16Dec2014_tent rip_steal foodDRAFT  1 

Dingo Interaction Report Form Insert Code: C Dingo ID: ORW09m 
 
Date (of Interaction): 16 Dec 2014 
Location (of Interaction): Eurgarie CZ (nth) 

Time (of Interaction 24hrs): Between 9:30 & 16:00 
Reporting Officer/s details: 7026466 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify) meat, 
poppers, softdrink cans 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Unknown 

 
Question 3: Dingo numbers and identification 
a. How many dingoes present     Unknown 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult 1             
Sub adult                   
Juvenile                   
Pup                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: removed tag found in the the tent. 
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:Tracks in the vicinity were consistent 
with an adult and juvenile. 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Address: Norman Park QLD 
Phone #:
Age: 50's 
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Code C_ORW09m_Euragarie CZ_16Dec2014_tent rip_steal foodDRAFT  2 

Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments Left food items in the tent and fridge freezer not securely locked with wire. 
 
 
 
Detailed report of events:  
 
Two separate families camping together with camper trailers had their canvas tents ripped into by 
unobserved dingo/es. 
 
They arrived back at camp to find  heavy duty canvas tent and fly ripped into. Poppers and softdrink 
were cans removed from the tent and consumed along with milk products.  
 
Their steel fridge/freezer was unlatched by a dingo and BBQ patties, bacon and other meat products 
from the fridge section taken. 
 
The second camper trailer had left their canvas open. Only the flyscreen was ripped the dingo/es had 
gained access and attempted to access poppers and softdrink cans secured within sealed plastic crate 
containers. No access was achieved. 
The dingo/es had moved their large mattrice within the tent and tried to pull it off the frame. 
 

presented ranger with a dingo tag that was found in the first ripped tent. 
 
 
 
Additional comments and notes: The family of the camp where the matrice had been moved advised 
that they had kelpies that had laid on the mattrice. This may have contributed the dingoes attempting to 
access it. 
The families are long term regular visitors to Fraser Island. They were concerned that they should leave 
the area. 
 
The tag would have been caught during tent access. The campers described a large male dingo and 
juvenile in the area the forevious afternoon and early morning.   
 
 
 
Action taken: Interaction reported. Tag identified. Northern staff advised of interaction and the probably 
likelyhood that this would occur again due to access to food gained from the site. 
 
 
 
 
Proposed further action: Visually assess whether ORW09m had definitely lost his tag. Monitor dingo 
activity in the area and continue briefing campers regarding dingo safe and food security measures.  
 
 
 
 
Faxed/emailed date:  17 Dec 2014                               Reporting Officers details:  7026466 
 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Code C_ORW09m_Euragarie CZ_16Dec2014_tent rip_steal foodDRAFT  3 

Photos  
 

 

Photo 1. 
Description (who took 
photo/when):  recovered tag 
front and back outer view 
consistent with ORW09m after 
investigation of  tag age, base 
colours, staple position and 
available previous images. 

 

Photo 2. 
Description (who took 
photo/when):  Inside view. 
 

  

Photo 3. 
Description (who took 
photo/when):  Image of 
ORW09m taken May 2015 
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Code C_Unidentified Dingo_Yidney rocks_16Dec14_on table 1 

Dingo Interaction Report Form Insert Code: C Dingo ID: Unknown 
 
Date (of Interaction): 16 December 2014 
Location (of Interaction): Yidney Rocks 
accommodation 

Time (of Interaction 24hrs): 01:00am 
Reporting Officer/s details: 7026466 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify) CD player 
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       
  interference with dingoes       

 
D) Threatening. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) High Risk. 

  nipping/mouthing 
  biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult                   
Juvenile                   
Pup                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged click to select 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details: "Larger dingo, not a pup" 
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Code C_Unidentified Dingo_Yidney rocks_16Dec14_on table 2 

Questionnaire:                  Specify visitor type   resident      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: and family woke to the sound of items crashing off their outside 
picnic table. Upon inspection they saw a dingo on the table sniffing around. It had knocked a protable 
CD player and other items off the table. 
 
The dingo moved on when they chased it off. 
 
 
 
Additional comments and notes:       
 
 
Action taken: Interaction reported. 
 
 
 
 
Proposed further action:       
 
 
 
Faxed/emailed date:  17 Dec 2014                               Reporting Officers details:  7026466 
 
  

sch4p3( 3) Prejudice the protection of an individuals right to privacy

15-166 File C 700 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



 1 

Dingo Interaction Report Form Insert Code: C Dingo ID: 4 unidentified dingoes 
 
Date (of Interaction): 17.12.14 
Location (of Interaction): Wahba cz 

Time (of Interaction 24hrs): Between 5pm and 
8.00pm 
Reporting Officer/s details: 7027130 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
       meat from esky 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     click to select 
b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             4 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name: 
Addres Hope Island 
Phone #
Age: 18 
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits No 
Did they read the Dingo BrochureNo 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments       
 
 
 
Detailed report of events: While at Lake McKenzie the dingoes entered the tent, opened the 
unsecured esky and removed stake and other cold food. 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Dingoes were also seen at the camp on the 18.12.14 
 
 
 
 
 
Action taken: Report taken & circulated 
 
 
 
 
 
 
 
 
Proposed further action: Brief all camps during holiday period. 
 
 
 
 
 
Faxed/emailed date:  23.12.14                                       Reporting Officers details:  7027130 
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Dingo Interaction Report Form Insert Code: C Dingo ID: 4 unidentified dingoes 
 
Date (of Interaction): 17.12.14 
Location (of Interaction): Wahba cz 

Time (of Interaction 24hrs): Between 5pm and 
8.00pm 
Reporting Officer/s details: 7027130 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
       meat from esky 

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     click to select 
b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             4 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address Hope Island 
Phone #
Age: 18 
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits No 
Did they read the Dingo BrochureNo 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) No 
Comments       
 
 
 
Detailed report of events: While campers were out for the day visiting Lake McKenzie - dingoes 
entered their tent in Wahba cz, opened the unsecured esky and removed stake and other cold food. 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Dingoes were also seen at the camp on the 18.12.14 
 
 
 
 
 
Action taken: Report taken & circulated 
 
 
 
 
 
 
 
 
Proposed further action: Brief all camps during holiday period. 
 
 
 
 
 
Faxed/emailed date:  23.12.14                                       Reporting Officers details:  7027130 
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Dingo Interaction Report Form Insert Code: c Dingo ID: Green tagged male 
 
Date (of Interaction): 19.12.14 
Location (of Interaction): Fraser Court, Orchid 
Beach Fraser Island 

Time (of Interaction 24hrs): Afternoon 
Reporting Officer/s details: 7027118 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Left 
    Details: Green tag 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   resident      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: On Friday afternoon 19.12.14 a Green tagged male dingo entered a house 
on Fraser court, Orchid Beach. The dingo came strait into the house and was startled when noticed the 
ocupant of the house. The dingo then left the house and moved on. 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: Report generated and circulated 
 
 
 
 
 
 
 
 
Proposed further action:       
 
 
 
 
 
Faxed/emailed date:  24.12.14                                       Reporting Officers details:  7027118 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 
 Photo 1. 

Description (who took 
photo/when):        
 

 Photo 2. 
Description (who took 
photo/when):        
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 Photo 3. 
Description (who took 
photo/when):        
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Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified 
 
Date (of Interaction): 20.12.14 
Location (of Interaction): Maheno cz 

Time (of Interaction 24hrs): 0200 
Reporting Officer/s details: 7027856 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:
Address Hervey Bay 
Phone #
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
 
      

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy

sch4p3( 3) Prejudice the protection of an individuals right to privacy
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Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: During the night, camper woke up to hear a dingo outside caravan. The 
dingo had bit through gauze in annex. Camper chased the dingo away. 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes:       
 
 
 
 
 
Action taken: Report generated and circulated 
 
 
 
 
 
 
 
 
Proposed further action: Educate all visitors on dingo safety during holiday period. 
 
 
 
 
 
Faxed/emailed date:  23.12.2014                                  Reporting Officers details:  7027856 
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Dingo Interaction Report Form Insert Code: C Dingo ID: BWR13m 
 
Date (of Interaction): 21.12.14 
Location (of Interaction): 500m south of Eli Creek 

Time (of Interaction 24hrs): 1305 
Reporting Officer/s details: 7027118 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Moved away from vehicle and 

hung in the area. 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Left 
    Details: BWR13m 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   Proffessional fisher/wormer      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: BWR13m attempted to gain access to pro wormer’s vehicle. See photo's 
below. BWR13m left the vehicle with no reward, though continued to loiter nearby.  
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: All bait items were secure in buckets with lids.  
 
 
 
 
 
Action taken: Report generated and circulated 
 
 
 
 
 
 
 
 
Proposed further action: Continue to patrol this area. 
 
 
 
 
 
Faxed/emailed date:  21.12.14                                       Reporting Officers details:  7027118 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

Photo 1. 
Descriptio
n (who took 
photo/when)
:  BWR13m 
soliciting 
food, 500m 
south of Eli 
Creek 
21.12.14 
 

 

Photo 2. 
Descriptio
n (who took 
photo/when)
:  BWR13m 
500m south 
of Eli creek 
21.12.14 
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Photo 3. 
Descriptio
n (who took 
photo/when)
:  BWR13m 
500m south 
of Eli creek 
21.12.14 
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Dingo Interaction Report Form Insert Code: C Dingo ID: GGG13f 
 
Date (of Interaction): 21.12.14 
Location (of Interaction): Eli Creek 

Time (of Interaction 24hrs): 1310 
Reporting Officer/s details: 7027118 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults       1       
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details:       
 
d. Which ears were tagged Right  
    Details: GGG13f 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Questionnaire:                  Specify visitor type   click to select      
Did they receive an information pack with their permits click to select 
Did they read the Dingo Brochureclick to select 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) click to select 
Comments       
 
 
 
Detailed report of events: 21.12.2014 GGG13f was loitering at Eli creek throughout the day. GGG13f 
is habituated and shows no sign of wariness towards people. 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Photo's below 
 
 
 
 
 
Action taken: Talked with groups of people about dingo safety while on Fraser Island. 
 
 
 
 
 
 
 
 
Proposed further action: Continue to have a high ranger presence at Eli creek during the holiday 
period, ensure all visitors are briefed. 
 
 
 
 
 
Faxed/emailed date:  24.12.14                                       Reporting Officers details:  7027118 
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Photos  
To add pictures, you will need to firstly unlock this form. Select the ‘Review Tab’, select ‘Restrict Editing’, then ‘stop 
protection’. You can now insert a picture using the Insert tab.  To re-lock the form check the box under step 2, 
choose ‘filling in forms’ from the drop down box, select ‘Yes, Start Enforcing Protection’, click ‘OK’. 

 

Photo 1. 
Description (who took 
photo/when):  GGG13f 
Loitering_Eli creek 21.12.14 
 

 

Photo 2. 
Description (who took 
photo/when):  GGG13f 
Loitering_Eli creek 21.12.14 
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 Photo 3. 
Description (who took 
photo/when):        
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Code C_PuGR13m_Connors crn to Ngkala_23Dec 2014_soliciting food 1 

Dingo Interaction Report Form Insert Code: C Dingo ID: PuGR13m 
 
Date (of Interaction): 23.12.14 
Site: Connors crn to Ngkala Rocks 
Location: Beach in front of Marloo CZ 

Time (of Interaction 24hrs): 1440 
Reporting Officer/s details: 7028773 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults 1             
Juvenile                   
Unknown Age                   

 
c. Were the dingo(s) tagged Yes 
    Details: Green tag left ear (PuGR13m) 
 
d. Which ears were tagged Left 
    Details: Green tag left ear (PuGR13m) 
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
Name:       
Address:       
Phone #:       
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Code C_PuGR13m_Connors crn to Ngkala_23Dec 2014_soliciting food 2 

Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments       
 
 
 
Detailed report of events: Green tagged male (PuGR13m) was loitering near a family on the beach in 
front of Marloo camping zone on the 23.12.2014. PuGR13m Was not wary of people and began to solicit 
food by inspecting a bucket (Photo 3). No food was accessed by the dingo. A lady ran down from their 
nearby camp and deterred the dingo with a stick - chasing the dingo away. 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: The green tagged male involved in this interaction has been 
identified to be PuGR13m. The tag of PuGR13m has delaminated to entirely green on both the inner and 
outer tag. 
 
 
 
 
 
Action taken: Photographs of interaction received from camper, Report generated and circulated. 
 
 
 
 
 
 
 
 
Proposed further action: Continue to brief camps in the area throughout the holiday period. 
 
 
 
 
 
Faxed/emailed date:  31.12.14                                       Reporting Officers details:  7028773 
through 7027118 
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Code C_PuGR13m_Connors crn to Ngkala_23Dec 2014_soliciting food 3 

Photos  
 

 

Photo 1. 
Description 
Green tagged 
male (PuGR13m) 
Loitering 23.12.14 
Beach in front of 
marloo camping 
zone (people 
nearby). 
 

 

Photo 2. 
Description 
Green tagged 
male (PuGR13m) 
Loitering 23.12.14 
Beach in front of 
marloo camping 
zone. 
 

sch4p3( 3) Prejudice the protection of an individuals right to privacysch4p3( 3) Prejudice the protection of an individuals right to privacy
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Code C_PuGR13m_Connors crn to Ngkala_23Dec 2014_soliciting food 4 

 

Photo 3. 
Description 
Green tagged 
male(PuGR13m) 
Soliciting food 
23.12.14 Beach in 
front of marloo 
camping zone 
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Code C_Unidentified dingo_Connors crn to Ngkala_23Dec 2014_loitering 1 

Dingo Interaction Report Form Insert Code: C Dingo ID: Unidentified Dingo 
 
Date (of Interaction): 26.12.14 
Site: Connors crn. to Ngkala Rocks 
Location: Marloo CZ 

Time (of Interaction 24hrs): 1630 
Reporting Officer/s details: 7028773 
Base: Fraser Island 

Question 1: What were the actions of the dingo(s) 
during the Interaction?  (click on box(s) to 
check/uncheck) 
 
B) Habituated. 

  not wary of humans 
  moving through common areas to humans  
  curious 
  loitering at recognized visitor sites (no humans 

       present) 
 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people    
       nearby)      

  stealing food or property (specify)  
             

  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)              
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  Entered dingo deterrent fence line       

 
D) Aggressive. 

  growling/snarling 
  dominant/submissive testing 
  stalking 
  tent ripping (campers inside tent) 
  circling (distance)       
  dominant towards humans 
  incorporate humans into pack behaviour 
  humans regarded as competitors for resources 
  bailing up/ambushing (walking alone or 

      unsupervised) 
  hunting tactics (with intent to test a response) 
  lunging (not attempting to nip or bite) 

 
E) Dangerous. 

  nipping/biting 
  attacking 
  causing casualty 
  hunting tactics (intent to attack) 
  bailing up/ambushing (intent to attack) 
  lunging (attempting to nip or bite) 

Question 2: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify) Deterred with whistle and 

baseball bat & stick 
 
 
Question 3: Dingo numbers and identification 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adults                   
Sub adults                   
Juvenile                   
Unknown Age             1 

 
c. Were the dingo(s) tagged Unknown 
    Details:       
 
d. Which ears were tagged Unknown 
    Details:       
 
e. Distinguishing features on dingo(s) 
 (e.g. white tail tip, socks, scars) 
    Details:      
 
Question 4: Details of person(s) involved in 
dingo Interaction. 
 
Name
Address: Bribie Island 
Phone #:
Age:       
 
Name:       
Address:       
Phone #:       
Age:       
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Code C_Unidentified dingo_Connors crn to Ngkala_23Dec 2014_loitering 2 

Questionnaire:                  Specify visitor type   camper      
Did they receive an information pack with their permits Yes 
Did they read the Dingo BrochureYes 
Did the people follow ‘dingo safe’ messaging? (Ranger to assess) Yes 
Comments Yes, went to great lengths to read up on dingo safety before visiting Fraser Island. 
Children had whistles to alert parents when dingoes were around.      
 
 
 
Detailed report of events: was on the beach in front of his camp in marloo camping zone 
supervising five children swimming in the shallows. noticed a dingo had come back to area and 
was located on the nearby fore dune. The dingo then ran down the beach towards the children,
ran at the dingo with a stick whilst blowing his whistle in attempt to deter the animal. A nearby camper 
also ran to deter the dingo with a baseball bat. The two men were successful in deterring the dingo as it 
left the area. 
 
 
 
 
 
 
 
 
 
 
 
 
Additional comments and notes: Roughly an hour earlier and the children were involved in a 
code D interaction in the same location. believes that this was the same animal. 
 
 
 
 
 
Action taken: Report Generated and circulated 
 
 
 
 
 
 
 
 
Proposed further action: Continue to brief all camps on dingo safety throughout the holiday period. 
 
 
 
 
 
Faxed/emailed date:  31.12.14                                       Reporting Officers details:  7028773 
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Code C – Dingo Interaction Form 2014 1 

Code C - Dingo Interaction Report Form  Dingo ID: Unidentified dingoes 
 

Complete high risk interaction form for all Code D and E interactions and refer to NRM ranger. 
D: Threatening – growling, snarling, dominant towards humans.  E: High Risk – nipping, biting, attacking 
 
 

Date (of Interaction): 26/12/2014 
Time (of Interaction 24hrs): 11:00 
Location (of Interaction): KBRV Jetty 
Reporting Officer/s details: 7028018 
Base: Fraser Island 
 

Details of person(s) involved in dingo Interaction. 
Name: KBRV ranger) 
Address:       
Phone #:       
Visitor type: Resort staff 

Question 1: Detailed report of events. 

A KBRV ranger reported an adult female and two juvenile 
dingoes regularly loitering around the KBRV jetty.  
 
 
 
 
 
 
Question 2: What were the actions of the dingo(s) during 
the Interaction?  (click on box(s) to check/uncheck) 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people nearby) 
  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)       
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       

 
Question 3: Dingo identification & numbers 

Was the dingo tagged: 
  Yes         No         Unknown 
  Right Ear         Left Ear 

Tag description:       
 
a. How many dingoes present     3 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult       1       
Juvenile             2 
Pup                   
Unknown Age                   

 
 

 

Question 4: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 

Question 5: Persons activity at time of interaction. 

  Not present 
  Eating/preparing food 
  Sleeping 
  Sitting/standing 
  Walking 
  Playing 
  Running 
  Swimming 
  Fishing/bait collection 
  Driving/parked vehicle 
  Other        

 
Question 6: Follow up actions. 

  NTC Issued 
  PIN Issued 
  NRM ranger notified  

 
Details of further actions: Monitor and maintain 
communicatin between KBRV and QPWS.  
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Code C_UT14m_27Dec2014_Loitering 1 

Code C - Dingo Interaction Report Form  Dingo ID: UT14m 
 

Complete high risk interaction form for all Code D and E interactions and refer to NRM ranger. 
D: Threatening – growling, snarling, dominant towards humans.  E: High Risk – nipping, biting, attacking 
 
 

Date (of Interaction): 28/12/14 
Time (of Interaction 24hrs): Approx 15:30 
Location (of Interaction): Cornwells CZ 
Reporting Officer/s details: 7028020, 7028018 
Base: Fraser Island 
 

Details of person(s) involved in dingo Interaction. 
Name: Palace Tag-along campsite - vacant 
Address:       
Phone #:       
Visitor type: Tag along tour 

Question 1: Detailed report of events. 

Whilst on patrol rangers 7028020 and 7028018 observed 
an untagged juvenile loitering around the vacant Palace 
tag-along camp in Cornwells CZ. 
Rangers got out of the vehicle to check the campsite was 
clean and to make sure the dingo had not accessed any 
food/rubbish. 
The campsite was clean, however the BBQ's smelt 
strongly of food so could be what attracted the dingo. 
The dingo was wary of the rangers, and took off when 
rangers yelled & clapped their hands. 
 
Question 2: What were the actions of the dingo(s) during 
the Interaction?  (click on box(s) to check/uncheck) 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people nearby) 
  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)       
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       

 
Question 3: Dingo identification & numbers 

Was the dingo tagged: 
  Yes         No         Unknown 
  Right Ear         Left Ear 

Tag description:       
 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult                   
Juvenile 1             
Pup                   
Unknown Age                   

 
 

 

Question 4: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 

Question 5: Persons activity at time of interaction. 

  Not present 
  Eating/preparing food 
  Sleeping 
  Sitting/standing 
  Walking 
  Playing 
  Running 
  Swimming 
  Fishing/bait collection 
  Driving/parked vehicle 
  Other        

 
Question 6: Follow up actions. 

  NTC Issued 
  PIN Issued 
  NRM ranger notified  

 
Details of further actions:Continue regular patrols 
through the campsites during the busy summer holiday 
period. 
Brief all campers of food security and dingo safety. 
 
 

 

15-166 File C 726 of 727

Rele
as

ed
 by

 N
PSR 

un
de

r th
e  

RTI A
ct 

20
09



Code C – Dingo Interaction Form 2014 1 

Code C - Dingo Interaction Report Form  Dingo ID: Unidentified 
 

Complete high risk interaction form for all Code D and E interactions and refer to NRM ranger. 
D: Threatening – growling, snarling, dominant towards humans.  E: High Risk – nipping, biting, attacking 
 
 

Date (of Interaction): 29/12/2014 
Time (of Interaction 24hrs): 10:30 
Location (of Interaction): Lake McKenzie 
Reporting Officer/s details: 7028018 
Base: Fraser Island 
 

Details of person(s) involved in dingo Interaction. 
Name: 
Address:       
Phone #:
Visitor type: Camper 

Question 1: Detailed report of events. 

Mr Graham and his family were walking down to Lake 
McKenzie and noticed a dingo lying in the water 
watching a couple of toddlers swimming (>10 meters 
away). The parents of the toddlers werent showing any 
concern of the dingo.  
 
 
Question 2: What were the actions of the dingo(s) during 
the Interaction?  (click on box(s) to check/uncheck) 
C) Nuisance or problem. 

  loitering at recognized visitor sites (people nearby) 
  stealing food or property (specify)       
  soliciting food 
  being fed or encouraged 
  living under or in infrastructure 
  following closely (distance)       
  damaging property (specify)       
  tent ripping (vacant campsite or tent) 
  entered dingo deterrent fence line       

 
Question 3: Dingo identification & numbers 

Was the dingo tagged: 
  Yes         No         Unknown 
  Right Ear         Left Ear 

Tag description:       
 
a. How many dingoes present     1 

b. How many dingoes involved in the Interaction 
(use table below) 

 Male Female Sex Unknown 

Adult                   
Sub adult             1 
Juvenile                   
Pup                   
Unknown Age                   

 
 

 

Question 4: How/why did the dingo(s) leave? 

  voluntarily, for no apparent reason 
  when yelled at 
  when chased away 
  when yelled at and chased away 
  when person stopped moving/making a noise 
  other (specify)       

 

Question 5: Persons activity at time of interaction. 

  Not present 
  Eating/preparing food 
  Sleeping 
  Sitting/standing 
  Walking 
  Playing 
  Running 
  Swimming 
  Fishing/bait collection 
  Driving/parked vehicle 
  Other        

 
Question 6: Follow up actions. 

  NTC Issued 
  PIN Issued 
  NRM ranger notified  

 
Details of further actions:Continue monitoring the area 
for dingo activity. 
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